Symantec™ Ghost Solution Suite 3.2 User Guide
Symantec™ Ghost Solution Suite User Guide

Legal Notice

Copyright © 2017 Symantec Corporation. All rights reserved.

Symantec, the Symantec Logo, the Checkmark Logo and any Altiris or Symantec trademarks or registered trademarks of Symantec Corporation or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This Symantec product may contain third party software for which Symantec is required to provide attribution to the third party (“Third Party Programs”). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Please see the Third Party Legal Notice Appendix to this Documentation or TPIP ReadMe File accompanying this Symantec product for more information on the Third Party Programs.

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Symantec Corporation and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. SYMANTEC CORPORATION SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 "Commercial Computer Software - Restricted Rights" and DFARS 227.7202, et seq.

"Commercial Computer Software and Commercial Computer Software Documentation," as applicable, and any successor regulations, whether delivered by Symantec as on premises or hosted services. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount of service for any size organization
■ Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
■ Upgrade assurance that delivers software upgrades
■ Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at the following URL:

support.symantec.com

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

support.symantec.com

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

■ Product release level
■ Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

**Licensing and registration**

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:

www.symantec.com/business/support/

**Customer service**

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

<table>
<thead>
<tr>
<th>Region</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asia-Pacific and Japan</td>
<td><a href="mailto:customercare_apj@symantec.com">customercare_apj@symantec.com</a></td>
</tr>
<tr>
<td>Europe, Middle-East, and Africa</td>
<td><a href="mailto:semea@symantec.com">semea@symantec.com</a></td>
</tr>
<tr>
<td>North America and Latin America</td>
<td><a href="mailto:supportsolutions@symantec.com">supportsolutions@symantec.com</a></td>
</tr>
</tbody>
</table>
Technical Support ................................................................................................................................................................. 4

Chapter 1 Introduction to Symantec Ghost Solution Suite .................................................................................................................. 12

Introduction to Symantec Ghost Solution Suite .............................................. 12
Features of Ghost Solution Suite ...................................................................... 14
Managing from the Ghost Solution Suite console ........................................... 15
Managing computers .............................................................................................. 15
Building and scheduling deployment jobs ......................................................... 17
Imaging ....................................................................................................................... 19
Migrating computers .............................................................................................. 20
Deploying and managing servers ......................................................................... 20
Get started ................................................................................................................ 20

Chapter 2 Installing Ghost Solution Suite Server .................................................. 22

Installing Ghost Solution Suite Server .............................................................. 22
Silent Install ........................................................................................................ 24
Platform Support for Ghost Solution Suite 3.x .................................................. 25
Installing the Ghost Standard tools from the installer ......................................... 30
Browsing to the Ghost Recovery kit ..................................................................... 32
Ghost Solution Suite Server components ......................................................... 33
Ghost Solution Suite Console ............................................................................ 33
Ghost Solution Suite Server .............................................................................. 34
Deployment Share or eXpress Share ................................................................. 36
PXE server ........................................................................................................... 37
System requirements for installing Ghost Solution Suite .................................. 39
Simple install for Ghost Solution Suite Server .................................................. 42
Custom install for Ghost Solution Suite Server ................................................. 44
Thin client install .................................................................................................. 47
Component install ................................................................................................. 50
Installing Ghost Solution Suite Agents ......................................................... 52
Client connectivity and network adapters ......................................................... 53
Installing the Ghost Solution Suite agent ........................................................ 53
Remote agent installer .......................................................................................... 54
Installing Ghost Solution Suite agent for Windows .......................................... 57
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select a computer or computer groups</strong></td>
<td>159</td>
</tr>
<tr>
<td><strong>Setting conditions for task sets</strong></td>
<td>160</td>
</tr>
<tr>
<td><strong>Deployment tasks</strong></td>
<td>161</td>
</tr>
<tr>
<td>Task names in a mixed-language environment</td>
<td>161</td>
</tr>
<tr>
<td>Common Tasks</td>
<td>161</td>
</tr>
<tr>
<td>Supported Live Task Types</td>
<td>163</td>
</tr>
<tr>
<td>Creating a disk image</td>
<td>165</td>
</tr>
<tr>
<td>Creating a Ghost image</td>
<td>167</td>
</tr>
<tr>
<td>Advanced Sysprep settings for creating a disk image for Windows Vista</td>
<td>168</td>
</tr>
<tr>
<td>and later versions</td>
<td>168</td>
</tr>
<tr>
<td>Advanced Sysprep settings for creating a disk image</td>
<td>168</td>
</tr>
<tr>
<td>Create disk image advanced</td>
<td>168</td>
</tr>
<tr>
<td>Ghost Solution Suite Hot Imaging</td>
<td>169</td>
</tr>
<tr>
<td>Distributing a disk image</td>
<td>171</td>
</tr>
<tr>
<td><strong>Scripted OS install</strong></td>
<td>173</td>
</tr>
<tr>
<td><strong>Scripted install for Windows XP, Windows Server 2003 and earlier</strong></td>
<td>174</td>
</tr>
<tr>
<td>Select OS version and language</td>
<td>176</td>
</tr>
<tr>
<td>Installation source files</td>
<td>177</td>
</tr>
<tr>
<td>Operating system-source files</td>
<td>177</td>
</tr>
<tr>
<td>Import an answer file</td>
<td>178</td>
</tr>
<tr>
<td>Answer file setup</td>
<td>178</td>
</tr>
<tr>
<td>Add a new section</td>
<td>179</td>
</tr>
<tr>
<td>Delete a section</td>
<td>179</td>
</tr>
<tr>
<td>Add a new variable</td>
<td>179</td>
</tr>
<tr>
<td>Command-line switches for scripted install</td>
<td>180</td>
</tr>
<tr>
<td>Ghost Solution Suite agent settings for scripted install</td>
<td>181</td>
</tr>
<tr>
<td>Scripted install summary</td>
<td>181</td>
</tr>
<tr>
<td><strong>Scripted install for Windows Vista, Windows Server 2008, and later</strong></td>
<td>181</td>
</tr>
<tr>
<td>Scripted install for Linux</td>
<td>182</td>
</tr>
<tr>
<td>Scripted install summary</td>
<td>183</td>
</tr>
<tr>
<td>Distributing software</td>
<td>183</td>
</tr>
<tr>
<td>Distribute software advanced</td>
<td>185</td>
</tr>
<tr>
<td>Capturing personality settings</td>
<td>186</td>
</tr>
<tr>
<td>Capture personality advanced options</td>
<td>187</td>
</tr>
<tr>
<td>Distributing personality settings</td>
<td>187</td>
</tr>
<tr>
<td>Distribute personality advanced</td>
<td>189</td>
</tr>
<tr>
<td>Modifying configuration</td>
<td>190</td>
</tr>
<tr>
<td>Getting inventory</td>
<td>191</td>
</tr>
<tr>
<td>Running a script</td>
<td>191</td>
</tr>
<tr>
<td>Script information</td>
<td>192</td>
</tr>
<tr>
<td>Using LogEvent and WLogEvent in scripts</td>
<td>195</td>
</tr>
</tbody>
</table>
Introduction to Symantec Ghost Solution Suite

This chapter includes the following topics:

- Introduction to Symantec Ghost Solution Suite
- Features of Ghost Solution Suite
- Managing computers
- Building and scheduling deployment jobs
- Imaging
- Migrating computers
- Deploying and managing servers
- Get started

Introduction to Symantec Ghost Solution Suite

Ghost Solution Suite lets you remotely manage all types of devices such as desktops, notebooks and servers through the phases of computer deployment and lifecycle management. Ghost Solution Suite lets you upgrade computers, distribute patches and drives, re-image computer hard drives or migrate large group of users to new computers including the custom settings and the installed programs.

What can I do with Ghost Solution Suite?

Ghost Solution Suite lets you deploy, manage, and migrate regardless of your organization’s size or special IT requirements, Ghost Solution Suite provides a
complete system to cut costs and improve response times for both big and small jobs.

### Table 1-1  Features of Ghost Solution Suite

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage from a central console.</td>
<td>Deploy, control, and manage all types of computers across your organization from the Ghost Solution Suite console. Use the feature-rich Ghost Solution Suite server Console for real-time management of computers. See “Managing from the Ghost Solution Suite console” on page 15.</td>
</tr>
<tr>
<td>Migrate data, applications, and personal settings.</td>
<td>Through easy-to-use wizards, migrate data and settings from a retiring computer to a new computer by capturing desktop, network, and application settings. Redeploy these personal settings remotely from a Ghost Solution Suite console. See “New Job wizard” on page 154.</td>
</tr>
<tr>
<td>Upgrade and install software.</td>
<td>Manage system software on a day-to-day basis for desktops, servers, and notebooks to upgrade applications, install service packs, set up printer drivers, and modify systems as needed. See “Distributing software” on page 183.</td>
</tr>
<tr>
<td>Deploy computers in large groups.</td>
<td>Easily deploy and configure large number of computers across an organization. Install hard disk images to groups of new or existing computers using the multicasting feature. Deploy software and personality settings with common applications, data and drivers. Run post-configuration jobs or automated scripts to assign unique security IDs, configure user names, and set IP addresses using deployment jobs. See “Managing computers” on page 15.</td>
</tr>
</tbody>
</table>
### Features of Ghost Solution Suite (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploy and manage servers.</td>
<td>Manage all types of servers. Automatically redeploy servers based on deployment history and saved server images, or use automated scripted installs with easy-to-create answer files. Operating system can be installed as image files or run as scripted installs-or as a combination strategy.</td>
</tr>
<tr>
<td>Respond to common help desk requests.</td>
<td>Browse, diagnose, and repair problems on systems without leaving the Ghost Solution Suite console. Detailed hardware and software inventories, along with remote control feature simplify remote diagnosis of common problems. See “Remote operations using Ghost Solution Suite” on page 128.</td>
</tr>
<tr>
<td>Recover from disaster.</td>
<td>Automatically back-up and restore configurations, personalities, registries, partitions, and drives from the Ghost Solution Suite console. Saving the history of all deployment jobs assigned to a computer makes it easy to restore a system to a previous working state. See “Restoring a computer from its deployment history” on page 131.</td>
</tr>
</tbody>
</table>

---

### Features of Ghost Solution Suite

Ghost Solution Suite can be installed and implemented locally as an independent Ghost Solution Suite server system on a single LAN segment or site.

Each Ghost Solution Suite server system includes services, applications, and utilities for high-bandwidth, real-time deployment.

**Ghost Solution Suite server system**

The Ghost Solution Suite console is a Windows user interface that provides full features to deploy computers, image hard disks, migrate user settings and programs, run scripted installs and perform other deployment tasks for all your computer resources. Daily IT requests and jobs formerly completed by visiting each desktop,
server or portable computer in the organization can now be completed from your Ghost Solution Suite server Console.

Components of the Ghost Solution Suite server system can be installed on a single computer (a Simple install) or distributed across several local computers (a Custom install). A Custom installation lets you install Microsoft SQL Server and access the Ghost Solution Suite Database from a separate computer. The eXpress Share, Ghost Solution Suite server, PXE Server, and Ghost Solution Suite console can also be distributed to separate computers. The Ghost Solution Suite Console displays data directly from the Ghost Solution Suite Database.

Managing from the Ghost Solution Suite console

The Ghost Solution Suite Console (a Windows console) is included with the Ghost Solution Suite server system and provides complete deployment and management features. It is divided into several operational panes:

- The **Computers** pane displays all computer resources managed by a Ghost Solution Suite server system. It includes features to right-click and remotely execute operations on managed computers. From this pane, you can drag the computer icons to job icons to schedule deployment and management tasks.

- The **Jobs** pane executes and schedules deployment tasks for selected computers. Using one or more sequenced jobs, you can image, configure computer settings, distribute packages, and run scripts by dragging Job icons to individual computers or computer groups. These can be executed immediately or scheduled for a more convenient time. You can schedule deployment jobs by dragging computer icons to job icons, or vice versa.

- The **Details** pane provides information and features to filter computers by type and build deployment tasks. It extends the user interface features when working in the **Computers** and **Jobs** panes.

- From the Ghost Solution Suite Console (the Windows console), a **Shortcut and Resources** pane organizes and provides easy access to .MSI files, image files (.img), Personality Packages (.exe), and other file types. It functions as a library for packages used when building jobs in the console.

In addition, the Ghost Solution Suite server Console provides easy-to-use wizards to simplify and expedite common deployment tasks.

See “Managing from the Ghost Solution Suite console” on page 15.

Managing computers

From the Ghost Solution Suite console, you can manage all types of computers to perform immediate deployment and management operations. From the **Computers**
pane of the console, computer resources can be grouped by location, department, or type (portables, desktops or servers) and organized to reflect your environment. You can run operations, schedule deployment jobs, access computers or computer groups to change the network settings, run disk image, other deployment jobs.

The console identifies computers and computer groups with a unique icon. To access a computer, click the computer icon to view the configuration settings or run specific deployment and management operations. Computer icons can be dragged to job icons to schedule and run preconfigured deployment tasks from the Windows console. In the Ghost Solution Suite console, you can manage computers using drop-down lists, secondary dialog boxes, and other familiar web features.

See “Managing computers” on page 96.

Managing with computer icons

Icons displayed in the Computers pane of the console help in identifying the computer types and deployment status. Group icons can be expanded to view the member computers, and computer types can be identified by specific icons: desktops and notebooks, servers, computer groups, and Linux computers. Computer icons can also identify the state of the managed computer—a logged-on user, a computer waiting for further instructions, a user not logged on and other states of deployment—when performing operations or executing deployment tasks on a selected computer.

See “Viewing computer details” on page 98.

This icon identifies a managed desktop or notebook computer that is active and has a user logged on.

This icon identifies a managed Windows network or Web server that is active and has a user logged on.

This icon identifies a Linux computer.

This icon identifies a pre-configured computer account with user account settings that are not associated with a new computer.

Additional icons represent deployment status, inactive computers, computers running a deployment job, and new computers.
See “Viewing computer details” on page 98.

Immediate management access from the console

From a Ghost Solution Suite console, you can select a computer and start various computer configuration and management operations for that computer. You can create new deployment tasks, restart, restore the hard drive, view deployment history, and perform other advanced tasks using the commands on this menu. Some operations—such as changing configuration settings, copying files, and creating quick disk images—create job files automatically.

See “Remote operations using Ghost Solution Suite” on page 128.

For complete information about Ghost Solution Suite consoles refer to the following:

See “Managing from the Ghost Solution Suite console” on page 15.

Building and scheduling deployment jobs

Jobs are designed as objects with defined deployment tasks. Jobs can be built, organized, and scheduled to run on selected computers or computer groups from a Ghost Solution Suite console.

Deployment jobs give you the ability to organize, store, and assign administration tasks for each computer or computer group. You can create and deploy images, back up registry files, run scripted installs, or make post-imaging changes such as adding printers and applications. You can deploy and run Personality Packages, and others—to migrate applications, configure computer settings, deploy complete hard disk images, and much more. You can also assign jobs with conditions to run only on defined computer types.

See “Building and scheduling jobs” on page 151.

Jobs are built in the Ghost Solution Suite server Console by creating a job name (identified by a job icon in the console) and adding predefined deployment tasks. Tasks such as Distribute Software, Run Script, or Create Disk Image are added and executed sequentially when scheduled to run on computers or computer groups.

And even within computer groups, different jobs can be assigned to different computer types based on the operating system, hardware, or other specified conditions.

See “Deployment tasks” on page 161.

When a job is built, it can be scheduled to run immediately, at desired intervals, or at any other convenient time when the bandwidth is low. In addition, you can use bandwidth throttling features to schedule and run deployment tasks to large groups without affecting network traffic.

See “Deployment tasks” on page 161.
From the Ghost Solution Suite Console, you have several options to create deployment jobs:

- Create common deployment tasks quickly and easily using the New Job Wizard.
- Import jobs from other Ghost Solution Suite systems.
- Manually create deployment tasks from the console.
- Copy and paste deployment tasks from within the console.

See “Building new jobs” on page 158.

In the Jobs pane, you can create and organize deployment jobs. You can then assign jobs by dragging icons to the desired computer or computer group.

**Building jobs**

Building jobs includes creating a new job and then adding tasks to the job to run in sequence when scheduled on selected computers. You can build jobs by adding tasks manually or you can step through the **New Job Wizard** to create common jobs and schedule them. Sample tasks are also included with Ghost Solution Suite to use as installed or to easily customize and run.

See “New Job wizard” on page 154.

After creating and building a job, you can then assign it to a computer and schedule it to run at any time—immediately, after a specified time, or on a daily, weekly, or monthly schedule. The deployment status of each job is reflected in the console.

**Assigning deployment jobs with icons**

Computer icons are used to identify the types of computers in a console. Similarly, job icons identify the status and success of a scheduled deployment job. After scheduling jobs, you can monitor the progress as the job icons are updated at each step of execution.

- This job is assigned to a computer, but is not scheduled to run. Until scheduled, this job icon remains unchanged.

- This job is assigned to the computer and is scheduled to run either immediately or in the future.

- This job is currently in process.
Scheduling jobs

From the Schedule Job dialog, you can run jobs immediately or schedule the job to run in batches at defined intervals. You can also assign the job to repeat every hour, day, or week. Scheduling jobs can be as simple as clicking OK to run immediately or as sophisticated as required to meet your deployment needs.

For complete information about building and scheduling deployment jobs, See “Building and scheduling jobs” on page 151.

Imaging

A primary task of Ghost Solution Suite is to capture an image (a clone of the hard drive) from a reference computer and distribute the image to set up new computers or reinstall computers to their basic configuration. You can create a library of image files on the eXpress Share (file server storage) and schedule image jobs to different computer types as required.

Ghost Solution Suite server lets you push down a boot image remotely and execute the image using PXE Server, eliminating the need to physically attend and boot each managed computer.

New Job wizard

Imaging from Ghost Solution Suite server

Ghost Solution Suite server includes multiple features to capture an image and lay it down to a new or existing computer. You can use the Ghost Solution Suite Console to create and distribute disk images using deployment tasks, such as the Quick Disk Image wizard.

Pre-boot environments let you boot to automation to create and deploy images, back up and restore a computer’s registry file, or run other automation tasks. You can also boot to a network server and run imaging files and other commands.

See Boot Disk Creator Help and PXE Configuration Utility Help.
Migrating computers

Ghost Solution Suite provides various options to migrate operating systems, computer personalities, software, or entire hard disk images. You can accomplish migration tasks individually or as a single job.

The New Job Wizard steps you through each migration option, letting you capture a complete hard disk image (to upgrade to a new computer), migrate a user to another operating system with the same personality settings and applications, or to simply move personality settings from one computer to another.

Deploying and managing servers

Ghost Solution Suite includes features designed specifically for deploying and managing servers. Server-specific features include scripted installs for initial installation, and support for remote management cards, multiple network adapters, history transfers to support rip and replace redeployment, and additional functionality required for automating server management.

Ghost Solution Suite also integrates with other hardware vendors to provide systems and tools to manage large server installations and support automatic deployment strategies. These unified systems simplify and automate server configurations and large-scale migrations, and support emerging hardware for ultra high-density server systems.

From a Ghost Solution Suite console you can build deployment jobs to run scripted installs for Windows and Linux servers. You can run these unattended installs directly over the network for individual servers. You can create answer files for each scripted install from a Ghost Solution Suite console.

You can also run server-specific scripts and redeployment tasks. Enhanced task logging and history tracking features let you recall deployment actions to quickly redeploy mission-critical servers.

Get started

Ghost Solution Suite is a full-featured remote deployment system designed to manage computer devices across all types and sizes of small to medium organizations and large enterprises. It includes Windows components to design and scale a system for your specific IT needs and challenges. Ghost Solution Suite provides a wide array of tools, utilities, and applications to design a system for your specific needs. Ghost Solution Suite is easy-to-use and adaptable to your environment.
You can design and install a Ghost Solution Suite server system specific to your hardware, organizational structure, network architecture, and other environmental variables. The installation and configuration process lets you install Ghost Solution Suite components (database, services, network share, user interface console) to a single computer or distribute components to separate role servers.
Installing Ghost Solution Suite Server

This chapter includes the following topics:

- Installing Ghost Solution Suite Server
- Silent Install
- Platform Support for Ghost Solution Suite 3.x
- Installing the Ghost Standard tools from the installer
- Browsing to the Ghost Recovery kit
- Ghost Solution Suite Server components
- System requirements for installing Ghost Solution Suite
- Simple install for Ghost Solution Suite Server
- Custom install for Ghost Solution Suite Server
- Thin client install
- Component install
- Installing Ghost Solution Suite Agents

Installing Ghost Solution Suite Server

Ghost Solution Suite Server is a flexible, scalable computer deployment and management system that can be installed and configured on a single computer, or installed across several computers to distribute processing for large enterprise environments. You can run a Simple install to position all Ghost Solution Suite
Server Components on a single computer (most frequently used), or plan and perform a Custom install to distribute installation of components across separate computers in the site.

See “Ghost Solution Suite Server components” on page 33.

After installing Ghost Solution Suite Server components, you can remotely install Ghost Solution Suite Agents on all types of computer resources across your organization: laptops, servers, and so on. Windows computers and Linux computers can be managed as a unified environment, with each client communicating through its own Ghost Solution Suite agent to update inventory data and react to Ghost Solution Suite Server commands and deployment tasks.

Pre-requisites check

The pre-requisite checks let you view the compliance of the computer for installing Ghost Solution Suite. Following are the pre-requisites that are checked:

- **Check**
  Checks for installation prerequisites and displays the GSS IRC (Ghost Solution Suite Install Readiness Check) summary.

  
  **Server Check Summary**
  - GSS is supported on Server OS only.
  - GSS requires the logged on user to be part of local administrator group.
  - GSS requires the UAC to be disabled

  **DB CHECK SUMMARY**
  Checks if database is present

  **PORT CHECK SUMMARY**
  Following ports are checked:
  - 402,403
  - 37,49,53,67,68,69, 137,138,1345, 1346,1347,4011, 5001,5002,6666,7777

- **Summary**
  Displays the summary of previous installation of Ghost Solution Suite on the computer.

Select one of the following methods for installing a Ghost Solution Suite Server system:

- Simple install for Ghost Solution Suite Server
  Install all components on local computer. See Simple install for Ghost Solution Suite Server

- Custom install for Ghost Solution Suite Server
Installs components on remote or local computers and lets you customize options. See Custom install for Ghost Solution Suite Server

- Thin client install
  Installs GSS Thin client view. See Thin client install

- Component install
  Installs additional Ghost Solution components. See Component install

- Ghost Standard Tools
  Launches the Symantec Ghost Standard Tools installer that lets you install the Symantec Ghost Standard Tools.
  See “Installing the Ghost Standard tools from the installer” on page 30.

To install Ghost Solution Suite Agents on the client computer, refer to the following section:

See “Installing Ghost Solution Suite Agents” on page 52.

Silent Install

Ghost Solution Suite lets your run silent install of Ghost Solution Suite Server in case for the following scenarios:

- Fresh installation
  See “To perform Silent Install for fresh installation” on page 24.

- Upgrade from Deployment Solution 6.9 SP6
  See “To perform Silent Install when you upgrade from Deployment Solution 6.9 SP6” on page 25.

- Upgrade from Ghost Solution Suite 3.0
  See “To perform Silent Install when you upgrade from GSS 3.0 and GSS 3.0 HF (all hot fixes)” on page 25.

- Upgrade from Ghost Solution Suite 3.0 HF (all hot fixes)
  See “To perform Silent Install when you upgrade from GSS 3.0 and GSS 3.0 HF (all hot fixes)” on page 25.

To perform Silent Install for fresh installation

1. Run the command `axinstall.exe -i` in the command window.
   This command launches the installer and captures all the values from the different windows and creates a `silent.ini` file.

2. Run the `axinstall.exe -t silent.ini` command in the command window to complete the silent installation and upgrade.
To perform Silent Install when you upgrade from Deployment Solution 6.9 SP6

1. Stop the following services:
   - Altiris Deployment Server Data Manager
   - Altiris Deployment Server DB Management
   - Altiris eXpress Server
   - Altiris PXE Config Helper
   - Altiris PXE Manager
   - Altiris PXE MTFTP Server
   - Altiris PXE Server

2. Run the command `axinstall.exe -i` in the command window.
   This command launches the installer and captures all the values from the different windows and creates a `silent.ini` file.

3. Run the `axinstall.exe -t silent.ini` command in the command window to complete the silent installation and upgrade.

To perform Silent Install when you upgrade from GSS 3.0 and GSS 3.0 HF (all hot fixes)

1. Stop the following services:
   - Altiris Deployment Server DB Management
   - Altiris eXpress Server
   - Altiris PXE Config Helper
   - Altiris PXE Manager
   - Altiris PXE MTFTP Server
   - Altiris PXE Server

2. Run the command `axinstall.exe -i` in the command window.
   This command launches the installer and captures all the values from the different windows and creates a `silent.ini` file.

3. Run the `axinstall.exe -t silent.ini` command in the command window to complete the silent installation and upgrade.

Platform Support for Ghost Solution Suite 3.x

This section lists the supported platforms for Ghost Solution Suite 3.0 and later:
**Note:** If you use SQL Server Express 2014 database management system, refer to the following article for the list of supported operating systems:


<table>
<thead>
<tr>
<th>Platform</th>
<th>Client</th>
<th>Server/Win32 Console</th>
<th>File Server</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2016</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Supported from 3.1 MP5 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server 2012</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 10</td>
<td>Yes</td>
<td>Yes (Enterprise Edition)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Read the following article for the limitations: DOC9010</td>
<td>3.0 HF2 onwards</td>
<td>3.0 HF2 onwards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 10 Version 1607 (Codename-Redstone 1)</td>
<td>Yes</td>
<td>Yes (3.1 MP5 onwards)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>(3.1 MP5 onwards with limitations)</td>
<td></td>
<td>3.1 MP5 onwards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read the following article for the limitations: <a href="http://www.symantec.com/docs/DOC9481">http://www.symantec.com/docs/DOC9481</a></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7, including Embedded Standard, Professional, Enterprise, and Ultimate editions</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 2008 Core</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server 2008 (x64), including R2 and SP2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Platform</td>
<td>Client</td>
<td>Server/Win32 Console</td>
<td>File Server</td>
<td>Database</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------</td>
<td>----------------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>Windows XP SP3</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refer to the following article: TECH213925</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMWare ESX Server 4.0 (vSphere)</td>
<td>Yes</td>
<td>Support is provided for VMware ESX Server scripted installations.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMWare ESX Server 3.5</td>
<td>Yes</td>
<td>Support is provided for VMware ESX Server scripted installations.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMWare ESX Server 3.0</td>
<td>Yes</td>
<td>Support is provided for VMware ESX Server scripted installations.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.6</td>
<td>Yes</td>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.7</td>
<td>Yes</td>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.8</td>
<td>Yes</td>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.9</td>
<td>Yes</td>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Platform</td>
<td>Client</td>
<td>Server/Win32 Console</td>
<td>File Server</td>
<td>Database</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------</td>
<td>----------------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>Mac OS X 10.10</td>
<td>Yes</td>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.11</td>
<td>Yes</td>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>macOS 10.12</td>
<td>Yes</td>
<td>Note: Imaging is not supported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supported from 3.1 MP5 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4</td>
<td>Yes</td>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4 x86_64</td>
<td>Yes</td>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 6.5</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 11</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 11 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 10</td>
<td>Yes</td>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 10 x86_64</td>
<td>Yes</td>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 9</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 9 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 2-1

<table>
<thead>
<tr>
<th>Platform</th>
<th>Client</th>
<th>Server/Win32 Console</th>
<th>File Server</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debian Linux 5 (and prior) Stable</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solaris SPARC 8, 9 (production agent only)</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetWare 6.5</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Note: Not supported from 3.1 MP4 onwards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: From Ghost Solution Suite 3.0 onwards Web Console is not supported.

Symantec Technical Support is unable to provide support for the installation, configuration or use of Symantec Ghost Solution Suite 3.X on a Domain Controller.

For more information refer to the following URL:

http://www.symantec.com/docs/INFO2800

List of supported SQL versions

- MS SQL 2008 R2 (x64)
- MS SQL 2012 (x64)
- MS SQL 2014 (x86)
- MS SQL 2014 (x64)
- MS SQL 2014 (x86) Express edition
- MS SQL 2014 (x64) Express edition
- MS SQL 2016 (x64) Enterprise edition

Ghost Standard Tool:

You can install the Ghost standard tools on the following Windows operating system:

- Windows Server 2012
- Windows Server 2012 R2
- Windows 8
- Windows 8.1
- Windows 10
Windows 7
- Windows Server 2008 R2 and SP2
- Windows XP SP3

The Boot Disk creator supports only the following operating systems:
- Windows 8
- Windows 8.1
- Windows 8.1 Update 1
- Windows 10
- Windows 2008 R2
- Windows Server 2012
- Windows Server 2012 R2

For more information on platform support for Windows ADK, refer to the following article:

Additionally, the GIF tools support the following file systems:
- NTFS
- FAT
- EXT2/3
- RAW

Installing the Ghost Standard tools from the installer

Ghost Solution Suite lets you install the Ghost Standard tools from the link that is provided in the installer. The Ghost Standard tools include the following:

- Boot Disk Creator.exe

**Note:** If you run BootWiz.exe for first time after fresh installation of Ghost Solution Suite 3.2, then you must right-click and open the application with Run As Administrator option.

- Ghost Explorer x64.exe
The Ghost Standard tools are installed at the following location and are accessible from the Start menu:

<Install_dir>/Program Files(x86)/Symantec/Ghost

**Note:** Symantec recommends not to install the Ghost Standard Tools 3.0 or later on the default recommended path of a computer that has Ghost Solution Suite 2.5. Installing on the default path overwrites the Ghost Solution 2.5 tools and conflicts with the Ghost 2.5 Console.

**To install Ghost Standard tools**

1. Start the computer and log on using the administrator account you created for the Ghost Solution Suite Server.
2. Launch the appropriate Symantec Ghost Solution Suite installation file and follow the setup steps.
3. The **Symantec Packager Self-Extracting Executable Options** dialog appears.
4. Select the **Use current temp folder** option to use the current temporary folder to download installation files or the **Extract to a specific folder** option to set a path to an existing folder to download the installation files.
5. Click **Extract and Execute App** to extract and execute the application immediately.
   
   The default extraction directory is C:\DSSetup. You may have to wait for some time while Symantec Packager extracts files from this archive.

   **Note:** Click **Extract Only** to only extract the application and execute the application later. You must run the axInstall.exe file to start the installation.

6. In the **Ghost Solution Suite Server Install Configuration** dialog, click on **Ghost Standard Tools**.
7 In the Symantec Ghost Standard Tools wizard, the default path where the Ghost Standard Tools executables are installed is displayed as follows:

C:\Program Files(x86)\Symantec\Ghost

To change the path where the Ghost Standard Tools executables are installed, click on Change....

8 Click Next >.

9 Click Install.

Browsing to the Ghost Recovery Kit

The Ghost Solution Suite lets you browse to the Ghost Recovery Tool kit at the following location:

<Install_Dir>:\DSSetup\Ghost_recovery_Kit.zip

Symantec Ghost Recovery Kit is a suite of tools designed for original equipment manufacturers (OEMs) and value-added resellers (VARs). It adds tools and functionality to the applications included in Symantec Ghost Solution Suite. Symantec Ghost Recovery Kit includes the following tools:

- GhostOEM32
  GhostOEM32 is a Win32 version of GhostOEM and is designed to run on Microsoft Windows Preinstallation Environment (WinPE).

- GhostOEM64
  GhostOEM32 is a Win64 version of GhostOEM and is designed to run on Microsoft Windows Preinstallation Environment (WinPE).

- PQIDeploy
  PQIDeploy is an OEM version of Symantec ImageCenter that provides restore-only capabilities. It contains the full scripting capabilities that are included in ImageCenter. It does not include any graphical user interface (GUI). All commands are specified in a script command file.

- PQIDplyD

- SRFixMbr
  The System Recovery Fix MBR executable installs the Boot Partition Selector in the Master Boot Record (MBR). The Boot Partition Selector requests which partition the end user wants to launch when the computer is booted from the primary hard drive. If no response is made within the timeout interval, then the user partition is launched. Alternatively, the end user can launch the recovery partition. The end user can access the recovery partition only through the Boot Partition Selector.
Ghost Solution Suite Server components

The Ghost Solution Suite Server system includes the following components:

- Ghost Solution Suite Console
  See “Ghost Solution Suite Console” on page 33.
- Ghost Solution Suite Server
  See “Ghost Solution Suite Server” on page 34.
- Ghost Solution Suite Database
  See “Ghost Solution Suite Database” on page 35.
- eXpress Share
  See “Deployment Share or eXpress Share” on page 36.
- PXE server
  See “PXE server” on page 37.
- DHCP Server (not an Symantec product)
- Installing Ghost Solution Suite agents
- Sysprep

You can install all these components on the same server or distribute them across multiple servers, depending on the environment.

Ghost Solution Suite Console

The Ghost Solution Suite Console is the Win32 user interface for Ghost Solution Suite. You can install this Windows console on servers across the network to view and manage resources from different locations. In addition, from this console, you can access the Ghost Solution Suite Database on other Ghost Solution Suite Server systems to manage sites across the enterprise.

See “Ghost Solution Suite Database” on page 35.

See “Connecting to another Ghost Solution Suite server” on page 93.

The Ghost Solution Suite Console communicates with the Ghost Solution Suite Database and Deployment services. In a Simple Install for Ghost Solution Suite Server, the Ghost Solution Suite Console is installed on the same computer similar to all other components. In a Custom Install for Ghost Solution Suite Server, you must ensure that a connection is available to these computers and security rights are set. You must have administrative rights on any computer running the Ghost Solution Suite Console.

See “Simple install for Ghost Solution Suite Server” on page 42.

See “Custom install for Ghost Solution Suite Server” on page 44.
Ghost Solution Suite Server

Ghost Solution Suite Server controls the flow of the work and information between the managed computers and the other Ghost Solution Suite Server components (Ghost Solution Suite Console, Ghost Solution Suite Database, and the eXpress Share). Managed computers connect and communicate with the Ghost Solution Suite Server to register inventory and configuration information and to run deployment and management tasks. The computer and deployment data for each managed computer is stored in the Ghost Solution Suite Database.

**Note:** To view, start, or stop Ghost Solution Suite Server, go to the Symantec Server services in your Windows Manager.

Managed computers require access to the Ghost Solution Suite Server at all times, requiring that you have administrative rights on the computer running the Ghost Solution Suite Server.

Create a user account to run the Ghost Solution Suite Server. The service runs as a logged-on user, not as a system account. You must create this account on all Ghost Solution Suite Server computers. The account must have full rights to the eXpress Share. The account must have a non-expiring password. See “Deployment Share or eXpress Share” on page 36.

Assign a static IP address to the Ghost Solution Suite Server computer. Other components cannot connect to the Ghost Solution Suite Server if you use DHCP and dynamically change the IP address.

To install the Ghost Solution Suite Server on a remote computer, the default administration shares must be present. Restore any shares that have been removed before you install the Ghost Solution Suite Server.

**Note:** It is easier to create an administrative account using the same name and password on all computers than to use the existing name and password of each account.
Most packages (Personality Packages, and .MSI files) pass through the Ghost Solution Suite Server. Therefore, if you store these files on the Ghost Solution Suite Server, the deployment of these packages is faster. Image files, however, are sent directly from the eXpress Share to the client computer when you run an imaging task.

See “Ghost Solution Suite Server components” on page 33.

**Ghost Solution Suite Database**

Refer to the following article for the list of supported SQL versions on which you can install the Ghost Solution Suite Database.


---

**Note:** In Ghost Solution Suite 3.0 and later, if you have already set up multiple instances of the Microsoft SQL Server, you can identify a specific instance using this format: `<database instance>\express`. Example: If you have a clustered Microsoft SQL Server named SQLClusterSvr to manage multiple Ghost Solution Suite systems on different network segments, you can enter the name `SQLClusterSvr\salesSegment` or `SQLClusterSvr\marketingSegment` during the Ghost Solution Suite Server setup, depending on the previously established database instance. This feature is supported in the silent install .INI file and the GUI install executable.

The database maintains the following information about the managed computers:

- Hardware. RAM, asset tag, and serial numbers
- General Information. Computer name and MAC address
- Configuration. TCP/IP, Microsoft networking, and user information
- Applications. The installed applications and information about these applications, such as the name of the application, publisher, and product ID
- Services. Installed Windows services
- Devices. Installed Windows devices, such as network adapter, keyboard, and monitors
- Location information. Contact name, phone, email, department, mail stop, and site

The Ghost Solution Suite Server Database also contains jobs and other data used to manage your computers.
Note: You can install a single Ghost Solution Suite Database in each Ghost Solution Suite Server system—you cannot have two databases storing data for a single computer. If the computer you are installing the database on has an existing Microsoft SQL Server™, the Ghost Solution Suite Database is added to that instance of the database engine.

Support for multiple database instances

In Ghost Solution Suite 3.0 and later, you can identify a named instance of the Microsoft SQL Server when installing Ghost Solution Suite. You can now identify other named instances of Microsoft SQL Servers instead of accessing only the default instance. This feature lets you identify and run multiple databases from one clustered Microsoft SQL Server to manage multiple sites or network segments. This feature is supported in the silent install .INI file and the GUI install executable. Ghost Solution Suite also supports a different name for the Ghost Solution Suite Database instead of the default name, eXpress.

See “Custom install for Ghost Solution Suite Server” on page 44.

See “Ghost Solution Suite Server components” on page 33.

Deployment Share or eXpress Share

The eXpress Share is a file server or shared directory where Ghost Solution Suite program files and packages are stored. The eXpress Share can be a shared directory (default Simple install in Program Files\ Altiris\eXpress\Deployment Server) or another file server (in the Custom install, you can assign a Microsoft Windows or Novell NetWare file server).

eXpress Share is where you store image files, registry files, .MSI packages, Personality Packages, script files, and more. When you are deploying or managing a computer, the Ghost Solution Suite Server stores and retrieves these packages from the eXpress Share as needed.
If you want to install Ghost Solution Suite on a remote file server (not the computer where you are running the install program), create a share (or give Read/Write rights for NetWare) on the file server where you want to install the Ghost Solution Suite Server. This share must allow access to all other components, including managed computers and the user account that runs the Ghost Solution Suite Server.

You must create this share before you begin installing. If you are not installing on a remote computer, you can select the option to create the share during the installation.

**Note:** You can install only one eXpress Share for each Ghost Solution Suite Server system. However, if the eXpress Share’s hard drive gets full, other computers can be used as additional backup storage points. In some cases, other systems emulating a Microsoft or NetWare environment can be used as the eXpress Share.

See “Ghost Solution Suite Server components” on page 33.

### PXE server

The PXE Server provides service to client computers on a subnet. When the Ghost Solution Suite Server sends a deployment job, the client computer receives a request to boot to automation and the PXE-enabled computers connect to the first PXE Server that they discover, which communicates with the Ghost Solution Suite Server and the client computers.

For list of supported operating system on which you can install a PXE Server, refer to the following article:


The PXE Server also functions on the same protocols as a standard DHCP Server, so you can place the PXE Server wherever you would place a DHCP server. You can also install as many PXE Servers as required in your system, but you must also install a DHCP Server.

The PXE Server sends a boot menu option list to the client when the computer performs a PXE boot. The deployment job, which contains at least one automation task, uses the default automation environment or the environment specified by a user who has the permission to create a deployment job. Use the boot menu option to request the PXE Server for the boot menu files and download the boot menu.
files from the PXE Server to the client computer's RAM storage. The client computer always boots according to the request and reply communications taking place between the Deployment and PXE Servers.

Ghost Solution Suite supports Linux, and Windows PreInstallation Environment (WinPE) as pre-boot environments. These options let you create a single job, but may contain multiple automation tasks. The default automation environment (the first pre-boot operating system files installed during the Ghost Solution Suite installation) is used for Initial Deployment, unless you specify otherwise.

Using a PXE Server to boot client computers to automation saves you from having to install an automation folder on each client computer's hard disk, or from manually starting computers using Symantec Ghost Solution Suite supported bootable media.

See Boot Disk Creator Help and see PXE Configuration Utility Help.

DHCP Server

The DHCP (Dynamic Host Configuration Protocol) server is a server set up to assign TCP/IP addresses to the client computers. This server is not a Symantec product, but is required if you want to use the PXE Server.

We recommend that you use DHCP to manage the TCP/IP address in your network, whether you use PXE or not. This greatly reduces the amount of time required to set up and manage your computers.

See “Ghost Solution Suite Server components” on page 33.

Adding drivers in Driver database

Ghost Solution Suite lets you add many types of drivers to the driver database.

To verify if the driver is added, navigate to Install_Dir:\Program Files (x86)\Altiris\eXpress\Deployment Server\DriversDB.

To add drivers to driver database

1. On the Ghost Solution Suite Server, navigate to <Install_Dir>:\Program Files (x86)\Altiris\eXpress\Deployment Server\Ghost.

2. Launch DriverManager.exe

3. In the Symantec Driver Library Editor, enter the following details:

   Type: Select the type of the driver.
   OS: Select the type of the driver
   Tags: Select the operating system for the driver
   IDs: Enter the Driver ID
4 Click **Add Driver…**.

5 In the **Add new driver** window, enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Browse to the location from where driver has to be added.</td>
</tr>
<tr>
<td>Friendly name</td>
<td>Enter a friendly name for the driver</td>
</tr>
<tr>
<td>Driver type</td>
<td>Select the type of the driver</td>
</tr>
<tr>
<td>Applicable OS</td>
<td>Select the operating system for which the driver is applicable</td>
</tr>
</tbody>
</table>

6 Click OK.

# System requirements for installing Ghost Solution Suite

The following list includes the minimum system requirements for installing Ghost Solution Suite:

- **Ghost Solution Suite (GSS) Agent**
  GSS Agents require network connectivity and around 9 MB disk space. Other system requirements are the same as the host operating system.

- **Ghost Solution Suite Server**
  Symantec recommends running the GSS Server components on a modern, dedicated server with Pentium 4 processor and 2GB of RAM.

- Computers hosting additional PXE servers and file shares should meet the requirements of the operating system hosting these components.

- **Automation Requirements**
  Microsoft recommends 512 MB of memory for computers booting WinPE. At a minimum, you should have 384 MB to avoid boot errors.

- If the SQL Server 2014 Express database is installed from within the Ghost Solution Suite installer, then .NET framework 3.5 must be installed.
  For more information on system requirements for installing SQL Server 2014 Express, see the following URL:
  [microsoft.com](http://microsoft.com)
Note: If you face an error while installing SQL Server Express, Symantec recommends checking if all the Windows updates are installed.

- For WinPE 5.1, .NET 4.5 Framework should be installed before importing the Windows ADK 8.1.
  For more information, please refer to the following article: HOWTO124262

- The Ghost Solution Suite user should be part of the local administrator group on all the computers on which you want to install Ghost Solution Suite.

- Firewall must be disabled on all the computers on which you want to install Ghost Solution Suite.

- User Account Control (UAC) must be disabled on all the computers on which you want to install Ghost Solution Suite.

- Local security policy must be disabled on all the computers on which you want to install Ghost Solution Suite.
  To turn off User Account Control: Run all administrators in Admin Approval Mode policy, follow the following steps:
  - In the command prompt, run secpol.msc
  - Navigate to the Local Policies.
  - Select the Security Options.
  - Open the User Account Control: Run all administrators in Admin Approval Mode policy and select the Disable option.

- The Remote Registry service should be running on the remote computers where you plan to install Ghost Solution Suite Component.

Ports and Protocols used in Ghost Solution Suite
The following table lists the ports that are used in Ghost Solution Suite:

<table>
<thead>
<tr>
<th>Component</th>
<th>Service</th>
<th>Port(s)</th>
<th>Protocol</th>
<th>Where is this port connected?</th>
<th>Is this port configurable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>PXE MTFTP</td>
<td>MTFTP</td>
<td>69</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1758</td>
<td>UDP (Multicast)</td>
<td>PXE Client</td>
<td>Yes [Configure by editing PXE.ini file]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1759</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Service</td>
<td>Port(s)</td>
<td>Protocol</td>
<td>Where is this port connected?</td>
<td>Is this port configurable?</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>----------------------</td>
<td>---------</td>
<td>----------</td>
<td>--------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>File Transfer</td>
<td>TFTP</td>
<td>1025 to 5000</td>
<td>UDP/TCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PXE Server</td>
<td>PXE Server</td>
<td>67</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>68</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4011</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td>PXE Manager</td>
<td>PXE Manager</td>
<td>405</td>
<td>TCP</td>
<td>PXEConfig</td>
<td>Yes [Configure by editing RPC.ini file]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>406</td>
<td>TCP</td>
<td>PXE Cfg Service</td>
<td>Yes [Configure by editing RPC.ini file]</td>
</tr>
<tr>
<td>PXECfg Service</td>
<td>PXECfg Service</td>
<td>407</td>
<td>TCP</td>
<td>PXE Server and PXE MTFTP</td>
<td>Yes [Configure by editing RPC.ini file]</td>
</tr>
<tr>
<td>DB Management (mm)</td>
<td>DB Management Service</td>
<td>505</td>
<td>TCP</td>
<td>Win32 console, axengine, pxemanager</td>
<td>Yes</td>
</tr>
<tr>
<td>Ghost Solution Suite Server</td>
<td>Axengine</td>
<td>402</td>
<td>TCP/UDP (multicast)</td>
<td>Agents, pxeserver, DataManager, PXEManager</td>
<td>Yes</td>
</tr>
<tr>
<td>Linux Agent</td>
<td>ADLAgent</td>
<td>415</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AClient</td>
<td>AClient</td>
<td>402</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PCT Real-time Destination Agents</td>
<td></td>
<td>4949</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3829</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4950</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4951</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4952</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Note: To configure the file transfer port, in the Ghost Solution Suite console to use a specific port, navigate to Tools > Options > Global tab. Check the Client/Server file transfer port check-box and set the dedicated port that you want to use.

For more information, refer to the following article:
Ports and Protocols

Simple install for Ghost Solution Suite Server

The Simple Install option places all the Ghost Solution Suite Server Components - Ghost Solution Suite Server, Ghost Solution Suite Console, eXpress Share, and Ghost Solution Suite Database - on the same computer.

See “Ghost Solution Suite Server components” on page 33.

To run a simple install

1 Start the server and log on using the administrator account you created for the Ghost Solution Suite Server.
   See “PXE server” on page 37.

2 Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.

   The Symantec Packager Self-Extracting Executable Options dialog appears.

   Note: Symantec recommends running the installer with admin rights.

3 Select the Use current temp folder option to use the current temporary folder to download installation files or the Extract to a specific folder option to set a path to an existing folder to download the installation files.

4 Click Extract and Execute App to extract and execute the application immediately.

   The default extraction directory is C:\DSSsetup. You may have to wait for some time while Symantec Packager extracts files from this archive.

   Note: Click Extract Only to only extract the application and execute the application later. You must run the axInstall.exe file to start the installation.

5 Select the Simple Install option from the installation types listed in the Ghost Solution Suite Server Install Configuration dialog.
6 Click Yes on the Software License Agreement page.

7 Enter the following information on the Ghost Solution Suite Share Information page:
   - In the File Server path field, enter or browse to the path to install the Ghost Solution Suite Server program files. The default path is C:\Program Files(x86)\Altiris\eXpress\Deployment Server.
   - Select the Create Ghost Solution Suite Share option to create an eXpress Share on the computer. The eXpress Share lets you store files on the computer and run Ghost Solution Suite Server system applications. See “Deployment Share or eXpress Share” on page 36.
   - Browse and select the licence file.
   - You must enter an administrator user name and password for the Ghost Solution Suite Server. This account must already exist on the eXpress Share and the Ghost Solution Suite Server. By default, the name you are currently logged on as appears. If you use a domain account, enter the domain and the user name (Example: Domain\\administrator).

   Note: If a previous installation of the Ghost Solution Suite Database is detected, an axinstall prompt appears, asking whether you want to preserve or overwrite the existing database. Click Yes to preserve the data in your Ghost Solution Suite Database.

8 Click Install to install the listed components, or click Back to modify the settings before starting the installation. The installation process begins and can take several minutes. The Installation Information Summary page appears after the installation completes.

   Note: If you are upgrading your installation, the message Do you want to replace the share? appears. Click Yes and continue. If you click No, a message appears, stating that the share is already in use and you need to manually set the share to point to the correct directory. Click OK.

9 (Optional) You can select the following option to install agents.
   - Remotely install Ghost Solution Suite agent (Windows Vista, 2008 or later only). Select this option if you want to push the Ghost Solution Suite
agent to computers running Windows Vista, Windows 2008, or later operating systems.

10 Click Finish.

You have successfully completed a Simple Install for a Ghost Solution Suite Server system. Click the Ghost Solution Suite Console icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

Note: Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Ghost Solution Suite Server Win32 Console, the "Unable to connect to the Symantec Ghost Solution Suite Server Management Server. Please ensure this service is started and running currently." error appears. This occurs because the service files are deleted by the antivirus application during scanning. To resolve this issue, disable the antivirus software and reinstall the Ghost Solution Suite Server.

See “Custom install for Ghost Solution Suite Server” on page 44.

Custom install for Ghost Solution Suite Server

The Custom Install option lets you distribute all the Ghost Solution Suite Server Components - Ghost Solution Suite Server, Ghost Solution Suite Console, eXpress Share, and Ghost Solution Suite Database - on different computers. You can install Ghost Solution Suite Server on an existing SQL Server.

See “Ghost Solution Suite Server components” on page 33.

To run a custom install

1 Start the server and log on as the administrator account you created for the Ghost Solution Suite Server.

2 Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.

   The Symantec Packager Self-Extracting Executable Options dialog appears.

3 Click the Use current temp folder option to use the current temporary folder to download installation files or the Extract to a specific folder option to set a path to an existing folder to download the installation files.
4 Click **Extract and Execute App** to extract and execute the application immediately.

The default extraction directory is `C:\DSSetup`. You may have to wait for some time while Symantec Packager extracts files from this archive.

---

**Note**: (Optional) Click **Extract Only** to only extract the application and execute the application later. You must run the `axInstall.exe` file to start the installation.

---

5 Select the **Custom Install** option from the installation types listed in the **Ghost Solution Suite Server Install Configuration** dialog if any of the following conditions exist:

- You are using the NetWare file server as a eXpress Share.
- You are managing many computers and require a distributed architecture to meet bandwidth restrictions and other design requirements.

6 Click **Install**. Click **Yes** on the **Software License Agreement** page.

7 Enter the following information on the **Ghost Solution Suite Share Information** page:

- In the **File Server path** field, enter or browse to the path to install the Ghost Solution Suite Server program files. The default path is `C:\Program Files(x86)\Altiris\eXpress\Deployment Server`.

- Select the **Create Ghost Solution Suite Share** option to create a eXpress Share on the computer. The eXpress Share lets you store files on the computer and run Ghost Solution Suite Server system applications. The eXpress Share can exist on a Microsoft Windows server or Novell NetWare server.

---

**Note**: You can only create the share if it is on a Microsoft Windows Server; the Novell share should already be set up. See “[Deployment Share or eXpress Share](#)” on page 36.

---

- Browse and select the (.SLF) license file.

8 Enter the following information on the **Ghost Solution Suite Server Information** page:

- Select the computer where you want to install the Ghost Solution Suite Server. You can install the Ghost Solution Suite Server on the local computer or on a remote computer. The IP address and the port information for the selected computer are displayed by default.
Enter the path where you want to install the Ghost Solution Suite Server.

You must enter an administrator user name and password for the Ghost Solution Suite Server. This account must already exist on the eXpress Share and the Ghost Solution Suite Server. By default, the name you are currently logged on as appears. If you use a domain account, enter the domain and the user name (Example: Domain1\administrator). (See “Installing Ghost Solution Suite Server” on page 22.) Click Next.

9 Enter the **Ghost Solution Suite Database** information and click Next.

- Specify the Microsoft SQL Server Instance where you want to install the database.

  **Note:** If you have already set up multiple instances of the Microsoft SQL Server, you can identify a specific database instance in this field using the format: `<SQL Server Name>\<database instance>`.

- Depending upon the selection of the SQL Server instance, the default port at which the selected instance is listening appears in the **SQL Port Number** field. You can edit the port number if you have manually entered the SQL Server name or if the port number does not appear automatically due to some firewall restriction.

- You can enter a name other than eXpress in the **Database Name** field.

10 Select the type of Ghost Solution Suite Database authentication to be used. You must enter the user name and password if you want to use SQL Server authentication.

  **Note:** You cannot use the remote SQL database with NT authentication on a remote computer if you do not have administrative rights on the computer.

  Click Next.

  **Note:** If a previous installation of the Ghost Solution Suite Database is detected, an `axinstall` prompt appears, asking whether you want to preserve or overwrite the existing database. Click **Yes** to preserve the data in your Ghost Solution Suite Database.

11 Specify how you want to connect your managed computer to the Ghost Solution Suite Server by selecting one of the following options.
Select the **Connect directly to Ghost Solution Suite Server** option and enter the Ghost Solution Suite Server IP address and port.

Select the **Discover Ghost Solution Suite Server using TCP/IP multicast** option and provide the Server name.

**Note:** If you leave the **Server name** field blank, the Ghost Solution Suite agent connects to the first Ghost Solution Suite Server that responds. Click **Next**.

**12** Click **Install** to install the listed components or click **Back** to modify the settings before starting the installation. The installation process begins and can take several minutes. The **Installation Information Summary** page appears after the installation completes.

**Note:** If you are upgrading your installation, the message **Do you want to replace the share?** appears. Click **Yes** and continue. If you click **No**, a message appears stating that the share is already in use and you must manually set the share to point to the correct directory. Click **OK**.

**13** (Optional) You can select one of the following option to install agents on the managed computers.

- **Remotely Install Ghost Solution Suite agent (Windows Vista, 2008 or later only)**. Select this option if you want to push the Ghost Solution Suite agent to Windows computers directly after the installation. This can be done any time by selecting **Tools > Remote Agent Installer**.

**14** Click **Finish**.

You have successfully completed a Custom Install for a Ghost Solution Suite Server system. Click the Ghost Solution Suite Console icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

See “Simple install for Ghost Solution Suite Server” on page 42.

---

**Thin client install**

The thin client install option lets you install the Thin Client view of the Ghost Solution Suite Console on your computer. You can install Ghost Solution Suite Server with a Microsoft Data Engine (MSDE) or install it on an existing SQL Server. You need not provide a license file for the Thin Client installation.
To run a thin client install

1. Start the server and log on using the administrator account you created for the Ghost Solution Suite Server.

2. Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.

   Symantec recommends running the installer with admin rights.

   The **Symantec Packager Self-Extracting Executable Options** dialog appears.

3. Select the **Use current temp folder** option to use the current temporary folder to download installation files or the **Extract to a specific folder** option to set a path to an existing folder to download the installation files.

4. Click **Extract and Execute App** to extract and execute the application immediately.

   The default extraction directory is `C:\DSSsetup`. You may have to wait for some time while Symantec Packager extracts files from this archive.

   **Note:** Click **Extract Only** to only extract the application and execute the application later. You must run the `axInstall.exe` file to start the installation.

5. Select the **Thin Client Install** option from the installation types listed in the **Ghost Solution Suite Server Install Configuration** dialog.

6. (Optional) Select the **Include PXE Server** option to install the PXE Server. (See “PXE server” on page 37.) Click **Install**.

7. Click **Yes** on the **Software License Agreement** page.

8. Enter the following information on the **Ghost Solution Suite Share Information** page:

   - In the **File Server path** field, enter or browse to the path to install the Ghost Solution Suite Server program files. The default path is `C:\Program Files(x86)\Altiris\eXpress\Deployment Server`.

   - Select the **Create Ghost Solution Suite Share** option to create a eXpress Share on the computer. The eXpress Share lets you store files on the computer and run Ghost Solution Suite Server system applications. See “Deployment Share or eXpress Share” on page 36.

   - You must enter an administrator user name and password for the Ghost Solution Suite Server system. This account must already exist on the eXpress Share and the Ghost Solution Suite Server. By default, the name you are currently logged on as appears. If you use a domain account, enter
the domain and the user name (Example: Domain1\administrator). See “Ghost Solution Suite Server” on page 34.

If a previous installation of the Ghost Solution Suite Database is detected, an **axinstall** prompt appears, asking whether you want to preserve or overwrite the existing database. Click **Yes** to preserve the data in your Ghost Solution Suite Database.

Click **Next**.

9 Click **Install** to install the listed components, or click **Back** to modify the settings before starting the installation. The installation process begins and can take several minutes. The **Installation Information Summary** page appears after the installation completes.

---

**Note:** If you are upgrading your installation, the message **Do you want to replace the share?** appears. Click **Yes** and continue. If you click **No**, a message appears, stating that the share is already in use and you must manually set the share to point to the correct directory. Click **OK**.

---

10 (Optional) You can select the following option to install agents.

- **Remotely install Ghost Solution Suite agent (Windows Vista, Windows 2008 or later only)**. Select this option if you want to push the Ghost Solution Suite agent to computers running Windows Vista, Windows 2008, and later operating systems.

11 Click **Finish**.

You have successfully completed a Thin Client install for a Ghost Solution Suite Server system. Click the **Ghost Solution Suite Console** icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

---

**Note:** Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Ghost Solution Suite Server Win32 Console, the "Unable to connect to the Symantec Ghost Solution Suite Server Management Server. Please ensure this service is started and running currently." error appears. This occurs because the service files are deleted by the antivirus application during scanning. To resolve this issue, disable the antivirus software and reinstall the Ghost Solution Suite Server.
Component install

The component install option lets you add selected Ghost Solution Suite Server Components - Ghost Solution Suite Console, PXE Server, and Ghost Solution Suite Agents to the existing eXpress Share. You can also add Microsoft Sysprep files. See “Ghost Solution Suite Server components” on page 33.

To run a component install

1. Start the server and log on using the administrator account you created for the Ghost Solution Suite Server.

2. Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.
   Symantec recommends running the installer with admin rights.
   The Symantec Packager Self-Extracting Executable Options dialog appears.

3. Select the Use current temp folder option to use the current temporary folder to download installation files or the Extract to a specific folder option to set a path to an existing folder to download the installation files.

4. Click Extract and Execute App to extract and execute the application immediately.
   The default extraction directory is C:\DSSetup. You may have to wait for some time while Symantec Packager extracts files from this archive.

   **Note**: (Optional) Click Extract Only to only extract the application and execute the application later. You must run the axInstall.exe file to start the installation.

5. Select the Component Install option from the installation types listed in the Ghost Solution Suite Server Install Configuration dialog and click Install.

6. Click Yes on the Software License Agreement page.

7. Enter a path for the eXpress Share and click Next.

8. Select the components you want to install and click Next.

   - **Install an additional Ghost Solution Suite Console.** Select this option to install another Ghost Solution Suite Console (a Windows executable) on another computer. You can add as many Ghost Solution Suite Consoles as required to manage from multiple consoles across your system, but you can install only one at a time. The Ghost Solution Suite Console Information dialog appears.
- **Install an additional Symantec PXE Server.** Select this option to add additional PXE Servers across a network segment to handle boot requests for large environments. The **PXE Server Information** dialog appears. **Master PXE Server.** When you add another PXE Server, the PXE Server that you initially installed is designated as the Master PXE Server. The Master PXE Server works concurrently with any additional PXE Server to handle boot requests across the network segment, but it also allocates additional blocks of IP addresses to other PXE Servers in the system. For all the available options for installing PXE Server, refer to the following section:
  See “PXE server” on page 37.

- **Install additional Ghost Solution Suite Agents.** Select this option to install additional Ghost Solution Suite Agents on client computers, setting up managed computers in the Ghost Solution Suite Server system. The **Remote Agent Install** dialog appears. Enter common administrator credentials for all client computers.
  See “Enter administrator account information” on page 55.

9 Select if you want to repair the PXE Manager.

---

**Note:** Symantec recommends running the repair PXE Manager option only on the computers on which PXE manager is already installed.

Before you select the option to repair the PXE manager, ensure to comply with the following:

- Uninstall all the PXE components (PXE Server and PXE Manager).
- Restart the computer.
- Relaunch the installer and select the Repair PXE Manager option.
- Select the **Install an additional Symantec PXE server** to install the PXE servers again.

10 Select the computer where you want to install the selected components and click **Next**. The **Installation Information** page appears.

---

**Note:** If you select the **On a remote computer** option, you must browse and select the remote computer.
11 Click Install to install the listed components or click Back to modify settings before starting the installation. The installation process begins and can take several minutes. The Installation Information Summary page appears, specifying that the installation was successful.

12 Select the Install add-ons to provision server hardware option to install the add-ons for Dell computers. Click Finish.

---

Note: This option is enabled on Dell computers only when add-ons are present in the oeminstall-addons section of the oeminstall.ini file, which is located in the eXpress directory. This is the only option available on the Installation Information Summary page when you select Component Install.

---

You have successfully completed a Component Install for a Ghost Solution Suite Server system. Click the Ghost Solution Suite Console icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

## Installing Ghost Solution Suite Agents

Each client computer requires the Ghost Solution Suite Agent to run as the Production Agent on a local hard disk, which communicates with the Ghost Solution Suite Server and registers in the Ghost Solution Suite Database. For Windows and Linux client computers, Ghost Solution Suite lets you push agent software to a client computer See “Installing the automation agent” on page 63. from a Ghost Solution Suite Console, or you can pull the Ghost Solution Suite Agent to the client computer from the eXpress Share.

- **Ghost Solution Suite agent.** Install a Production Agent to a Windows desktop, notebook, or server computer. You can also install this agent on any supported Linux workstation or server. See “Installing Ghost Solution Suite agent for Windows” on page 57.

- **Ghost Solution Suite agent on Linux.** Install on any supported Linux workstation or server. See “Installing Ghost Solution Suite agent on Linux” on page 61.

- **Automation Agent.** Install on any Windows desktop, notebook, or server computer.

- **Ghost Solution Suite agent on XP, 2003, Vista (Business) and 2008 Server.** Install the Ghost Solution Suite agent on the selected Windows XP, Server 2003, Vista (Business), and Server 2008 computers.
Client connectivity and network adapters

Symantec supports all standard network adapter cards and includes many drivers with the installation of Ghost Solution Suite. However, sometimes outdated drivers (including default drivers that come with the hardware) cause problems when clients are in automation mode. To avoid these problems, you should check the manufacturer's Web site for your network adapter to ensure you use their latest driver in your pre-boot operating system configuration file.

Some common client problems that can be solved by updating drivers are:

- Locking when loading drivers or failing to connect to the server
- Locking when imaging (downloading, uploading, or multicasting)

Microsoft client drivers

The Boot Disk Creator is set up to work with drivers that follow a certain standard. Because not all NIC drivers follow that standard, you may have to move the files to a different location.

Ensure that the following files are in the same directory:

- The sample protocol.ini that comes with your driver (protocol.ini)
- The OEM setup file that specifies the DOS driver (oemsetup.inf)

Example: The OEM setup file may contain lines similar to the following:

```
[netcard]
NGRPCI="NETGEAR FA310TX Fast Ethernet PCI Adapter",0,ndis,ethernet,real,NGRPCI,NGRPCI_NIF
[NGRPCI] (This header must be the sixth item listed in the line above)
Device=NGRPCI.DOS (If this line is missing, add it. The syntax is device=drivername.)
```

If there is no protocol.ini file, create a text file that contains the following command: DriverName=drivername.

Installing the Ghost Solution Suite agent

For client computers running a Windows operating system, Ghost Solution Suite lets you install agent software using the Remote Agent Installer to "push" the agent to a client computer from a Ghost Solution Suite Console. (See “Remote agent installer” on page 54.) You can also pull the Ghost Solution Suite agent to the client computer by accessing the Windows share. You must have administrative rights to the client computers and File and Print Sharing must be enabled to install the agent software.
Click Remote Agent Installer on the Ghost Solution Suite Console toolbar, or click Tool > Remote Agent Installer to open the utility program. You can also download DAgent.exe from the network share to install a Ghost Solution Suite agent.

Remote agent installer

DAgent replaced AClient as the default agent for the following Windows platforms:

- Windows 2000 SP4 or higher
- Windows 2003 Server
- Windows XP SP2 or higher
- Windows Vista
- Windows 2008 Server
- Windows 2008 Server R2
- Windows 7
- Windows 8
- Windows 8.1
- Windows 10
- Windows Server 2012
- Windows Server 2012 R2
- Windows Server 2016

Windows XP

To install, each XP computer must have the following items:

- An Administrator account with a password. This account must be able to browse \\hostname\admin$ on the selected computer.
- Disabled simple file sharing. This option can be disabled in Windows Explorer by selecting Tools > Folder Options > View tab and clearing the Use simple file sharing check box in the Advanced settings section.
- Enabled File and printer sharing in the Windows Firewall.

Windows 2003, Vista, 2008 servers, and Windows 7

You must enable file and print sharing in the Windows Firewall.
A domain user from the Domain Admins group can install the agent using the Remote Agent Installer on the client computers if you add the user to the local administrator group. A client computer which is a member of the domain, has the local built-in administrator disabled by default.

**Enter administrator account information**

Enter common administrator credentials for all client computers, or keep the default credentials to be prompted for each client computer.

Let me specify a username and password for each machine as it's installed. Prompts for an administrative user name password for each computer in the remote install list. This is the default option.

Use this username and password for all clients. Enter credentials for an administrator account that has rights to all the client computers that you add to the remote install list.

**Specify install directory**

Enter a location to install the Ghost Solution Suite agent.

**Install directory.** Enter the path to install the Ghost Solution Suite agent on the client computer.

Enable this agent to use SIDgen and/or Microsoft Sysprep. If you plan to use SIDgen or Sysprep to configure this computer the required files can be copied when the agent is installed.

Click Change Settings to set the Ghost Solution Suite agent settings.

**Automatically add to a group**

You can select one of the following options to automatically add new computers to the group that you specify.

Add client(s) to default group. Adds new computers to the All Computers group.

Add client(s) to a specific group. Adds new computers to another group. Use backslashes to separate subgroups.

**Select computers on the network**

Identify client computers on the network and add them to a list of computers to remotely install the Ghost Solution Suite agent.

Add. Select the computers by the name in the list, or enter a computer name or IP address.
**Computer Name.** Enter the name of a computer on the network or its IP address.

**Properties.** Select a computer and view the agent install settings. You can also change Agent settings from the **Agent Properties** dialog.

**Import.** Import new computers from a file. This file has the following parameters: 


The parameters must be entered in this order. The password parameter is not required if the administrator account does not have one assigned. If you are using the default settings, you do not need to specify an input file name. Each computer entry must be on a separate line.

**Export.** You can export the listed computers into an export file to use later. The default extension is `.RCI`. Remote Agent Installer first looks for an `.RCI` file extension.

When the computers appear in the installer list and the properties are set, click **Finish.** The status of the agent install appears.

After the Ghost Solution Suite agent is installed, it automatically connects to the Ghost Solution Suite Server and appears in the **Computers** pane of the Ghost Solution Suite Console.

**Download Microsoft Sysprep**

If you select **Enable this agent to use SIDgen and/or Microsoft Sysprep** on the previous dialog, the **Remote Agent Installer** dialog locates the required installation files for the specific versions of Sysprep.

**Update file system permissions when changing SIDs.** Select this option to automatically update file system permissions to maintain the individual file permissions that you may have set. This also includes the individual network shares that may exist on this client. On selecting this option, SID conversion takes a long time.

To install Microsoft Sysprep, you must download the installation files required for the Windows operating systems running on the client computer.

**Windows 2000/XP/2003 (deploy.cab)**

We recommend installing these files from a Windows 2003 server CD. Windows Vista and 2008 Server include Sysprep files by default.
Change settings
Click Change Settings to modify access, security and other settings on the Ghost Solution Suite agent to be installed.

Get server security key
This page appears only if you select the Enable key-based authentication to Ghost Solution Suite Server option in the Default Agent Settings dialog.

Enter the security key file path for the Ghost Solution Suite Server or browse and select a file containing the security key file path.

Installing Ghost Solution Suite agent for Windows

Run dagent.msi from the eXpress Share (shared folder).

1. On the Symantec Client Service dialog, enter a location to install the Ghost Solution Suite agent. Select one of these options, if required, and click Next:
   - Secure modification of server properties. Select to prohibit users from changing any agent settings.
   - Enable changing of Security ID. Select to manage the security IDs to run a SID utility as part of an imaging job.
   - Advanced. Click to open the Computer Configuration Properties dialog and enter the settings for the Ghost Solution Suite agent you are installing. See “Computer configuration properties” on page 104.

2. If you have enabled the security IDs, a page listing the options for managing the SIDs appears. Select the utilities you want to use and enter the path where the utilities are stored. Click Next to install the Ghost Solution Suite agent.

3. (Optional) Select a group in the Ghost Solution Suite Console to add the client to. You can also leave it at the default group.

After the Ghost Solution Suite agent is installed, it connects to the Ghost Solution Suite Server and appears in the Computers pane of the Ghost Solution Suite Console.

See "Installing Ghost Solution Suite Agents" on page 52.

Scripted installation of Ghost Solution Suite agent

You can run scripted install of Ghost Solution Agent using default agent settings or you can run the scripted install with advanced configurations.

- Scripted install with default agent settings
Scripted install with advanced configuration settings

Ghost Solution Suite lets you install the Ghost Solution Suite agent with advanced configurations. Use the Aclient.inp file to configure additional settings during dagent install on the client computer. The Aclient.inp file is present in the C:\Program Files (x86)\Altiris\eXpress\Deployment folder.

- Create or edit the Aclient.inp file.
- Copy the dagent.msi on the client computers.
- Run the dagent.msi from the command prompt

Create or edit the Aclient.inp file.

Edit the Aclient.inp file in notepad and enter the configurations that you want to implement on the client computer.

Create the following folder structure on the client computer and copy the Aclient.inp file:

C:\Program Files\Altiris\Dagent

Following is an example of Aclient.inp file:

;---------------------------------------------------------------------

; MCastAddr is the multicast group address to be used to find the
; Deployment Server (optional)

; MCastPort is the port number to use while multicasting (optional)
; TTL is the maximum number of hops to multicast through (optional)
; ServerName is the computer name of the server (optional)
;---------------------------------------------------------------
; MCastAddr=225.1.2.3
; MCastPort=402
; TTL=32
; ServerName=GSSSERVER
;---------------------------------------------------------------
; TcpAddr is the IP address of the Deployment Server to connect to (optional)
; TcpPort is the IP port number of the Deployment Server listening for
; requests (optional)
; Note: Specifying these parameters will switch the DAgent to use
; TCP to connect to the server.
;---------------------------------------------------------------
; TcpAddr=SERVER-IP-ADDRESS
; TcpPort=402
;---------------------------------------------------------------
; LogFile field is the full pathname to the log file (optional)
; LogSize is the maximum log file size (optional)
; LogErrors - If this is Yes, then errors will be logged
; LogInformation - If this is Yes, then information items will be
; logged.
; LogDebug - If this is Yes, then detailed debug information will be
; logged.
;---------------------------------------------------------------
; LogFile=c:\Windows\Temp\Dagent.log
; LogSize=4096
; LogErrors=Yes | No
;LogInformation=Yes | No
;LogDebug=Yes | No

; PromptExecute parameter is used to prompt the user when tasks are
; being executed (optional)
; PromptReboot parameter is used to prompt the user before
; the computer restarts (optional)
; PromptRemoteControl parameter is used to prompt if someone attempts
; to remote control this computer.
; PromptSeconds is the number of seconds that DAgent will
; wait for a response from the user (optional)
; PromptOverride is the default action to take when the user
; has not responded to the prompts (optional)

; PromptExecute=Yes | No
; PromptReboot=Yes | No
; PromptRemoteControl=Yes | No
; PromptSeconds=30
; PromptOverride=Abort | Continue

; EncryptSessions - Specifies whether or not DAgent will attempt to
; make an encrypted session with the server
;
; RequireEncrypt - Specifies whether or not DAgent will fail to
; connect if an encrypted session cannot be
; established.

; EncryptSessions=Yes | No
; RequireEncrypt=Yes | No
Copy the dagent.msi on the client computers.

Copy the dagent.msi on the client computers based on the architecture of the client computers.

The dagent.msi is present at the following location:

<Install_dir>:\Program Files (x86)\Altiris\eXpress\Deployment Server\Agents\AClient

- For x86: Dagent.msi /qn
- For x64: Dagent_x64.msi /qn

Run the dagent.msi from the command prompt

To run the scripted install of dagent, run the appropriate command on the client computer:

- For x86
  Dagent.msi /qn
- For x64
  Dagent_x64.msi /qn

Installing Ghost Solution Suite agent on Linux

You can install the Ghost Solution Suite agent on any supported Linux workstation or server by downloading and running the Ghost Solution Suite agent for Linux installation file (a .BIN file) on the client computer. The Ghost Solution Suite agent is updated automatically on Linux computers when you upgrade to a new version of Ghost Solution Suite. The creation date of the Ghost Solution Suite agent is checked and updated when a new agent is available.

**Note:** Currently, Ghost Solution Suite does not support UEFI-based Linux computers.

Installing the Ghost Solution Suite agent for Linux

1. After downloading the .BIN file to a local directory, you can install from the command line.

   - Browse to the directory where you saved the .BIN file, switch to the root user (su) and change the directory to the location of the .BIN file by entering (cd < directory>)

   - After changing the directory, you must have the permission to execute the .BIN file; to obtain the permission, enter chmod 544 <filename>

   - Enter: ./<file name>
The Ghost Solution Suite agent for Linux is installed in the
/opt/altiris/deployment/adlagent directory.

2 To change the adlagent configuration file settings, update the adlagent.conf
file. This file is located in the /opt/altiris/deployment/adlagent/conf
directory. You can also change the adlagent configuration file settings by
executing the configure script from the
/opt/altiris/deployment/adlagent/bin directory.

■ To edit the configure file directly, open the adlagent.conf file located in
the /opt/altiris/deployment/adlagent/conf directory and make the
required changes.
You can also edit the configuration file to change the functionality or
properties. Example: You can open the adlagent.conf file in an editor and
scroll to the [Transport] section and the UseMcast line. Change
UseMcast=true to UseMcast=false. In the TCPAddr=<IP address> line,
enter the IP address of the specific Ghost Solution Suite Server you want
to manage the client computer. You can also identify and edit additional
configuration settings in the configuration file.

■ To run the script to change the settings for the adlagent configuration file,
browse to the /opt/altiris/deployment/adlagent/bin directory from
the shell and enter .configure
You are prompted to select Multicast options to identify a Ghost Solution
Suite Server to manage the current client computer, or you can select a
specific Ghost Solution Suite Server by setting the Multicast option to false
and adding the IP address of the required Ghost Solution Suite Server.

3 After editing the configuration file, restart the Ghost Solution Suite agent for
Linux.
To start and stop the Ghost Solution Suite agent for Linux, enter the full path
or browse to the /etc/rc.d/init.d directory (with administrator/root rights).
You can use either the adlagent stop and adlagent start commands, or
only the adlagent restart command. You can also use the Package Manager
installed with Linux to restart the Ghost Solution Suite agent for Linux.
By stopping and starting the Ghost Solution Suite agent for Linux, the service
updates the changes made in the adlagent configuration file.

You can now view the Linux managed computer from a Ghost Solution Suite
Console.

See “Installing Ghost Solution Suite Agents” on page 52.
Installing the automation agent

Here are some other ways to create and install an Automation Agent, which is saved in an embedded (recommended) or hidden partition on the client computer's hard disk.

- For Ghost Solution Suite systems running the PXE Server, create boot menu options from the PXE Configuration Utility, using one of the following methods: **Boot Disk Creator**, **Direct from floppy**, or **User Specified**. See PXE Configuration Utility Help.

Installation help

The following are the help file topics for the Ghost Solution Suite Server installation program that you can access by clicking Help or pressing the F1 key. These topics identify and explain the elements on the dialogs used in the installation process.

**Installing Ghost Solution Suite Server**

Specify the eXpress Share (shared directory) where you want to store the image files, and other package files. Before installing the Ghost Solution Suite Server, ensure that you have a shared Windows or NetWare directory with free disk space and appropriate security rights.

**File server path.** Select the drive letter and directory path where you want to install the Ghost Solution Suite Server. The default path is the Program Files directory on the local computer.

**Create Ghost Solution Suite Share.** If you are installing the Ghost Solution Suite Server on a local Windows computer, select this option to create a shared directory as your eXpress Share. If you are installing on a remote file server or if you select an invalid path, this option is unavailable.

**Note:** If you are installing the Ghost Solution Suite Server on a remote file server, create a share or grant access rights to the Ghost Solution Suite Server directory on the file server before you start the installation.

See “Deployment Share or eXpress Share” on page 36.

Select one of the following options to configure the licensing information:

See “Ghost Solution Suite Server components” on page 33.

See “Installing Ghost Solution Suite Server” on page 63.
Installing Ghost Solution Suite Server using component install

Specify the eXpress Share (shared directory) where the image files, and other package files are stored. Ensure that you have a shared Windows or NetWare directory with available disk space and security rights before installing.

See “Deployment Share or eXpress Share” on page 36.

Ghost Solution Suite Server install

Install the Ghost Solution Suite Server on a server. The service is identified in the Services section of the Windows Computer Management as Altiris eXpress Server.

See “Ghost Solution Suite Server” on page 34.

To install service on a local server

1 Select the On this computer option.
2 Enter the Ghost Solution Suite Server IP address and port information.
3 Enter the path to install the Ghost Solution Suite Server.
4 Enter the user name and password of the Ghost Solution Suite Server. For a domain account, enter the domain and user name. Create this account before starting the installation.

To install service on a remote server

1 Select the On a remote computer option.
2 Enter the name of the computer or browse to where you want to install. By default, the destination path and IP address of the computer appear.
3 Enter the user name and password of an administrator account for the Ghost Solution Suite Server computer. For domain accounts, include the domain name (Example: orgDomain\admin). The user account must have rights to the eXpress Share. Create the administrator domain account before starting the installation.

See “Deployment Share or eXpress Share” on page 36.

Ghost Solution Suite Database install

Install the Ghost Solution Suite Database on a local or remote server with or without an existing Microsoft Data Engine (MSDE) or Microsoft SQL Server. To install the database, you must have administration rights to the selected server.

See “Ghost Solution Suite Database” on page 35.
**Note:** If you have multiple instances of the Microsoft SQL Server already set up, you can identify a specific instance using this format: `<SQL Server Name>\<database instance>`. The instance of the database can vary. Example: If you have a clustered Microsoft SQL Server to manage multiple Ghost Solution Suite systems on different network segments, you can enter the name `salesSegment\express` or `marketingSegment\express` depending on the previously established database instance.

Install the Ghost Solution Suite Database using these options:

- Select the Microsoft SQL Server instance where you want to install your Ghost Solution Suite Database.
- You can also change the default SQL Port number.
- You can rename the Ghost Solution Suite Database default name, eXpress, by entering a different name in the **Database Name** field. However, this does not alter the eXpress Share name.

See “Ghost Solution Suite Server components” on page 33.

**PXE server install**

Select the options to boot locally using the Symantec Automation Folder. For PXE-compliant computers, you can boot across the network using the Intel Pre-boot eXecution Environment option in the PXE Server.

See “PXE server” on page 37.

**Note:** If you have a Novell NetWare file server, you must set up the PXE Server after installing the Ghost Solution Suite Server. The Universal Network Device Interface (UNDI) default driver is not supported by Novell NetWare.

- Select the **No I will be using an Symantec automation folder on each client computer** option, if you do not want to use PXE and prefer to use embedded (preferred) or hidden partitions, or bootable media to run tasks.

  **Note:** This option is unavailable for installing the PXE Servers using the Component Install option.

- Select the **Yes, I want to install PXE Server on this computer** option to install the PXE Server on the local computer.
Note: This option is selected by default for the Component Install.

- Select **Yes, I want to install PXE Server on a remote computer** to install the PXE Server on a remote computer. Enter the name of the computer and the path.
- Enter the IP address for the PXE Server and the Ghost Solution Suite Server.
- Enter the path where you want to install the PXE Server.
- In case of upgrade, select the pre-boot operating system that can be used as the default PXE boot menu item.

See “Installing the automation agent” on page 63.

**Client connection to server**

Select the protocol your managed computers can use to connect to the Ghost Solution Suite Server.

**Connect directly to Ghost Solution Suite Server.** Installs the PXE Server using the Intel Pre-boot eXecution Environment (for PXE-compliant computers only). You can use this without PXE for faster access, as it goes directly to the IP address without searching.

If managed computers are on a different segment or if you are using the PXE Server with an UNDI driver, click **Connect directly to Ghost Solution Suite Server** and enter the IP address of the Ghost Solution Suite Server that the managed computers can connect to. Do not change the port number unless the default is already being used.

Note: If you change the port number, you must change the client configurations.

**Discover Ghost Solution Suite Server using TCP/IP multicast.** Lets the managed computers connect to any Ghost Solution Suite Server. To use multicasting and connect to a specific Ghost Solution Suite Server, enter the name of the Ghost Solution Suite Server computer.

Multicasting cannot be used with the UNDI driver. If you want to use different drivers on the PXE Server, you can create multiple PXE boot files after installing.

See “Ghost Solution Suite Agents ” on page 115.

**Installing components**

Click **Install**, or click **Back** to change the settings.
See “Ghost Solution Suite Server components” on page 33.

**Ghost Solution Suite Database authentication**

Specify the type of authentication the Ghost Solution Suite Database will use. You can select Windows authentication or SQL Server authentication. If you select SQL authentication, enter the user credentials with administrative rights for the SQL database.

**Use Windows NT authentication.** Select this option to use the Windows network or Active Directory authentication.

**Use SQL Server authentication.** Enter the user name and password set for the Microsoft SQL Server. If using MSDE, the default "sa" user name is used and no password is required.

See “Ghost Solution Suite Server components” on page 33.

See “Installing Ghost Solution Suite Server” on page 22.

**Add components**

If you have already installed Ghost Solution Suite Server, you can add components to the existing system. Select the type of component you want to add.

See “Ghost Solution Suite Server components” on page 33.

**Console install**

You can install the Ghost Solution Suite Console either on the local server or on multiple remote computers. Installing the Ghost Solution Suite Console on remote servers lets you manage servers from multiple Ghost Solution Suite Consoles across the Ghost Solution Suite Server installation.

See “Ghost Solution Suite Console” on page 33.

- Select the **On this computer** option to install the Ghost Solution Suite Console on the local server.
  - Select the **On a remote computer** option to install the Ghost Solution Suite Console on a remote server. Enter the computer name or browse and select a computer.

See “Installing Ghost Solution Suite Server” on page 22.

See “Ghost Solution Suite Server components” on page 33.
Managing from the Ghost Solution Suite Console

This chapter includes the following topics:

- Managing from the Ghost Solution Suite Console

Managing from the Ghost Solution Suite Console

Ghost Solution Suite provides a Windows console to deploy and manage computer devices across local or wide area networks. It also provides a Thin Client view of the Ghost Solution Suite Console. As an IT administrator, you can manage all computer devices from one of these Ghost Solution Suite Consoles:

The Ghost Solution Suite Console is a Windows-based console with complete deployment and management features, security, PXE Server configuration, image editing, and other deployment utilities and features.

The Thin Client View of the Ghost Solution Suite Console provides a simplified experience when dealing exclusively with Thin Clients. The functionality of the Thin Client Console is identical to that of the current Ghost Solution Suite Console. However, you can toggle from Full View to Thin Client View.

To launch the Ghost Solution Suite Console, click the icon on the desktop, or click Start > Programs > Altiris > Deployment Solution > Console.

Features of the Ghost Solution Suite Console

The Windows console for Ghost Solution Suite provides standard Computers, Jobs, and Details panes to drag and drop icons, view properties, and identify the state and status of Deployment objects. In addition, the Ghost Solution Suite Console also includes a Shortcuts and Resources view and provides the tools, utilities, and features required for complete computer resource management.
Set program options. From the Tools > Options dialog, you can set preferences for each Ghost Solution Suite server system.
See “General options” on page 81.

Set security. From the Tools > Security dialog, you can set security rights and permissions for all Ghost Solution Suite Consoles.
See “Security in Ghost Solution Suite” on page 86.

Connecting to other Ghost Solution Suite server systems. Connect to other Ghost Solution Suite server connections from your current Ghost Solution Suite Console and manage computers outside of your current network segment or site.
See “Connecting to another Ghost Solution Suite server” on page 93.

Ghost Solution Suite Console basics
The Ghost Solution Suite Console is your main portal to Ghost Solution Suite. It is a feature-rich Win32 program with real-time access to computer resources, deployment jobs, and package files, each represented by distinct icons to identify the status and settings. From the Ghost Solution Suite Console, you can build simple or complex deployment jobs, assign them to a computer group, and verify deployment execution.

Because the Ghost Solution Suite Console can reside on its own server, you can have multiple consoles running from different locations. The Ghost Solution Suite Console needs to be running only while creating assignments or viewing information about the managed computers. You can turn on the console, run management tasks, and turn off the console.

Scheduling information is saved in the Ghost Solution Suite Database and tasks are executed at their scheduled time. If an assignment to a managed computer is made from two different consoles at approximately the same time, the computer is assigned those tasks in the order they are received.

See “Console options” on page 82. to set refresh intervals for the Ghost Solution Suite Console.

Thin client view of the Ghost Solution Suite Console
The Thin Client view of the Ghost Solution Suite Console provides a simplified experience when dealing exclusively with Thin Clients. The functionality of the Thin Client view is identical to that of the current Ghost Solution Suite Console. However, you can switch from Full view to Thin Client view.

The Thin Client Console has the following panes:

- Computers
The Computers, Resources, and Software Packages panes are on the left side of the Thin Client view, while the Inventory pane is on the right side of the Thin Client view.

Installing the thin client view

During installation, you can install the Ghost Solution Suite Thin Client view. By default, the traditional Ghost Solution Suite Console is installed.

If you select Thin Client view, a Thin Client Jobs system folder is created. All the jobs created from the Ghost Solution Suite Thin Client view are stored in this folder. During the installation process, the following folders are created in this hierarchy for the Thin Client resources:

- Configuration Packages
- Images
- Software Packages

Ghost Solution Suite for Thin Clients uses the same installation program as Ghost Solution Suite. No licensing is required even if you select Thin Client Install.

To install Thin Client, choose one of the following options:

To install thin client

- On the Ghost Solution Suite server Install Configuration dialog, select the Thin Client Install option. The Ghost Solution Suite Console Thin Client View appears.

Switching between two views

When you switch between the traditional view and the Thin Client view, you can maintain the last state in which you viewed the console. This ensures that you open the console in the same view that you last closed it in.

To switch between the traditional and the thin client view

1. Click View.
2. Select Show Thin Client View.
**Note:** By default, the Thin Client view is visible if you select Thin Client Install.

When you switch to the Thin Client view, all the menus and items that are not necessary for the Thin Client view are unavailable. These are visible when you switch to the traditional view.

**Computers pane**

This pane is the same as that in the traditional view. However, only thin clients are displayed. You can right-click this pane to view a new menu. When you right-click a thin client, you can view the following options:

- Capture Configuration
- Capture Images
- Deploy Configuration
- Install Automation Folder
- Get Inventory
- Power Control
- Properties
- Delete
- Manage Inventory View

If you select a Capture option, a text field appears, prompting you for the name of the captured resource. By default, the name is the same as the serial number on the Thin Client, which you can change.

If you select a deploy option, a list of the available resources appears for the selected type, such as Configurations, Images, or Software Packages. You can select a resource from this list.

**To create a job**

You can create a job in one of the following ways:

- Select any of the first six options from the Computers pane. All these jobs are scheduled at the current time.

**Note:** The Schedule Computers for Job dialog does not have the Job Schedule tab. Also, all the automation jobs have the default option selected for boot image.
Drag resources to the Computers pane or computers to the Resources pane to schedule jobs at the current time.

**Note:** Ensure that you have the required permissions to drag and drop resources.

All thin client job details are saved in the Thin Client Jobs system folder. You cannot delete or rename this new system folder from the console.

All the above options, except Properties, are disabled when the client is not active.

**Note:** All the jobs on the thin clients are automatically created and scheduled by the console, and this happens only when the clients are active. When creating the jobs, the console refers to the operating system type (platform) of the client.

**Resources pane**

This pane is a tree view listing all the resources that you can drag and drop to the thin clients and vice versa. The following types of resources appear in this pane:

- **Configuration Packages.** Example: Captured Registry Settings.
- **Images**
- **Software Packages.** Example: HP Tools.

**Note:** All these resources reside in the eXpress share in the ThinClient directory.

When you click any of the submenus corresponding to the subdirectories within the ThinClient directory, the tree expands and displays all the resources included in the directory. If the folder is empty, an appropriate message appears. You can rename or delete the resources.

**Software packages**

The **Software Packages** pane displays the software packages that can be created for the available computers. You can drag and drop this resource to the thin clients and vice versa.

When you right-click the **Software Packages** pane, you can view the following options:

- **New folder.** Select this option to create a new folder.
- **Import.** Select this option to import a job.
  
  See “To import a job” on page 73.
- **Rename**. Select this option to rename a folder.

  **Note:** You cannot rename the Software Packages pane. You can only rename a folder.

- **Delete**. Select this option to delete folders.

- **Find Software Packages**. Select this option to find software packages.

To import a job

1. Open the Thin Client view.
2. Right-click the **Software Packages** pane and select **Import**.
   The **Import Job** dialog appears.
3. In the **Job file to import** field, browse and specify the file that you want to import.

  **Note:** By default, the Import to Job Folder, Overwrite existing Jobs and Folders with the same names, and Delete existing Jobs in folder options are disabled.

   To preserve the source operating system file paths of Scripted Install, select the Preserve Scripted Install OS source paths option.

   Click **OK**.

To delete the Software Packages option from the Ghost Solution Suite Console

1. Open the Ghost Solution Suite Console.
2. In the **Jobs** pane, select **System Jobs > Thin Client Jobs > Software Packages**.
3. Right-click Software Packages and select **Delete**.
   A confirmation dialog opens.
4. Click **Yes** to confirm the deletion.
   The **Software Packages** option is deleted from the Ghost Solution Suite Console view.

  **Note:** The **Software Packages** option is automatically added in the Jobs pane in **System Jobs > Thin Client Jobs** when you switch from the Ghost Solution Suite Console view to the Thin Client view.
Inventory pane

This pane displays a table that lists all the thin clients identified by the console. The following columns appear in the Inventory pane:

- Name
- Computer Status
- Action Status
- Product Name
- Operating System
- Image Version
- Flash Size
- Memory Size
- BIOS Version

You can select which columns to view. The following columns are available, but do not appear:

- Automation Partition
- CPU
- Domain Name
- IP address
- MAC address

To view Inventory columns

1. Right-click the Inventory pane. The Manage Inventory Columns dialog appears.
2. You can add columns to either the Selected columns list or the Available columns list by clicking the required arrows.
3. Click OK.

Toolbars and utilities

The toolbars and menus on the Ghost Solution Suite Console provide major features and utility tools to deploy and manage computers from the console. From the Main toolbar, you can create new jobs and computer accounts and run basic deployment tasks. On the Tools toolbar, you can launch Ghost Solution Suite administration tools and package editing tools. It also includes icons to quickly run commonly used remote operations.
See “Remote operations using Ghost Solution Suite” on page 128.

Ghost Solution Suite utility tools

The Ghost Solution Suite Console lets you open utility programs from the Tools menu or from the Tools toolbar. You can launch Ghost Solution Suite administration tools (Boot Disk Creator, PXE Configuration, and Remote Agent Installer) and package editing tools (Wise MSI Editor, PC Transplant Editor, and Image Explorer) from the toolbar.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Disk Creator</td>
<td>Use this tool to create boot disk configurations, and automation and network boot media to image client computers. The Boot Disk Creator can maintain several different boot disk configurations for different types of network adapter cards. See Symantec Boot Disk Creator help.</td>
</tr>
<tr>
<td>PXE Configuration</td>
<td>After installing the PXE Server, you can create and modify configurations, which make up the boot menu options that appear on client computers. This is another option to boot computers to automation. See the Symantec PXE Configuration help.</td>
</tr>
<tr>
<td>Remote Agent Installer</td>
<td>Remotely install the Deployment Agent on client computers from the console. This utility lets you push the agent installation to client computers from the Ghost Solution Suite Console. DAgent is the default agent for all Windows platforms.</td>
</tr>
<tr>
<td>PC Transplant Editor</td>
<td>Use this tool to edit a Personality Package to add or remove data. See the Symantec PC Transplant Help located in the eXpress Share.</td>
</tr>
<tr>
<td>Ghost Explorer</td>
<td>After a disk image is saved to the eXpress Share, this tool lets you view and manage data in the image file. You can edit and split an image, create an index, and more. See the Symantec Image Explorer help file located in the eXpress Share.</td>
</tr>
<tr>
<td>Wise MSI Editor</td>
<td>Edit .MSI packages generated from the Wise Setup Capture tool or other .MSI files used to distribute software and other files.</td>
</tr>
</tbody>
</table>
Extending the tools menu

You can add commands to the Tools menu on the Ghost Solution Suite Console to quickly access additional management applications. This lets you easily access applications commonly used with Ghost Solution Suite.

Commands are added by modifying or adding new .INI files. You can insert commands to the root ATools.ini file for the main menu or add new .INI files to create submenus. Place both types of .INI files in the directory where the Ghost Solution Suite Console executable (eXpress.exe) is located. The default location is Program Files(x86)\Altiris\ eXpress\Deployment Server.

You can add up to eight menu items to the main menu, and eight menu items for each submenu.

These .INI fields are included for each application added to the "Tools > Symantec Legacy Tools" menu:

[Application name or submenu declaration]
MenuText=<the application name displayed in the menu>
Description=<the name displayed when you mouse over the menu item>
WorkDir=<directory set as default when executable is run>
Executable=<path to the executable files>

The ATools.ini file extends the main Tools menu on the console. This sample file contains one submenu, Web Tools, and two additional menu items, Notepad and Netmeeting. The .INI files are located in the eXpress Share.

[Submenus]
Web Tools=wtools.ini

[Notepad]
MenuText=Notepad Editor
Description=Simple Editor
WorkDir=. 
Executable=C:\WINNT\notepad.exe

[NetMeeting]
MenuText=NetMeeting
Description=NetMeeting
WorkDir=. 
Executable=C:\Program Files\NetMeeting\conf.exe
Another Tools .INI file is wtools.ini. It is a submenu file referenced by the main ATools.ini file. On the main menu, this is titled "Web Tools" (see Tools.ini) and contains two applications, Internet Explorer and Adobe Acrobat.

[Explorer]
MenuText=Explorer
Description=Windows Explorer
WorkDir=
Executable=C:\Program Files\Internet Explorer\explorer.exe

[Acrobat]
MenuText=Acrobat Reader
Description=Acrobat Reader
WorkDir=
Executable=C:\Program Files\Adobe\Acrobat\acrobat.exe

**GhostCast Server**

GhostCasting lets multiple computers running Symantec Ghost Solution Suite receive the same information over a computer network simultaneously. For example, you can send image files to multiple computers.

The GhostCast Server works with Ghost Solution Suite or restore an image file onto a number of client computers.

The GhostCast Server supports the following forms of data transfer for transferring files:

- **Unicasting**
  One Unicast stream of data is sent for each client computer

- **Direct Broadcast**
  The data is sent to all computers on a specified subnet. If more than one subnet is targeted, one stream is sent to each subnet.

- **Multicast**
  The data is sent to all of the computers on the network that have requested the data. Only one stream of data is sent.

The following table lists the fields and description of the **GhostCast Server** dialog.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Name</td>
<td>Enter a name of the session</td>
</tr>
<tr>
<td>Image File</td>
<td>Browse and select the image file that you want to send to the client computers</td>
</tr>
<tr>
<td>Disk</td>
<td>Select the disk of the client computer that you want to restore.</td>
</tr>
<tr>
<td>Partition</td>
<td>Select if the partition of the client computer that you want to restore.</td>
</tr>
<tr>
<td>Restore Image</td>
<td>Select if you want to restore an image.</td>
</tr>
<tr>
<td>Create Image</td>
<td>Select if you want to create image of the client computer.</td>
</tr>
<tr>
<td>More Options&gt;&gt;</td>
<td>Displays the following options:</td>
</tr>
<tr>
<td></td>
<td>Client command line options</td>
</tr>
<tr>
<td></td>
<td>■ Disk No.</td>
</tr>
<tr>
<td></td>
<td>Select the disk number from the drop-down list</td>
</tr>
<tr>
<td></td>
<td>■ Partition No.</td>
</tr>
<tr>
<td></td>
<td>Select the partition number from the drop-down list</td>
</tr>
<tr>
<td></td>
<td>■ Command line</td>
</tr>
<tr>
<td></td>
<td>Enter the command to be executed</td>
</tr>
<tr>
<td>Auto Start</td>
<td>■ Time</td>
</tr>
<tr>
<td></td>
<td>Enter the time after which the session should start automatically</td>
</tr>
<tr>
<td></td>
<td>■ Client count</td>
</tr>
<tr>
<td></td>
<td>Enter the number of clients on which the task should start automatically</td>
</tr>
<tr>
<td></td>
<td>■ Timeout</td>
</tr>
<tr>
<td></td>
<td>Enter the time for which the GhostCast Server waits after a client computer receives the task.</td>
</tr>
<tr>
<td>Accept clients</td>
<td>Select this option so that the GhostCast Server waits till the clients connect.</td>
</tr>
<tr>
<td>Send</td>
<td>Click to start the session.</td>
</tr>
</tbody>
</table>
To set the range of IP addresses and log settings, navigate to **File > Options**.

Following are the field and description of the Options dialog:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Force Mode**                      | Check the check box to enable **Force Mode**. You can select from either of the following:  
  ■ Unicast  
  ■ Multicast  
  ■ Direct Broadcast |
| **Limit data throughput for**       | You can set the maximum limit of the data transferred:  
  ■ Restoring  
    Set the limit for restoring in MB per minute  
  ■ Creating  
    Set the limit for creating image in MB per minute |
| **Action on completion**            | Select the action to be performed after the GhostCast Server session is complete:  
  ■ Restart Operation  
    Relaunches GhostCast Server  
  ■ Close GhostCast Server  
    Exits the GhostCast Server |
| **Use Specified Multicast Address Range** | Enter the range of IP addresses on which the task should be performed. |
| **Multicast scope TTL**             | Set the multicast scope Time-To-Live (TTL) value. It specifies the number of routers (hops) that multicast traffic is permitted to pass through before expiring on the network. |
| **Log Clients**                     | Browse to select the client logs. |
### Computer filters and job conditions

Use this dialog while creating a computer group filter to filter only the specified computers in a computer group, or while setting conditions for task sets when running a job only on the specified computers in a group.

See “Creating a computer group filter” on page 80.

See “Setting conditions for task sets” on page 160.

### Creating conditions to assign jobs

You can set conditions on a scheduled job to run only on the computer devices that match a defined criteria. As a result, you can create a single job with tasks defined for computers with varying properties, including the type of the operating system, network adapters, processors, free disk space, and other computer properties. For each job, you can now create task sets that are applicable only to the computers matching those conditions.

Click a job in the Jobs pane. The Condition feature appears in the **Details** pane. Click **Setup** to add new conditions or edit existing conditions. When you are setting conditions to schedule a job, select from a list of predefined database fields or create custom tokens that key on other fields in the database.

### Creating a computer group filter

The **Computer Filters** dialog displays a list of all computers in a group according to the specified criteria. Example: You can create a filter to view all the computers in a particular group that have Windows 2000, 256 MB of RAM, and 20 GB hard
disks only. By applying the filter, you can view all the computers that meet the specified criteria in the Details pane of the Ghost Solution Suite Console.

Click a computer group in the Computers pane. The Filter feature appears in the Details pane for the selected computer group. Click Setup to add new filters, or to modify and delete existing computer filters.

**To create or modify a computer filter**

1. Click the All Computers group or any other computer group.
2. On the Filter bar in the Details pane, click Setup > New to create a new filter.
   Or
   Click Setup > Modify.
3. Type a name for the filter and click Add. The Filter Definition page appears.
4. Define the conditions you want to filter.
   Click the Field box to see a list of computer values stored in the Ghost Solution Suite Database. Select a computer value and set the appropriate operation from the Operations list. In the Value box, enter an appropriate value for the selected database field. Example: You can choose Computer Name as the Field, Contains as the Operation, and Sales as the Value.
5. Repeat to include other conditions. Click OK.

**General options**

Use the Program Options feature to set the general options for Ghost Solution Suite. Click Tools > Options to view the Program Options dialog.

- Console options
  See “Console options” on page 82.
- Global options
  See “Global options” on page 82.
- Task password options
  See “Task password options” on page 84.
- Domain accounts options
  See “Task password options” on page 84.
- RapiDeploy options
- Agent settings options
- Custom data sources options
Console options

Set basic console features for miscellaneous refresh actions and warning messages.

Scan resource files for changes every _____ seconds. Specify how frequently (in seconds) the Ghost Solution Suite Console updates its view of package files in the Resources view.

See Shortcuts and resources view.

Warn user when no tasks are assigned to the 'default' condition. When a job is assigned to computers and the default condition has no tasks assigned, a message appears. The job has no secondary default tasks assigned if a computer in the group does not meet the primary conditions.

See Setting conditions for task sets.

Refresh displayed data every _____ seconds. Refresh the display of data accessed from the Ghost Solution Suite Database. This lets you refresh console data at defined intervals instead of updating every time the Ghost Solution Suite Console receives a command from the server, which can be excessive traffic in large enterprises.

Global options

Set global options for the Ghost Solution Suite server system.

Delete history entries older than _____ days. Specify the number of days entries are kept in the history before they are deleted. Enter any number between 1 and 10,000. If you don't select this option, log entries remain in the history.

Remove inactive computers after ____ days. Specify the number of days you want to keep inactive computers in the Ghost Solution Suite Database before they are deleted. The default value is 30 days, but any number between 1 and 10,000 is valid.

Synchronize display names with computer names. Automatically update the displayed name of the managed computer names in the console when the client computer name changes. If this option is not selected, changes to the computer names are not reflected in the console. Synchronization is off by default. The names do not have to be synchronized for the Ghost Solution Suite server to manage the computer.

Reschedule failed image deployment jobs to immediately retry. Immediately retry a failed image deployment job. The program continues to retry until the job succeeds or until the job is canceled.

Client/server file transfer port: ______. Specifies a static TCP port for file transfers to the clients. The default value is 0 and causes the server to use a dynamic port.
This setting is useful if you have a firewall and need to use a specific port rather than a dynamically assigned port.

**Automatically replace expired trial licenses with available regular licenses.** Lets Ghost Solution Suite automatically assign a permanent license to the computer after the trial license expires.

---

**Note:** Be careful when using this option. Ensure that you do not give a permanent license to computers you do not want to manage after their trial license expires.

---

**Display Imaging status on console.** Displays the status of the imaging job on the Ghost Solution Suite Console.

**Remote control ports.** Specifies ports for using the Remote Control feature. You have the option to enter a primary port address and a secondary port address (Optional).

**Remove task passwords when exporting or copying jobs.** Specifies that you must remove the task password when exporting or copying jobs.

**Display only computers and jobs the user has rights to manage.** Displays only the computers and jobs that the user has rights to manage. If this option is not selected, all of the computers and jobs are displayed. If this option is selected when security is enabled and the logged-on user has administrator rights, all computers and jobs are displayed. However, if this option is selected when security is enabled and the logged-on user does not have administrator rights, that user's view is restricted to see the jobs and computers that the user only has rights to. A computer is displayed if the logged-on user has any permission on the computer's group or if the computer's group inherits any permissions from a parent folder.

**Do not update configuration data on a failed configuration task.** If checked, does not overwrite the data in the Ghost Solution Suite database if a configuration task fails. The database is not updated until a successful configuration task finishes running.

**Primary lookup key(s).** Specifies the lookup key type(s) used to associate a new computer with a managed computer. The options are Serial Number, Asset Tag, UUID, or MAC Address.

**Sysprep Settings.** This lets you enter global values for Sysprep.

See "Sysprep settings" on page 83.

---

**Sysprep settings**

View and configure the Sysprep settings for the Ghost Solution Suite server.
OS product key dialog

In the OS Product Key dialog, select the suitable operating system from the Operating System drop-down list. After you select the operating system, a list of all product keys for the selected operating system appears. Select an operating system from the Operating System drop-down list, and click Add to type the Product Key. You can type up to 29 characters for the Product Key. The new product key is added to the list of available keys of the selected operating system.

To modify a product key, select the product key to be modified, and click Edit. To remove a product key, select the product key to be deleted, and click Remove.

Note: If the product key is being used by another task, you cannot delete the product key. You are prompted with a message stating that the product key is being used by another task.

Task password options

According to the network and security properties, the passwords for administrators and users change after a certain number of days. In such a scenario, the password becomes invalid and all jobs and tasks using the user name whose password changes must be modified to use the new password. The Task Password option provides administrators with a simple option to manage all password changes from a centralized location.

This feature lets you set or change user passwords from a central location, so you can modify the password for the Copy File to, Distribute Software, Run Script, Distribute Personality, and Capture Personality tasks when creating or modifying jobs. However, this tab is enabled only to administrators and select users who have been granted the appropriate privileges.

The Status field displays the results of password updates. Example: User A's user name and password is used in ten tasks. If you want to update the password for these ten tasks, you can do so through the Task Password option. After the password is updated, the Status field displays the message: Password for 10 tasks updated.

Domain accounts options

This sign-on feature retrieves the name of the administrator (or the user with administration rights) and the password for each domain. This feature lets you avoid needing to log on for each managed computer when you run imaging and configuration jobs.
You can provide the user credentials for the parent domain or a trusted domain in this window. Ghost Solution Suite supports the UPN and SAM formats, and it accepts either the parent domain user's credentials or the domain user's credentials for any configuration jobs.

Click **Add** to enter the Domain name. The **Add Domain Account** page appears. Enter the name of the selected domain and provide the administrator credentials. Click **OK**. The administrator name and domain are listed in the **Domain Accounts** list box.

**Agent settings options**

These default settings are applied only for new client computers that have never connected to the Ghost Solution Suite server, and have no information stored in the Ghost Solution Suite Database. These settings are not for the existing managed computers, nor are these settings applied when setting properties using the Remote Agent Installer.

When the Deployment Agent connects, the Ghost Solution Suite server verifies if the computer is a new or an existing computer. If the client computer is new and if the Force new agents to take these default settings option is selected, the Deployment Agent on the client computer receives the default settings established in the Options > Agent Settings dialog. If the computer is recognized as an existing managed computer, it uses the existing agent settings. The same process occurs for automation agents if the Force new Automation agents to take these default settings option is selected.

**Force new agents to take these default settings.** Select this option to force the default settings when adding a new computer.

**Force new Automation agents to take these default settings.** Select this option to force the default settings when adding a new automation agent connects.

**Custom data sources options**

This option lets you set up credentials to authenticate to external Ghost Solution Suite Databases and other Microsoft SQL Server databases to extract data using custom tokens. Click Add to enter an administrator alias and other login information for the Microsoft SQL Server (or MSDE) hosting the desired Ghost Solution Suite Database.

The information required to create a custom data source entry is listed below:

- **Alias.** The alias name you want to use when referencing the external SQL database.
- **Server.** The name of the external SQL database server or IP address.
- **Database.** The name of the external database from which you want to extract data.

- **Use Integrated Authentication.** This option authenticates to the external database using the domain account you are currently logged on as.

- **User name and Password.** When the integrated authentication is not being used, you must provide a user name and password to authenticate to the external database.

- **Allowed Stored Procedures.** Click this tab to modify the existing list.
  
  See “Allowed stored procedure list” on page 86.

### Allowed stored procedure list

Click Allowed Stored Procedures to identify the stored procedures from the selected custom data source. You can now select from the list of available stored procedures in the data source. This lets you call stored procedures outside of the Ghost Solution Suite Database (eXpress database) using custom tokens within scripts or answer files.

### Virtual centers options

You can keep a list of all VMware Virtual Center Web services. The hosts and virtual computers from each Virtual Center that have corresponding computers in the Ghost Solution Suite Database appear in the computer tree. These virtual computers appear under the Virtual computers node in the Computers pane.

Click Add. On the Virtual Center page, enter the Display name, Server hostname, and Username. By default, the port number is displayed. You can also set up a password for the selected user.

### Security in Ghost Solution Suite

Ghost Solution Suite provides a security system based on associating job and computer objects with user and group permissions, letting IT personnel be assigned to different security groups to manage operations on specific computer groups or job folders. Each security group can perform only a defined scope of deployment operations on each computer group or job folder. Additionally, each user can be assigned rights to access general console features. You can also choose whether to specify that scripts on run only on the Ghost Solution Suite server.

**Note:** Security rights and permissions set in one console are enforced in all Ghost Solution Suite Consoles.
To set general security rights, click Tools > Security and add a user name and password. You can create users and groups and set scope-based rights.

To set feature-based permissions for specific computers or jobs, select the object in the console, right-click and select Permissions.

See "Best practices for Ghost Solution Suite security" on page 87.

See "Enabling security" on page 87.

See "Setting permissions" on page 93.

See "Groups" on page 90.

See "Rights" on page 91.

Best practices for Ghost Solution Suite security

Ghost Solution Suite is based on defining groups of users and groups of computers and jobs, and associating one with another. We recommend that you first create user groups based on administration duties or access to levels of deployment operations. For example, you probably set up a group with full Administrator rights. This group has access to run all operations on all computers using all types of jobs. No permissions need to be set on each computer group or job folders for the Administrator group because this has full rights to all features and resources.

However, you can also set up a Technician group that has only basic access and permissions limiting deployment operations. This prohibits members of the group from re-imaging the Server computer group or scheduling Distribute Disk Image jobs. You can explicitly Allow or Deny the group from running these operations for each computer group in the Computers pane or each job folder in the Jobs pane.

After creating the Technician group, you can limit their rights to set General Options and set permissions on each computer groups and job folder for the group. You can select the computer group, right-click it and select Permissions. Select the group name in the left pane, and click Allow or Deny for a list of deployment operations. Example: You can select the Deny check boxes for Restore, Schedule Create Disk Image, and Schedule Distribute Disk Image.

Additional groups can be created with different rights and permissions depending on the needs and responsibilities in the IT team. If users are assigned to multiple groups, the Evaluate Permissions and Evaluate Rights features are sorted and display effective permissions and rights.

Enabling security

You can enable security by first creating a group with Administrator rights, adding a user to the Administrator group, and selecting Enable Security.
Note: When the Administrator Right is selected, you do not need to select any other rights because the Administrator Right implies that all other rights are selected.

To enable security

1. Click **Tools > Security**.
   The Security dialog appears.

2. Click the **Manage User Groups** tab and click **Add**. The **Add User Group** dialog appears.

3. Select the authentication type. You can add a DS group or a group from the Active Directory. To add groups from Active Directory, refer to the following section:
   See “Adding groups from the Active Directory” on page 90.

4. Click **DS Group**.

   **Note:** The Browse option is disabled for Local Group.

5. Type a name and description in the **Add User Group** dialog. Click **OK**.
   The group name appears in the window.

6. Select the new group name and click **Rights**.

7. Select Administrator in the **Rights** dialog. This assigns complete rights and permissions to the group. Click **OK**, and click **Close**.

8. On the main **Security** dialog, click the **Manage Users** tab, and click **Add**.
   The **Add User Account** dialog appears.

9. Select the authentication type. You can add a GSS user or a user from the Active Directory. To add users from the Active Directory, refer to the following sections:
   See “Adding groups from the Active Directory” on page 90.

10. Select the GSS User option in the **Add User Account** dialog.

    **Note:** The Browse option is disabled for GSS User.

11. Type the user name, full name, and password. Retype the password, and enter a description for the user. Click **OK**.

12. Select the user name in the main **Security** dialog. Click **Rights**.
13 Click the name of the new Administrator group in the **Groups** window. This assigns the new user to the new group with Administrator rights. Click **OK**.

**Note:** You can assign the user Administrator rights directly, but we recommend you to assign users to groups.

See “**Best practices for Ghost Solution Suite security**” on page 87.

14 Now that you have a user with administrator rights, select the **Enable Security** box.

Security is now enabled. You can now create users and groups and assign permissions to computer groups and job folders.

You can add users from the Active Directory.

**Adding users from the Active Directory**

1 In the main **Security** dialog, click the **Manage Users** tab, and click **Add**.

2 Select the **AD User option** in the **Add User Account** dialog.

3 If you know the user name, type it in the User name field, or click Browse to select the user from the Active Directory.

   The password field is deactivated because the user is being added from the Active Directory.

   **Note:** You can add only one user at a time. To import users, see Importing users from the Active Directory.

4 Enter a description for the user in the Description box.

5 Click **OK**.

**Importing users from the Active Directory**

You can also import users from the Active Directory. To open a standard **Windows Active Directory** dialog, from the main **Security** dialog, click the Manage Users tab, and click **AD Import**. Add users from Active Directory, not groups. The users are added to the Ghost Solution Suite Database. However, you still need to assign the users to security groups with appropriate rights and permissions.

**Note:** When logging on with the imported AD account, Ghost Solution Suite accessed the Windows Active Directory server to validate the user password.
Assign the user to previously created groups. If you are enabling security, you can assign the user to a group with Administration rights.

To add groups, from the Security dialog, click the Manage User Groups tab, and click Add. Select the authentication type, and type the required details. You can view the members of any group by clicking the group in the Manage User Groups dialog and clicking View Members.

See “Best practices for Ghost Solution Suite security” on page 87.
See “Enabling security” on page 87.

Adding groups from the Active Directory

You can add users from the Active Directory.

To add groups from the Active Directory

1. In the main Security dialog, click Manage User Groups tab, and click Add.
2. Select AD Group in the Add User Group dialog.
3. If you know the group name, enter it in the Name field, or click Browse to select the group from the Active Directory. A list of groups, along with their descriptions, appears in a new dialog. Select a group from the list and click OK.
4. The Name, Domain, and Description are displayed. However, you can modify the description. Click OK.

The newly added group appears in the main Security dialog.

Importing groups from the Active Directory

You can also import users from the Active Directory. In the main Security dialog, click the Manage User Groups tab, and click AD Import to open a standard Windows Active Directory dialog. Add groups from Active Directory. You can choose a domain from the Domain List, and select a group from the displayed list. The group is added to the Ghost Solution Suite Database. However, you still need to assign the users to security groups with appropriate rights and permissions.

DS authentication

If the user is already in the Ghost Solution Suite Database and tries to access the Ghost Solution Suite Console, the Ghost Solution Suite server checks the authentication with the logged on user, and upon matching does not prompt for user credentials. Similarly, if a group is already added in the Ghost Solution Suite
Database and if a logged-on user, who is a part of the AD group, tries to access the Ghost Solution Suite Console, the Ghost Solution Suite server does not prompt for credentials.

Rights

This dialog lets you set general rights for a user or group.

To verify, add, or change the rights assigned to each console user

1. On the Security page, select a user and click Rights.
2. Click the Rights tab.
3. Select the check box for each right you want to grant.
4. After selecting all applicable rights, click OK to save your changes.

A brief explanation of each Ghost Solution Suite server right that can be assigned is given below:

- **Administrator.** Lets the user access all features available on the Ghost Solution Suite Console. You must have Administrator rights to enable security. See Enabling security.

- **Options Console.** Lets you set the view and the Console options. See Console options.

- **Options Global.** Lets you set the view and the Global options. See Global options.

- **Options Domain Accounts.** Lets you set the view and the Domains Accounts options. See Domain accounts options. See “Domain accounts options” on page 84.

- **Options RapiDeploy.** Lets you set the view and the RapiDeploy options. See RapiDeploy options.

- **Options Agent Settings.** Lets you set the view and the Agent Settings options. See Agent settings options.

- **Options Custom Data Sources.** Lets you create Custom Data Sources options. You can view, create, and set database aliases. See “Custom data sources options” on page 85.

- **Manage Rejected Computers.** Lets you view rejected computers in Ghost Solution Suite and change their status. See Rejected computers in Ghost Solution Suite.
- **Refresh Clients.** Lets you refresh Ghost Solution Suite clients. See Refresh Ghost Solution Suite. You can use the View > Refresh clients <CTRL+F5> feature to disconnect and reconnect client computers.

- **Allow Scheduling on All Computers Group.** Lets you schedule jobs on All Computers. If you have administrator rights, by default, you have the rights to schedule job on all computers, irrespective of the check box state. You can grant this right to a specific user or a group.

- **Import/Export.** Lets you import and export jobs and import computers as well. See Importing and exporting jobs and Importing new computers from a text file.

- **Options Task Password.** Lets you centrally update passwords for users and groups so they can access the Copy File to, Distribute Software, Run Script, Distribute Personality, and Capture Personality tasks. You must have administrative rights to access this option. See Task password options.

- **Use PXE Configuration Utility.** Lets you use the PXE Configuration Utility.

- **Options Virtual Centers.** Lets you view and add options for Virtual Centers. See Virtual centers options.

- **Run Script on DS.** Lets you choose to run scripts either on the server or on the client.

- **Access to Master Return Code.** If unchecked, restricts access to the master return code list. If checked, lets you modify the master return code list.

- **Allow DeployAnywhere.** Lets you run DeployAnywhere to create hardware independent images. This functionality is provided by Symantec Ghost Imaging Foundation (GIF). To add and manage drivers, on the Tools menu, click the new DeployAnywhere option. To enable this functionality, select the DeployAnywhere option from the deploy image task.

### Restricting the number of computers

This dialog lets you restrict the maximum number of computers that can be selected.

1. **Restricting the number of computers**
2. On the **Security** page, select a user and click **Rights**.
3. Click the **Restrictions** tab.
4. Type the maximum number of computers that each job can be scheduled on.
5. Check the box if you want this user to be able to schedule jobs to run immediately.
6. Click **OK** to save your changes.
Setting permissions

Set permissions for jobs, job folders, computers, and computer groups.

See “Best practices for Ghost Solution Suite security” on page 87 for additional design tips.

Setting permissions

1 Right-click on a computer group or job folder (or individual computers and jobs) and select Permissions. The Object Security dialog appears.

2 Click the Groups tab and select a group name. Or click the User tab and select a user name.

3 From the list in the right pane, select if you want to Accept or Deny permission to run the operations on the selected computer or job objects. These permissions include access to remote operations using Ghost Solution Suite and features for scheduling Deployment tasks.

See “Remote operations using Ghost Solution Suite” on page 128.

See “Deployment tasks” on page 161.

4 Select the Allow or Deny check box to explicitly set security permissions for these Ghost Solution Suite features for the selected objects.

**Note:** Administrators have access to all objects with unrestricted rights and permissions. You cannot explicitly deny permissions to computer or job objects for users with administrator rights.

5 To assign permissions to multiple groups, click Set permissions on all child objects to assign the values without closing the dialog.

**Note:** You can set permissions for all jobs and computers by clicking in the Jobs pane or Computers pane without selecting a job or computer object.

Connecting to another Ghost Solution Suite server

From the Ghost Solution Suite Console, you can connect to other Ghost Solution Suite servers on your LAN and manage computers outside of the network segment you are currently logged on to. To open a connection, you must connect to the Ghost Solution Suite Database of the preferred Ghost Solution Suite server connection using the ODBC Data Source Administrator.
Click **File > Connect** to or press **CTRL+O** to open the Connect to **Ghost Solution Suite Server** dialog. Enter the required information to connect to the external Ghost Solution Suite server connections using an ODBC driver.

---

**Note:** Although you are accessing another connection (another Ghost Solution Suite Database), Windows remembers the last place you browsed to, which would be the eXpress Share of the previous Ghost Solution Suite server connection. You need to browse to the new connection’s eXpress Share to access its shared folder that contains its images, executables, and other resources.

---

**Connecting to a new Ghost Solution Suite Database**

1. Click **New**. The **Define Connection Information** dialog appears.
2. Enter a name for the connection to be opened.
3. Establish an ODBC data source.
   - Click **ODBC Administrator**.
   - Click the **System DSN** tab, and click **Add**.
   - Select the SQL Server driver source and click **Finish**.
   - In the Create a **New Data Source to SQL Server** dialog, enter a name and description for the data source.
   - If an entry for your server already exists, select it from the menu. Otherwise, enter the name of the server hosting your remote SQL server in this field. Click **Next**.
   - Click **Next** in the Create a **New Data Source to SQL Server** dialog to accept the default settings for authentication.
   - Select the Change the default database to option and select eXpress from the drop-down list. Click **Next**.
   - Click **Finish**. The specifications for the new ODBC data source appear.
   - Click **Test Data** Source to verify that the source is reachable.
   - Click **OK**. You return to the main ODBC Data Source Administrator dialog with your new data source listed in the System DSN tab. Click **OK**.
4. From the ODBC Data source name drop-down list in the Define Connection Information dialog, select the new Data Source name you just created.
5 In the **Installation Directory path** field, enter or browse the full UNC path (or path using any locally mapped drive) to the directory of the required Ghost Solution Suite server, such as:

\server\express or H:

6 Click **OK**.

**Rejected computers in Ghost Solution Suite**

When an unwanted managed client computer attaches to your Ghost Solution Suite system, you can right-click the computer in the Computers pane and select **Advanced > Reject Connection**. You can view these rejected computers by clicking **View > Rejected Computers**.

The rejected computers are prohibited from being active in the Ghost Solution Suite Database. They are identified and rejected by their MAC address.

You can remove computers from the Rejected Computers list by selecting it and clicking **Accept Computer(s)**. This lets the computer to attach again and be managed by the Ghost Solution Suite system.

**Refresh Ghost Solution Suite**

You can refresh the Ghost Solution Suite Console by clicking **View > Refresh Console** (or pressing <F5>) to update data from the Ghost Solution Suite Database. You can also click **View > Reset Client Connections** (or press Ctrl+<F5>) to disconnect and reconnect all managed computers in a Ghost Solution Suite server system.

When you refresh the managed client computers, you are asked if you want to disconnect all computers. Click **Yes**. This tells the Ghost Solution Suite Agent to shut down and restart. It also creates additional network traffic when all computers connect and disconnect. By refreshing the managed client computers, you ensure that you are viewing the current status and state of all computers resources in your system.
Managing Computers

This chapter includes the following topics:

- Managing computers
- Viewing computer details
- Adding new computers
- Computer configuration properties
- Ghost Solution Suite Agents
- Computer properties
- Remote operations using Ghost Solution Suite
- Deploying and managing servers
- New Dynamic Machine Groups

Managing computers

From the **Computers** pane of a Ghost Solution Suite console, you can identify, deploy, and manage all computer resources across your organization, including desktop computers, notebook computers, servers, and network switches. You can quickly modify any computer’s configuration settings or view its complete management history. Or you can take on big projects, such as completely re-image the hard drive, restore software, and migrate personality settings for a whole department. You now have management of all your computer resources available from a Windows console from any location.

All computer resources can be accessed and managed as single computers or organized into computer groups with similar hardware configurations or deployment requirements, letting you run deployment jobs or execute operations on multiple
computers simultaneously. You can use search features to locate a specific computer in the Ghost Solution Suite Database, or set filters to sort computers by type, configuration, operating system, or other criteria.

**Manage with computer icons.** Major computer types are identified by a computer icon in the console, with a list of scheduled jobs and operations associated with each computer. In the Ghost Solution Suite Console, you can assign and schedule deployment jobs to computers or groups by dragging the computer icon to a job in the Jobs pane, or vice versa.

See “Viewing computer details” on page 98.

Computer icons appear in the **Computers** pane of the Ghost Solution Suite Console, where they can be organized into groups. To assign and schedule a job on a computer in the Ghost Solution Suite Server Console, drag a computer icon or group icon to a job icon.

**Add new computers.** Ghost Solution Suite lets you add new computer accounts and set configuration properties for new computers before they are recognized by the Ghost Solution Suite Server system. Preset computer accounts automatically associate with new computers when they startup, or can be associated with preconfigured computers.

See “Adding new computers” on page 100.

Click **New Computer** on the console to create a new computer account. You can also click **File > New > Computer** or right-click in the **Computers** pane and select **New Computer**.

When the new computer starts up, you can assign it a preset account.

Click **New Group** on the console to add a new group in the **Computers** pane of the Ghost Solution Suite Console. You can also click **File > New > Computer Group** or right-click in the **Computers** pane and select **New Group**.

**Deploy to groups of computers.** Organize computers by department, network container, hardware configuration, software requirements, or any other structure to meet your needs. You can deploy and provision computers on a mass scale.

To filter computers in a computer group and to schedule jobs only to the appropriate computer types.

See “Computer filters and job conditions” on page 80.
Configure Computer Agents

See “Ghost Solution Suite Agents” on page 115.

View and configure computer properties. You can modify computer settings for each computer from the console. Or you can view the Computer Properties page for detailed access to a computer's hardware, software, and network property settings.

See “Computer configuration properties” on page 104.

See “Computer properties ” on page 125.

Run remote operations from the console. Perform operations quickly in real time from a Ghost Solution Suite Console. Restore a computer to a previous state, configure property settings, send a file, set security, run deployment jobs, or select from additional management commands.

See “Remote operations using Ghost Solution Suite” on page 128.

Build and schedule jobs. Build deployment jobs with one or more management tasks to run on selected computers. Create jobs, add tasks, and assign the job to computer groups. Jobs can be organized and assigned for daily tasks or to handle major IT upgrades.

See “Building and scheduling jobs” on page 151.

Manage Servers. Ghost Solution Suite also manages servers to administrate high-density server farms or server network resources across your organization.

Viewing computer details

In Ghost Solution Suite, a computer resource is identified in the console with a distinctive icon to display the computer type - Windows desktop or notebook, server, or Linux operating system - and its current status. These computer icons change to convey the state of the computer, such as the log on status, server waiting status, or user with a timed license status. You can also view the status of the jobs assigned to the selected computer in the Details pane of a Ghost Solution Suite Console.

See “Viewing job details” on page 152.

The following is a sample list of computer icons displayed in each Ghost Solution Suite Console, identifying the computer type and state.

A computer connected to the Ghost Solution Suite Server with a user logged on.
A computer connected to the Ghost Solution Suite Server, but the user is not logged on.

A computer with a time-limited user license and a user logged on.

A computer not currently connected to the Ghost Solution Suite Server, but known to the Ghost Solution Suite Database.

A preconfigured computer with values defined in advance using the New Computer feature. As soon as the computer connects, the Ghost Solution Suite Server recognizes the new computer and this icon appears. See “Adding new computers” on page 100.

A managed computer waiting for user interaction before running deployment tasks. This icon appears if the Workstations checkbox is selected in Initial Deployment. See “Sample jobs” on page 207.

A managed server connected to the Ghost Solution Suite Server with a user logged on. Additional icons identify different states of server deployment.

A managed Linux computer connected to the Ghost Solution Suite Server with a user logged on. Additional icons identify different states of Linux computer deployment.

Physical view of Rack/Enclosure/Bay components for high-density server systems. These icons appear as physical representations to allow management of different levels of the server structure. In addition, server icons identify logical server partitions. See “Bay” on page 126 for properties and rules to deploy Rack/Enclosure/Bay servers.

Select the New Computers or All Computers group to run jobs or operations for these default groups identified by an icon in the Computers pane.
Additional computer groups can be added to the **Computers** pane to organize similar computer types or to list computers of similar departments or locations. Click the New Group icon on the toolbar or select **File > New > Computer Group** to create a new group.

## Adding new computers

Computers can be added to the Ghost Solution Suite Database using the following methods:

- **Install the Ghost Solution Suite Agent.** If you install the Ghost Solution Suite Agent to a computer with the operating system already installed, the computer is added automatically to the Ghost Solution Suite Database at startup. New computers with the Ghost Solution Suite Agent installed are added to the **All Computers** groups (unless otherwise specified in the Ghost Solution Suite Agent configuration). You can move the computer to another group if required.

- **Use Initial Deployment to configure and deploy new computers booting to automation.** Starting up a new computer with the Automation Agent lets you image the hard drive, assign IP and network settings, distribute personal settings and software, and install the Ghost Solution Suite Agent for new computers. Using Initial Deployment, you can associate new computers with preconfigured computer accounts. These newly configured computers appear in the **New Computers** group.
  
  See “Sample jobs” on page 207.

- **Create or import computer accounts from the Ghost Solution Suite Console.** You can add new computers using the New Computer feature or import computers using a delimited text file. You can preconfigure computer accounts by adding names and network settings from the console.
  
  See “Creating a new computer account” on page 101.

## About new computers

When a new computer starts up, if Ghost Solution Suite Server recognizes the MAC address provided in a New Computer account or import file, it automatically associates the user account at startup with the New Computer icon. If this value is not provided, the computer appears as a preconfigured computer account, letting you associate it with a new computer.

The New Computer icon appears for a new computer if the MAC Address is provided when creating a new computer account using any import or new computer account feature.
A preconfigured computer account icon appears if specific hardware data (MAC Address) is not known. As soon as the computer starts up and is associated with a preconfigured computer account, Ghost Solution Suite Server recognizes the new computer and this icon appears.

Preconfigured computer account

A preconfigured computer account can be associated with a new computer using the Initial Deployment feature. You can create multiple preconfigured computer accounts and associate the account with a new computer when it boots to automation. At startup, the configuration settings and jobs assigned to the preconfigured computer account can be associated with the new computer.

Ghost Solution Suite provides features to create a preconfigured computer account to pre-define a computer’s configuration settings and assign customized jobs to that computer even if you do not know that computer’s MAC address. This type of computer is known as a preconfigured computer account.

Preconfigured computer accounts offer a lot of power and flexibility, especially when you need to deploy several computers to individual users with specific needs. Preconfiguring a computer account saves your time because you can configure the computer before it arrives on site. You can set up as much configuration information (such as computer name, workgroup name, and IP address) as you have about the computer and apply it to the new computer when it comes online. You can also prepare jobs prior to the arrival of the new computer to deploy the computer using customized images, .MSIs based on a user’s specific needs.

Example: A user might request Windows 2000 with Office 2000 and virus scanning software installed on the new computer. The user also might request that the computer personality (customized user settings, address books, bookmarks, familiar desktop settings) be migrated from the old system. You can build any job, including any of the available tasks, and assign it to a preconfigured computer account.

When the new computer finally arrives, you are ready to deploy it because you have done all the work in advance. Boot the client computer to automation, and the new computer can connect to the server and become a managed computer. Now you can perform an Initial Deployment or run a deployment imaging job on the new computer.

Creating a new computer account

You can create computer accounts for individual computers or for computer groups. When creating new accounts for computer groups, you can automatically assign new names and associate them with existing computer groups or the New Computer group.
Click the **New Computer** icon on the console to create a new computer account. You can also click **File > New > Computer** or right-click in the **Computers** pane and select **New Computer**.

To create a new computer account

1. In the **New Computers** dialog, click **Add**. The **New Computer Properties** page appears.
2. Enter names and configuration settings for each new computer account using the Computer Configuration screens.

   For a description of the configuration settings, See “Computer configuration properties” on page 104.

   **Note:** If you do not enter a MAC address, the computer you create or import becomes a virtual computer.

3. (Optional) Click **Import** to add new computers from a delimited text file.

   See “Importing new computers from a text file” on page 103.

4. Click **OK**.

   A preconfigured computer account icon appears in the **Computers** pane.

When a new computer starts up, you can assign it to this preset account.

You can create computer accounts and automatically assign predefined names. These computer accounts can be associated with computers in a selected computer group.

To create and associate multiple computer accounts

1. Select a computer group, including the **New Computers** group (This feature is not available if the group is empty). Right-click and select the **Configure** command. The **Computer Configuration Properties** dialog appears.
2. Enter names and configuration settings for each new computer account using the Computer Configuration screens.

   See “Computer configuration properties” on page 104.

3. (Optional) Click the **Microsoft Networking** category and click **Define Range**.
   - In the **Fixed text** field, enter a base computer name. Example: Sales.
   - In the **Range start** field, enter a numeral or letter to add to the Fixed Text name. This creates a unique name for a group of computers starting with
the specified character. The range of numerals and letters is assigned to the computer name. Example: Enter 3.

- Select **Append** to add the range of numerals after the computer name. Clear the check box to add names before the computer name.
  
  In the above example, the **Result** field displays computer names beginning with Sales3 and ending with Sales12.

4 Click **Associate**. You can now associate computers in a group (including the New Computers group) with the multiple computer accounts.

5 Click **OK**.

### Importing new computers from a text file

You can import computer configuration data using delimited text files (.TXT, .CSV, or .IMP files) to establish multiple computer accounts in the Ghost Solution Suite Server database. This file contains all configuration data for a new computer, including all settings in the Computer Properties of a selected computer.

See “**Computer properties**” on page 125.

1 Click **File > Import/Export > Import Computers**.

   A dialog appears, letting you select import files. These files can have .XML, .TXT, .CSV, or .IMP extensions.

2 Select the import file. Click **Open**. If a correctly formatted computer import file is selected, a message appears, informing you that the computer import is complete and identifying the number of computers added. Click **OK**.

   New computers appear as preconfigured computer accounts in the **Computers** pane of the console (as single computers or in groups), and any jobs imported from the import file are listed in the **Jobs** pane.

   **Note:** Jobs can be added to the import file. They can be created and associated with the new computers.

   If the computer import file is incorrectly formatted, a warning appears, stating that the computer import file is incorrect.

3 Edit computer settings by selecting a computer from the list and clicking **Properties**.
4 The Computer Properties page opens. You can edit or add values not set in the import file, such as computer name, TCP/IP settings, user name, and other configuration settings.

5 Click OK.

The imported computers appear in the Computers pane of the Ghost Solution Suite Console.

You can also import a computer to be placed in a sub-folder in the Computers pane and create a job to be associated with the imported computer. See the sample import file for additional information.

Referencing the sample import file

When creating an import file, use either the ImportComputers55.txt file or the ImportComputers55.xls file in the Samples folder of the eXpress Share. The ImportComputers55.txt file provides a sample import template you can access to test the Import feature. The ImportComputers55.xls file is a Microsoft Excel spreadsheet that lets you add values to each identified column and save the file as a delimited TXT file to import to the Ghost Solution Suite Database. The sample import file places a computer (DB Computer 1) in a computer group (Test Group) and adds a job (Test Job) associated with the imported computer.

Deploying new computers on a mass scale

If you need to deploy large numbers of computers (100 to 5,000), consider using a barcode scanning system to collect user information (names, operating system, and application needs) and computer information (MAC address, serial numbers, asset tags). You can save this information to a file, which can be imported into the New Computers List View. Depending on the number of incoming computers, the amount of information you have about those computers, and the needs of individual users, you can use either the preconfigured computer account method (best for smaller numbers of new computers) or the Initial Deployment job (best when deploying generic setups by departments or groups).

If you are using an import file, ensure you know the primary lookup key. This information is required by Ghost Solution Suite Server to set up a unique computer. The primary lookup key can be the Serial Number, Asset Tag, UUID, or MAC address.

Computer configuration properties

These computer property settings can be viewed, set, and modified when performing the following computer management operations:

- See “Adding new computers” on page 100.
See “Modifying configuration” on page 190. Create or edit property settings in a deployment job.

See “Sample jobs” on page 207.

Click the configuration group icons to set additional computer property values. After you edit these computer property settings, the computer restarts so that the changes can take effect.

General configuration settings

Set the most important value from this property sheet. It includes the name of the computer in Ghost Solution Suite, the NetBIOS name of the computer, the MAC address and other settings.

Microsoft networking configuration settings

Set the Windows name of the computer and the Workgroup or Domain settings.

TCP/IP configuration settings

Set the TCP/IP addresses for one or more network adapters.

NetWare client configuration settings

Set Novell Directory Services client logon options.

Operating system licensing configuration settings

Set the registered user name and view the hashed installation license key for the installed operating system.

User account configuration settings

Set the local Windows user account values.

General configuration settings

The General category provides access to important property settings that are also listed in other configuration categories. Click other category icons to view and set additional configuration properties.

### Table 4-1 General configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name              | Provides a name that appears in the Ghost Solution Suite Console (not the BIOS name of the computer).  
Note: The Name field is disabled for multiple computer configuration. |
| MAC address       | Network card’s MAC Address                                                  |
| Serial Number     | The serial number of the computer’s motherboard.                           |
Table 4-1  General configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Tag</td>
<td>The asset tag of the computer, if available.</td>
</tr>
<tr>
<td>UUID</td>
<td>The UUID of the computer.</td>
</tr>
<tr>
<td>Computer Name</td>
<td>The Windows name of the computer.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Current IP address of the computer. Multiple IP addresses are listed in this box.</td>
</tr>
<tr>
<td>Registered User</td>
<td>The name of the user who registered the operating system software.</td>
</tr>
<tr>
<td>License key</td>
<td>The hash value rendered from the OEM key or 25-digit license key required when installing the operating system.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name for the local Windows user account.</td>
</tr>
<tr>
<td>Full name</td>
<td>The full name for the local Windows user account.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the local Windows user account.</td>
</tr>
<tr>
<td></td>
<td>See “Computer configuration properties” on page 104.</td>
</tr>
</tbody>
</table>

Microsoft networking configuration settings

Enter the computer name and workgroup or domain property settings for the managed computer. If you are using Active Directory, you can add computers to a domain and a specified organizational unit (OU).

Use Sysprep to generate unique SIDs. This can be done by manually running the utility or selecting this feature while installing the Ghost Solution Suite Agent.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Computer name | This is the NetBIOS name for the computer. The name must be unique in the network and limited to 15 characters.  
**Note**: This field is disabled for multiple computer configuration. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Range</td>
<td>Click to create a sequential range of computer names. The Computer Name Range dialog appears. For new computers, set a range of names for multiple new computers.</td>
</tr>
<tr>
<td>■ Fixed text</td>
<td>Enter the text portion of the name that you want to associate with each computer. Example: MARKETING.</td>
</tr>
<tr>
<td>■ Range start</td>
<td>Enter a whole number to add to the fixed text. Example: 1.</td>
</tr>
<tr>
<td>■ Append</td>
<td>Select this check box to add the range after the fixed text in the computer name. If you clear this box, the number is added as a prefix to the fixed text.</td>
</tr>
<tr>
<td>■ Result</td>
<td>View an example of the selected names that is assigned to each computer. Example: MARKETING1...MARKETING6.</td>
</tr>
</tbody>
</table>

**Note:** When setting name ranges, do not set names using multiple Modify Configuration tasks and assigning the names by setting conditions for task sets. If you set up two separate name ranges to be assigned by separate conditions, the computer names increment irrespective to the base name.

See “Modifying configuration” on page 190.
See “Setting conditions for task sets” on page 160.
See “Computer configuration properties” on page 104.
Table 4-2  Microsoft networking configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup</td>
<td>Select this option and enter the name of the workgroup to place the managed computer.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can select either the <strong>Workgroup</strong> or the <strong>Domain</strong> option.</td>
</tr>
<tr>
<td>Domain</td>
<td>Enter either the fully qualified domain name, the DNS domain name, or the WINS domain name. You can enter the fully qualified domain name (Example: mjones.yourcompany.com), and specify the organizational unit (OU) using this format: OU/newOU/users. The complete entry to place the computer in the users OU is the following: mjones.yourcompany.com/OU/newOU/users internal.myServer.org/New Corporate Computer OU/Mail Room/Express Mail Servers</td>
</tr>
</tbody>
</table>

TCP/IP configuration settings

Enter TCP/IP settings for one or more network adapters. Click **Advanced** to setup IP Interfaces, Gateways, DNS, WINS, and Static Routes. For computer groups, click **Associate** to assign a range of pre-defined IP addresses.

Table 4-3  TCP/IP configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>The DNS name of a device on a network. The name is used to locate a computer on the network.</td>
</tr>
</tbody>
</table>
### Table 4-3  TCP/IP configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network adapter</td>
<td>A list of all network adapters installed in the selected computer. The network adapter with the lowest bus, device, and function number is the first listed (NIC0 - zero based). If the bus, device, and function information cannot be determined for a network adapter, it is enumerated in the order it is detected.  <strong>Add.</strong> Enter new settings for additional network adapters installed on the client computer. You can add &quot;virtual&quot; network adapter settings to send a job to a computer group containing computers with varying numbers of network adapters. If a computer in the group has only one network adapter, it is configured only with the IP settings listed first. If IP settings are provided for additional network adapters not present in the computer, they are disregarded. If you add a new network adapter, the <strong>Remove</strong> button appears. You can remove the new network adapter by clicking <strong>Remove.</strong></td>
</tr>
</tbody>
</table>

**Table 4-3**

TCP/IP configuration settings *(continued)*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Description         | - **MAC Address**  
The MAC address is a unique number assigned to the network adapter by the manufacturer. You cannot change this number. The MAC address appears in this box when you view computer configuration settings. This box is disabled when creating a Modify Configuration task.  
- **DNS connection suffix.**  
Enter this to add domain suffixes to the root address.  
- **Obtain an IP Address automatically.**  
- **Use the following IP address.**  
- **Obtain DNS server address automatically**  
- **Obtain the following DNS server addresses.**  
- **Reboot After Configuration.**  
  Restart the computer after configuration. |
| Adapter state       | The state of the Network Interface Card (NIC). Users have the option of enabling, disabling, or keeping the card in its current state.            |

**TCP/IP advanced options - IP interfaces**

IP Interfaces (Linux and Windows type only). Click **Add** to set named interfaces for this network adapter. You can add TCP/IP addresses to an existing network adapter card on Linux or Windows operating systems.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Add or modify an IP address common to all interfaces.</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>Enter the appropriate subnet mask.</td>
</tr>
<tr>
<td>Interface Name</td>
<td>Establish Linux-specific IP interface settings. Ensure you use the &quot;eth&quot; syntax when naming new interfaces. Example: eth0:1 or eth0:new interface.</td>
</tr>
</tbody>
</table>
Table 4-4  TCP/IP advanced options - IP interfaces (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast Address</td>
<td>Enter the Broadcast address for the specified IP interface.</td>
</tr>
<tr>
<td>Interface State</td>
<td>The default value of the interface state is Up, which denotes that the named</td>
</tr>
<tr>
<td></td>
<td>interface is operating. You can shut down the named interface by selecting</td>
</tr>
<tr>
<td></td>
<td>Down.</td>
</tr>
</tbody>
</table>

See “Computer configuration properties” on page 104.

TCP/IP advanced options - gateway

View Gateway addresses. Click Modify to edit an existing IP address. Use the up and down arrows to move an address to the top of the list, which acts as the primary address. Review all selection by clicking the TCP/IP option on the Configuration page.

Table 4-5  TCP/IP advanced options - gateway

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>Add additional gateways for this network adapter.</td>
</tr>
</tbody>
</table>

TCP/IP advanced options - DNS

Click Add to set a new DNS address.

**DNS server addresses, in order of use:** Add additional Domain Naming Servers (DNS) for this network adapter.

**Append these DNS Suffixes (in order):** Add the name of the Domain Suffix and use the up and down arrows to set the DNS suffix search order.

TCP/IP advanced options - WINS

Click Add to set a new WINS address.

Add additional WINS settings for this network adapter. Select one of the Enable NetBIOS over TCP/IP, Disable NetBIOS over TCP/IP, or Use NetBIOS settings from DHCP server options for this network adapter.

See “Computer configuration properties” on page 104.
TCP/IP advanced options - static routes

Table 4-6  TCP/IP advanced options - static routes

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td>IP address of the destination Ghost Solution Suite Server.</td>
</tr>
<tr>
<td>Netmask</td>
<td>Subnet mask.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Additional gateways required to reach the destination server.</td>
</tr>
<tr>
<td>Interface</td>
<td>IP address for the interface over which the destination can be reached.</td>
</tr>
<tr>
<td>Metric</td>
<td>Cost associated with the route</td>
</tr>
<tr>
<td>Flags (Linux)</td>
<td>Enter the flag associated with a Linux-specific operating system. Possible flags include:</td>
</tr>
<tr>
<td></td>
<td>■ U (route is up)</td>
</tr>
<tr>
<td></td>
<td>■ H (target is a host)</td>
</tr>
<tr>
<td></td>
<td>■ G (use gateway)</td>
</tr>
<tr>
<td></td>
<td>■ R (reinstate route for dynamic routing)</td>
</tr>
<tr>
<td></td>
<td>■ D (dynamically installed by daemon or redirect)</td>
</tr>
<tr>
<td></td>
<td>■ M (modified from routing daemon or redirect)</td>
</tr>
<tr>
<td></td>
<td>■ A (installed by addrconf)</td>
</tr>
<tr>
<td></td>
<td>■ C (cache entry)</td>
</tr>
<tr>
<td></td>
<td>■ ! (reject route)</td>
</tr>
</tbody>
</table>

NetWare client configuration settings

Set Novell NetWare client values for a new or existing computer. Select whether you want to log in directly to a NetWare server or to a NetWare tree in the Novell Directory Service (NDS). You can specify the preferred tree, server name, and NDS context.
Table 4-7  NetWare client configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore NetWare settings</td>
<td>Select to disregard all Novell NetWare client settings for this computer. Clear to specify the required information.</td>
</tr>
<tr>
<td>Preferred server</td>
<td>Select this option and enter the name of the NetWare server. Example: \OneServer. This is the primary login server for the NetWare client.</td>
</tr>
<tr>
<td>Preferred tree</td>
<td>Select this option and enter the name of the NDS tree.</td>
</tr>
<tr>
<td>NDS User name</td>
<td>Enter the name of the user object for the NetWare client.</td>
</tr>
<tr>
<td>NDS Context</td>
<td>Enter the organizational unit context for the user.</td>
</tr>
<tr>
<td>Run login scripts</td>
<td>Select this option to run the NetWare client login scripts.</td>
</tr>
<tr>
<td></td>
<td>See “Computer configuration properties” on page 104.</td>
</tr>
</tbody>
</table>

Operating system licensing configuration settings

Enter or view the license information for your Windows operating system software (Windows 2008, 2012, Vista, Windows 7 and Windows 8).

Table 4-8  Operating system licensing configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registered user</td>
<td>Enter the name of the registered user.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter the name of the organization.</td>
</tr>
<tr>
<td>License key</td>
<td>Enter the alpha-numeric license key. This is the hash value rendered from the OEM key or 25-digit license key required when installing the operating system.</td>
</tr>
<tr>
<td></td>
<td>See “Computer configuration properties” on page 104.</td>
</tr>
</tbody>
</table>
User account configuration settings

Set up local user accounts for the newly imaged computer or when running a configuration task. Enter a user name, full name, and password; and set standard Windows login options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>The user name for this local Windows user account.</td>
</tr>
<tr>
<td>Full name</td>
<td>The full name for this local Windows user account.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for this local Windows user account.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Confirm the password for the local Windows user account.</td>
</tr>
<tr>
<td>Groups</td>
<td>Specify the Windows groups that this user belongs to as a comma-delimited list. Example: Administrators, Marketing, Management.</td>
</tr>
<tr>
<td>User must change password at next logon</td>
<td>Select to force the user to change the password after setting the configuration properties.</td>
</tr>
<tr>
<td>User cannot change password</td>
<td>Prohibit the user from changing the password at any time.</td>
</tr>
<tr>
<td>Password never expires</td>
<td>Select to maintain the user password. See “Computer configuration properties” on page 104.</td>
</tr>
</tbody>
</table>

Ghost Solution Suite Agents

To remotely manage computers from a Ghost Solution Suite Console, a Ghost Solution Suite Agent is installed on each computer in the Ghost Solution Suite Server system. Ghost Solution Suite Agents are provided for various computer types, including Windows, and Linux computers.

To set or modify Ghost Solution Suite Agent settings from the Ghost Solution Suite Server Console, right-click a computer or group, select Change Agent Settings >
**Production Agent.** To set or modify agent settings for new computers, click **Tools > Options,** click **Agent Settings.**

The following Ghost Solution Suite Agents reside on the client computer and communicate with the Ghost Solution Suite Server:

<table>
<thead>
<tr>
<th>Agent Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ghost Solution Suite Agent on Windows</strong></td>
<td>The Ghost Solution Suite Agent runs on Windows computers, including desktops, notebooks, and servers.</td>
</tr>
<tr>
<td><strong>Ghost Solution Suite Agent on Linux</strong></td>
<td>This Ghost Solution Suite Agent runs on Linux workstations and servers.</td>
</tr>
<tr>
<td><strong>Automation Agent</strong></td>
<td>The Automation Agent is used when you create configurations to boot client computer to automation. This is done through Boot Disk Creator.</td>
</tr>
<tr>
<td><strong>Ghost Solution Suite Agent on ThinClient CE 6.0</strong></td>
<td>This agent runs on ThinClient Windows CE 6.0 operating systems and lets the Ghost Solution Suite Console manage WinCE 6.0 based Thin Clients.</td>
</tr>
<tr>
<td><strong>Ghost Solution Suite Agent on CE .NET</strong></td>
<td>This agent runs on the CE .NET 4.2 operating system.</td>
</tr>
<tr>
<td><strong>Notification Server Client</strong></td>
<td>The NS client is an agent that runs on computers supported by the Notification Server. This agent runs on the Ghost Solution Suite Server computer when running Ghost Solution Suite on the Notification Server.</td>
</tr>
<tr>
<td><strong>Ghost Solution Suite Server Agent</strong></td>
<td>This agent runs on the Ghost Solution Suite Server computer when running Ghost Solution Suite on the Notification Server.</td>
</tr>
</tbody>
</table>

**Install Ghost Solution Suite Agent to add a managed computer**

When a Ghost Solution Suite Agent is installed on a computer, it searches the network for a Ghost Solution Suite Server to attach to. When the Ghost Solution Suite Agent locates a Ghost Solution Suite Server, the client computer is added as a record to the Ghost Solution Suite Database.

When the Ghost Solution Suite Agent for Windows is running on a computer, the user sees a small icon in the notification area. When the icon is blue, the client computer running the Ghost Solution Suite Agent is connected to the Ghost Solution Suite system.
When the Ghost Solution Suite Agent for Windows icon is clear, it shows that the client computer is not connected to the Ghost Solution Suite system. The agent may be configured incorrectly, the Ghost Solution Suite Server is down, or other network problems exist.

**Automatically update to newer version of Ghost Solution Suite Agent**

At times, Symantec may update versions of the Ghost Solution Suite Agent to enhance features. For best performance, we recommend that all managed computers run the latest version of the Ghost Solution Suite Agent. When a new version of the Ghost Solution Suite Agent is saved to the eXpress Share file server, the managed computers automatically update the Ghost Solution Suite Agent.

- From the computer where Ghost Solution Suite Server is installed, click **Start** > **All Programs** > **Altiris** > **Deployment Solution** > **Configuration**. The Symantec Ghost Solution Suite Server Configuration Utility page appears.
- Click **Options**.
- Click **Transport**.
- Select the **Automatically update clients** option and click **OK**.

**Ghost Solution Suite Agent settings**

You can set the default agent settings when new client computers are added to the system that the Ghost Solution Suite Server manages. You can also modify the properties settings for the Production or Automation Agent through the Automation Agent.

To set or modify agent settings in the Ghost Solution Suite Server Console for Windows or Linux clients, right-click the computer and select **Change Agent Settings** > **Production Agent Settings**.

- To set or modify agent settings for the Ghost Solution Suite Agent, click **Tools** > **Options**.
- Click the **Agent Settings** tab.
- Select the **Force new agents to take these default settings** check box to set the Ghost Solution Suite Agent settings for all new computers.
- Click the **Change Default Settings** option. Click each agent setting tab to set the properties.
  - See “Server connection” on page 119.
  - See “Access” on page 120.
  - See “Security ” on page 121.
  - See “Log file ” on page 123.
See “Startup and shutdown” on page 124.

- Click OK.

To view or modify settings from the Windows client, right-click the Ghost Solution Suite Agent icon in the notification area (or double-click the client icon in the notification area and click Properties).

When the client agent is first started, the agent establishes a connection to the Ghost Solution Suite Server using the following general steps:

**To connect to the Ghost Solution Suite Server**

1. The agent service is started and initialized.
2. A TCP socket is created.
3. A connection is made to the Ghost Solution Suite Server.
4. The agent is updated, if required.
5. A basic inventory of the client is sent to the Ghost Solution Suite Server.

After the initial connection process is complete, no additional data needs to be sent to or from the Ghost Solution Suite Server for the client agent to remain connected.

---

**Note:** If no Ghost Solution Suite traffic is sent to the Ghost Solution Suite System agent, the TCP/IP protocols send an occasional watchdog packet (approximately every 24 hours) to ensure that the connection is still valid.

---

**Ghost Solution Suite Agent properties**

Right-clicking the Ghost Solution Suite Agent icon gives you access to the following options:

- **View status.** Brings up the Symantec Client Service box to observe the current status of the Ghost Solution Suite Agent. You can also see the computer name, Ghost Solution Suite Server connected to, IP address, multicast address, and MAC address. You can also watch Ghost Solution Suite Agent communicate with the Ghost Solution Suite Server. Clicking Properties lets you edit the Ghost Solution Suite Agent properties. Passwords protect this option.

- **About.** Displays the version and licensing statement for the Ghost Solution Suite Agent. Passwords do not affect this option.

- **Exit.** Stops all Ghost Solution Suite Agent services from running but does not uninstall Ghost Solution Suite Agent. Ghost Solution Suite Agent loads normally the next time you boot the computer. Passwords protect this option.
## Server connection

Table 4-10

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect directly to this Deployment Server</td>
<td>Select this option so that the client receiving the Ghost Solution Suite Agent connects to the Ghost Solution Suite Server you selected to configure.</td>
</tr>
<tr>
<td>Address/Hostname</td>
<td>Enter the IP address or NetBIOS name of the Ghost Solution Suite Server computer.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number communicating with the Ghost Solution Suite Server.</td>
</tr>
<tr>
<td>Enable key-based authentication to Ghost Solution Suite Server.</td>
<td>Select this option to specify mandatory authentication for client computers to connect to the Ghost Solution Suite Server. This helps keep rogue computers from connecting to unauthorized Ghost Solution Suite Servers.</td>
</tr>
<tr>
<td>Discover Ghost Solution Suite Server using TCP/IP multicast</td>
<td>Managed computers can use the multicast address if they are on the same segment as the Ghost Solution Suite Server or if multicast is enabled on the network routers. Ensure that the multicast address and port match those set up on the Ghost Solution Suite Server. Try using defaults on both the client and Ghost Solution Suite Server if you have problems while connecting. Managed computers should use the Ghost Solution Suite Server IP address if multicasting is disabled on the network routers or if they are not on the same network segment as the Ghost Solution Suite Server. The port number must match the number set on the Ghost Solution Suite Server. Otherwise, the client computers cannot connect.</td>
</tr>
<tr>
<td>Server Name</td>
<td>Enter the NetBIOS name of the computer running the Ghost Solution Suite Server.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number distributing the multicast address.</td>
</tr>
<tr>
<td>Multicast Address</td>
<td>Enter the group multicast address.</td>
</tr>
</tbody>
</table>
Table 4-10  (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TTL</td>
<td>Specifies the number of routers the multicast request can pass through. Change this setting if you want to locate a Ghost Solution Suite Server that is more than 32 routers away (default setting) or to restrict the search to a smaller number of routers, making it easier to find the closest Ghost Solution Suite Server.</td>
</tr>
</tbody>
</table>
| Refresh connection after idle| This check box and set the refresh time in hours or days. The Ghost Solution Suite Server closes the connection after the specified time and immediately tries to re-open the connection. This sends a message to client computers that the network is down.  
The default checking is of 28800 seconds or 8 hours. We recommend keeping this setting above 28800. Do not set this option too low-reconnecting to the Ghost Solution Suite Server increases bandwidth when connecting. If this option is set too low, your client computers will take longer to connect than to refresh their connections. |
| Abort files transfers if rate is slower than | Select this option to preserve bandwidth when running deployment tasks on slower connections.                                                                                                                  |

**Access**

Set these commands to control the way the client handles requests from the server.
Table 4-11  Access

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt the user before performing actions</td>
<td>You can select the following options to prompt the user before the corresponding action is performed:</td>
</tr>
<tr>
<td></td>
<td>■ Shut down and Restart.</td>
</tr>
<tr>
<td></td>
<td>Prompts the user before shutting down and restarting the computer. This feature overrides the Power Control option from the Ghost Solution Suite Server to force applications to shut down without a message.</td>
</tr>
<tr>
<td></td>
<td>■ Copy file and Run command</td>
</tr>
<tr>
<td></td>
<td>Prompts the user before running a program or executing file copy commands.</td>
</tr>
<tr>
<td>Time to wait for user response</td>
<td>If one of the Prompt the user before perform actions is selected and the user is not at the computer to respond, you need to decide whether to continue or abort the operation. Specify the time to wait for the user's response, and select one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ Continue the operation</td>
</tr>
<tr>
<td></td>
<td>Select to continue if there is no response from the user.</td>
</tr>
<tr>
<td></td>
<td>■ Abort the operation.</td>
</tr>
<tr>
<td></td>
<td>Click to not continue if there is no response from the user.</td>
</tr>
<tr>
<td>Select when the Ghost Solution Suite Server is denied access to the Ghost Solution Suite Agent.</td>
<td>Select the days and set the start and end times when access to the Ghost Solution Suite Agent is denied.</td>
</tr>
</tbody>
</table>

Security

This page lets you secure data between the Ghost Solution Suite Server and the Ghost Solution Suite Agent, or to set a password so that the user on the client computer can only view and modify the User Properties of the Ghost Solution Suite Client Settings on the managed computer.
### Table 4-12  Security

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Encrypt session communication with Ghost Solution Suite Server** | Select to allow encryption from this managed client computer to the Ghost Solution Suite Server. This lets encrypted data transmissions between the Ghost Solution Suite Server and the Ghost Solution Suite Agent on the client computer. If selected, the client computer can connect (but is not required to connect) using encryption.  
To enable encryption protocols, you must open the Symantec Ghost Solution Suite Server Configuration Utility, click **Options** and select the **Transport** tab. Select the **Allow encrypted sessions** check box to let Ghost Solution Suite Server transmit using encryption protocols. |
| **Require encrypted session with any server** | Select to require encryption between the managed client computer and the Ghost Solution Suite Server. If this option is selected and the option to allow encryption in the Deployment Configuration tool is not selected, the Ghost Solution Suite Server does not communicate with the Symantec Client on the managed client computer.  
**Note:** Selecting encryption options slows down the communication path between the agent and the Ghost Solution Suite Server. |
| **Password protect Admin properties from user** | Select to let users on the managed computer access the Admin properties only if they enter the set password. If the check box is selected and the user does not know the password, they will have rights only to view the User Properties, which includes only the **User Prompts** and **Remote Control** tabs on the **Symantec Client Settings** dialog.  
Enter the password in the Password field and re-enter the password for confirmation in the Confirm password field. |
| **Hide client tray icon** | Select to hide the Symantec Client icon in the notification area of the managed computer. |
Log file

The Log File page controls how data is logged and saved in a Ghost Solution Suite Server system, letting you save different types and levels of information to the log files. You can save a text file with logged errors, informational errors, and debug data using this dialog. If the log exceeds the specified size, the older data is dropped from the files. You can maximize the size of the log file to save all selected data.

Table 4-13  Log file

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save log information to a text file</strong></td>
<td>Select this option to save information to a log file. By default, this option is cleared. Selecting this option enables the File name and Maximum size fields.</td>
</tr>
<tr>
<td><strong>File name.</strong></td>
<td>Enter the name and path of the log file. The default path is \Program Files\Altiris\AClient\AClient.log file.</td>
</tr>
<tr>
<td><strong>Maximum size</strong></td>
<td>Enter the maximum number of bytes for each log file.</td>
</tr>
<tr>
<td><strong>Log errors</strong></td>
<td>Select this option to save only the errors returned when running a job or operation between the Ghost Solution Suite Server and the Ghost Solution Suite Agent.</td>
</tr>
<tr>
<td><strong>Log informational messages</strong></td>
<td>Select this option to save a list of procedural steps run on the client computer.</td>
</tr>
<tr>
<td><strong>Log debugging information</strong></td>
<td>Select this option to list comprehensive debugging information in the text file.</td>
</tr>
</tbody>
</table>

Note: If the log exceeds the specified size, the older data is dropped from the files, so it is recommended to select an appropriate maximum file size.

Proxy

Typically, remote networks on the other side of a router or switch cannot receive multicast or Wake-On-LAN packets from the Ghost Solution Suite Server. Setting the managed computer as a proxy client computer forwards or re-creates the multicast packets. A managed client computer setup as a multicast proxy simply acts as a Ghost Solution Suite Server and advertises the server's name and IP
address through multicasting. You can also set the managed computer as a proxy to send Wake-On-LAN packets.

Set these options to control how the managed computer acts as a proxy agent, identifying the type of traffic this managed computer forwards from the server.

Table 4-14  Proxy

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Forward Wake-On-LAN packets</strong></td>
<td>Select if you want the managed computer to forward Wake-on-LAN packets.</td>
</tr>
<tr>
<td><strong>Forward Ghost Solution Suite Server discovery multicast packets</strong></td>
<td>Select if you want to advertise the Ghost Solution Suite Server to client computers on another LAN segment or if the client computer is on the other side of the router.</td>
</tr>
<tr>
<td><strong>Send multicast advertisement every</strong></td>
<td>Set the time in seconds, minutes, or hours for managed computers to send a multicast advertisement.</td>
</tr>
</tbody>
</table>

**Startup and shutdown**

Following are the field and the description of the Startup and shutdown dialog box:

Table 4-15  Startup and shutdown

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delay starting jobs after system startup</strong></td>
<td>Set the time in seconds, minutes, or hours for managed computers to delay jobs until after system startup.</td>
</tr>
<tr>
<td><strong>Force all programs to close when shutting down</strong></td>
<td>Select this option to shut down applications when using Power Control features. The user is still prompted to Abort or Continue the shutdown.</td>
</tr>
<tr>
<td><strong>Synchronize date/time with Ghost Solution Suite Server</strong></td>
<td>Select this option to synchronize the system clock of managed computers with the time of the Ghost Solution Suite Server.</td>
</tr>
<tr>
<td><strong>Prompt for a boot disk when performing automation jobs</strong></td>
<td>Select this option to prompt for a boot disk while running any automation jobs.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Disable direct disk access for GSS agent for DOS (Boot Works) communication.</td>
</tr>
</tbody>
</table>
Computer properties

View and edit the computer properties for each managed computer.

View and edit computer properties by double-clicking a computer icon in the Computers pane, or right-clicking and selecting Properties, or clicking the icon in the toolbar.

See “General” on page 125., See “Hardware” on page 125.

General

View or change the name of the computer as it appears in the console. You can view the following: logged-on user names, operating system installed, name of the Ghost Solution Suite Server, whether an automation partition is installed, version of the Symantec Windows Client, and other client information.

See “Computer configuration properties” on page 104.

Hardware

View processor make and type, processor count, RAM installed on the computer, display configuration, manufacturer, model, product name, MAC address of each network adapter installed, serial number, asset tag, UUID, and whether Wake On LAN and PXE are installed and configured.

See “Computer configuration properties” on page 104.

Drives

View information about each drive on the computer. If you have multiple drives, you can select a drive from the list to view its settings, such as the capacity, serial number, file system, volume label, and number of drives installed.

See “Computer configuration properties” on page 104.

TCP/IP

View TCP/IP information, including a list of all installed network adapter cards (up to eight) for the selected computer. Click Change to open the Configuration page to modify settings.

See “Configuring computers” on page 132.

See “Computer configuration properties” on page 104.
Applications

View the applications that are installed on the computer, including their description, publisher, version number, product ID, and system components.

See “Computer configuration properties” on page 104.

Services

View the services installed on the computer along with the description, start type, and path for each service.

See “Computer configuration properties” on page 104.

Devices

View the devices installed on the computer, including display adapters, disk drives, ports, storage volumes, keyboards, and other system devices.

See “Computer configuration properties” on page 104.

Location

View and edit user-specific properties such as contact name, phone number, e-mail address, department, mail stop, and site name.

See “Computer configuration properties” on page 104.

Bay

View location information and other properties for Rack / Enclosure / Bay components for high-density and blade servers. Set rules for automatic re-deployment of blade servers based on physical location changes. This property is available only to systems using blade servers.

Server deployment rules

From the Bay property page, you can select rules to govern actions taken when a new blade server is detected in a selected bay. These rules are described below:
<table>
<thead>
<tr>
<th>Rule</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Re-Deploy Computer</strong></td>
<td>Restore a blade server using deployment tasks and configuration settings saved from the previous server blade in the bay. This lets you replace new blades in the bay and automatically run deployment tasks from its deployment history. See “Restoring a computer from its deployment history” on page 131. All deployment tasks in the bay's history are run starting from the last Distributing a Disk Image task or Scripted OS Install task, or from any script (in a Run Script task) with this command: rem deployment start. See “Scripted OS install” on page 173. See “Running a script” on page 191.</td>
</tr>
<tr>
<td><strong>Run Predefined Job</strong></td>
<td>The server processes any specified job. Select a job to run automatically when a new server is detected in the bay.</td>
</tr>
<tr>
<td><strong>Ignore the Change</strong></td>
<td>This option lets you move blades to different bays without automatically running jobs. The server blade placed in the bay is not identified as a new server and no jobs are initiated. If the server existed in a previous bay, the history and parameters for the server are moved or associated with the new bay. If the server blade is a new server (never before identified), the established process for managing new computers is executed.</td>
</tr>
<tr>
<td><strong>Wait for User Interaction</strong></td>
<td>(Default) No job or tasks are performed (the Ghost Solution Suite Agent on the server blade is instructed to wait). The icon on the console changes to reflect that the server is waiting. See “Computer configuration properties” on page 104.</td>
</tr>
</tbody>
</table>
Lights-Out

View information about the remote management hardware installed on the selected computer (most often a server) used to power up, power down and restart the computer remotely, or to check server status. You can also enter the password for the remote management hardware by clicking Password.

**Note:** This feature is currently only available for selected HP Integrated Lights Out (ILO) and Remote Insight Lights-Out Edition (RILOE) features.

See “Computer configuration properties” on page 104.

Remote operations using Ghost Solution Suite

The Operations menu in the Ghost Solution Suite Console provides a variety of commands to remotely manage all computers in your site or network segment. Some operation commands, such as **Restore**, automatically create and schedule deployment jobs and place them in the System Jobs folder in the Jobs pane. Other commands, open utility programs to access and remotely manage computers.

Open the computer operations menu by right-clicking a computer icon in the **Computers** pane, clicking **Operations** on the menu bar, or clicking the icons in the toolbar.

<table>
<thead>
<tr>
<th><strong>Table 4-17</strong> Remote operations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td><strong>Restore</strong></td>
</tr>
<tr>
<td><strong>History</strong></td>
</tr>
<tr>
<td><strong>Configure</strong></td>
</tr>
</tbody>
</table>
### Table 4-17  Remote operations (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick Disk Image</strong></td>
<td>Select a computer and image its hard disk. This creates and stores the image to distribute now or later. See “Quick disk image” on page 133.</td>
</tr>
<tr>
<td><strong>Power Control</strong></td>
<td>Wake up, restart, shut down, and log off remotely. See “Power control” on page 199.</td>
</tr>
<tr>
<td><strong>Execute</strong></td>
<td>Type and run commands remotely. See “Execute” on page 135.</td>
</tr>
<tr>
<td><strong>Copy File to</strong></td>
<td>Copy selected files, directories, or entire directory structures and send them to the selected computer(s). See “Copying a file” on page 196.</td>
</tr>
</tbody>
</table>

**ADVANCED >**

<table>
<thead>
<tr>
<th><strong>Clear Computer Status</strong></th>
<th>Clear computer status as shown in the title bar of the List View.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reset Connection</strong></td>
<td>Disconnect and reset the connection between Ghost Solution Suite Server and the Ghost Solution Suite Agent on the selected computer.</td>
</tr>
<tr>
<td><strong>Install Automation Folder</strong></td>
<td>Install the automation folder on selected computers. See “Installing and uninstalling Automation Folder” on page 135.</td>
</tr>
<tr>
<td><strong>Uninstall Automation Folder</strong></td>
<td>Uninstall the automation folder that is installed on the selected computer. See “Installing and uninstalling Automation Folder” on page 135.</td>
</tr>
</tbody>
</table>
Table 4-17  Remote operations (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Inventory</td>
<td>Update property settings for a selected computer. These inventory settings can be viewed in Computer properties. Select it to ensure that you have the latest inventory of the computer. Set the timeout value in the General tab of the Ghost Solution Suite Server Configuration utility (in the Control Panel).</td>
</tr>
<tr>
<td>Reject Connection</td>
<td>Refuse communication with the selected computer.</td>
</tr>
<tr>
<td>Uninstall agent</td>
<td>Uninstall the agent from the selected computer.</td>
</tr>
<tr>
<td>Apply Regular License</td>
<td>Apply a permanent license if a client computer is using a time-limited license or requires an updated license.</td>
</tr>
<tr>
<td>New Job Wizard</td>
<td>Open this to build, assign, and schedule deployment jobs for the selected computer. See “New Job wizard” on page 154.</td>
</tr>
<tr>
<td></td>
<td>See “New Dynamic Machine Groups” on page 146.</td>
</tr>
<tr>
<td>New Group</td>
<td>Click to create a new computer group in the Computers pane.</td>
</tr>
<tr>
<td>New Computer</td>
<td>Create a new computer account. See “Adding new computers” on page 100.</td>
</tr>
<tr>
<td>Rename</td>
<td>Assign the computer or group a new name in the console. Right-click a computer or group to edit in the Computer pane.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a computer, a computer group, or any combination of computers and groups from the database.</td>
</tr>
</tbody>
</table>
Table 4-17  Remote operations (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Agent Settings</td>
<td>Update property settings for the Ghost Solution Suite Agent running on selected computer(s).</td>
</tr>
<tr>
<td>Permissions</td>
<td>View security settings for the selected computer(s).</td>
</tr>
<tr>
<td>Job Scheduling Wizard</td>
<td>Open this to assign deployment jobs to the selected computer.</td>
</tr>
<tr>
<td>Properties</td>
<td>View computer configuration and network properties.</td>
</tr>
<tr>
<td></td>
<td>See “Computer properties” on page 125.</td>
</tr>
</tbody>
</table>

Restoring a computer from its deployment history

Occasionally, it is necessary to restore a computer to its original settings based on operations or deployment jobs previously executed on the computer. A computer’s past deployment history appears in the Restore Computer dialog, where you can restore a computer by selecting the tasks from its history file. You can rerun the deployment tasks to restore the computer.

Restore a computer by right-clicking a computer icon in the Computers pane and selecting Restore, clicking Operations > Restore Computer on the menu bar, or clicking this icon in the toolbar. You can restore a computer using Remote Operations Using Ghost Solution Suite or by creating and scheduling a job using the New Job Wizard.

See “Remote operations using Ghost Solution Suite” on page 128.

See “New Job wizard” on page 154.

To restoring a computer from its deployment history

1. Right-click a computer and click Restore.

   The Restore Computer dialog appears with a list of previous tasks with check boxes.

2. (Optional) Select the type of tasks to be displayed from the Show only drop-down list. Select the date from the Since list box to filter tasks.

3. Click Next to view a summary of tasks selected to reschedule.
4 Click **Next** to schedule the job.

   See “Building and scheduling jobs” on page 151.

5 Click **Finish**.

When you finish this computer operation, a new job appears in the Jobs pane of the Ghost Solution Suite Console under the **System Jobs > Restoration Jobs** folder. The job name has a generic format of Restore: <computer name>.

You can view the history of deployment tasks for a specific computer. Users who do not have administrative privileges or the permissions to delete a computer's history cannot access this option.

**To view a computer's history**

1 Right-click a computer and click **History**.

   The History of <Computer Name> dialog appears with a list of previous tasks, including when the task was scheduled, its deployment status and other deployment information.

2 (Optional) Click **Save As** to save the file as a .TXT or .LOG file.

3 (Optional) Click **Print** to print the History file.

4 Click **Delete** to delete the History file. Click **Yes** to the confirmation message.

5 Click **Close**.

   See “Remote operations using Ghost Solution Suite” on page 128.

### Configuring computers

From the Operations menu, you can enter and modify configuration settings for computers. See “Computer configuration properties” on page 104. for complete information about configuration settings.

**To configure computers**

1 Right-click a computer and click **Configure**.

   The **Computer Configuration Properties** dialog appears.

2 Set basic configuration values in the **General** configuration group (default view).

3 Click other configuration group icons in the left pane to set additional values.

4 Click **OK**.

   See “Remote operations using Ghost Solution Suite” on page 128.
Quick disk image

This computer operation creates a disk image of the selected computer. This option is a quick and easy way to create a disk image of a selected managed computer from the Ghost Solution Suite Console.

To run a disk image job you must have an automation folder installed on the client computer, or it is PXE-enabled and can boot to automation by connecting to a PXE Server.

To create a quick disk image

1. Right-click a computer and click **Quick Disk Image**.
   - The **Schedule Computers for Job** dialog appears.
   - See “Building and scheduling jobs” on page 151.

2. Schedule the job to run immediately or at a later time. You can also click the option to not schedule the job (this option places the job in the working area and does not run until you manually drag it to a selected computer and reschedule it).

3. Click **OK**.
   - A new job appears in the Jobs pane of the Ghost Solution Suite Console under the **System Jobs > Image Jobs** folder. The job name has a generic format of *Create Image: <computer name>*.
   - See “Remote operations using Ghost Solution Suite” on page 128.

Power control

This computer operation lets you wake up a computer, restart a computer, shut down, or log off as the current user for a selected managed computer. You can also power a computer on if Wake-On-Lan is supported.

Restore a computer by right-clicking a computer icon in the **Computers** pane and selecting **Power Control**, clicking **Operations > Power Control** on the menu bar, or clicking the icon on the toolbar.
To control power

1 Right-click a computer and select **Power Control**.

A secondary menu appears with the following options:

- **Wake-up**
  - The Wake-Up feature is hardware-dependent and is available only for inactive computers. Select this command to start a computer that has been turned off.
  - Your operating system and network adapter must be capable of recognizing and processing the Wake-on-LAN packets. Non-embedded network adapters must be properly configured. Example: 3Com NICs have an extra header cable that enables Wake-on-LAN. Check the documentation that comes with your network adapter for more information about Wake-on-LAN.
  - For NICs and operating systems that support Wake-on-LAN Power Management features, go to the **Properties** dialog of the network adapter driver and select the **Power Management** tab. Click the **Allow this device to bring the computer out of standby** option for this device to bring the computer out of standby status.
  - You must enable this feature for some computers in their BIOS.

- **Restart**
  - Click to reboot the selected managed computer. Select **Force Applications to close without a message box** to restart immediately without prompting the user.

- **Shut down**
  - Click to shut down the selected managed computer. Select **Force Applications to close without a message box** to shut down immediately without prompting the user.

- **Log off**
  - Click to log off the selected managed computer. Select **Force Applications to close without a message box** to log off immediately.
2 Select a Power Control option. A **Confirm Operation** dialog appears. Select the **Force application to close without a message** option to shut down users without a warning. If you do not select this option, the user is prompted to save work before the power operation continues.

3 Click **Yes**.

See “Remote operations using Ghost Solution Suite” on page 128.

**Execute**

Send a command from the Ghost Solution Suite Console as if you were entering a command from the command-line prompt on the client computer.

Execute a command to a client computer by right-clicking a computer icon in the **Computers** pane and selecting **Execute**, clicking **Operations > Execute** from the menu, or clicking this icon in the toolbar.

**To execute**

1. Type a command you would like executed on the selected remote computer(s), or select from a list of previously-run commands. Example: Type regedit to open the registry on the computer.

2. To run the command as another user on the managed computer, click **User** and enter the user name and password.

**User account**

Use this dialog to run a script using another local user account. You can log in with another user name and password with rights to run an execute command.

<table>
<thead>
<tr>
<th>Table 4-18</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Run with default security credentials.</td>
</tr>
<tr>
<td>Run with the following credentials</td>
</tr>
</tbody>
</table>

See “Remote operations using Ghost Solution Suite” on page 128.

**Installing and uninstalling Automation Folder**

An automation folder package contains pre-boot operating system files and drivers. The automation folder is installed on the client computer and lets you boot the client computer in the automation environment without using the network boot (PXE).
Booting a client computer using an automation folder is faster compared to the network boot option. However, if there is any change in the configuration, you must reinstall the automation folder on all the client computers.

**Note:** Currently, Ghost Solution Suite supports installation of automation folder only for Windows operating system.

The automation folder package name consists of the name of the pre-boot configuration. For example:

If you create an Automation Folder for WinPE_HP configuration for a 64-bit computer, the Automation Folder package is stored as AF_WinPE_HP.exe

The path where the folder is saved is as follows:

```
\Altiris\eXpress\Deployment\Server\AutoFolderPkgs\WinPE_HP\X64\AF_WinPE_HP.exe
```

If you modify the Automation Folder Configuration for any reason such as addition of new drivers, you must install the latest automation folder on the client computers. The new configuration uninstalls the earlier configuration and installs the latest package on the client computers.

To verify if the automation folder is installed successfully, check the status code in autoutil.log and autoinst.log files which are created on C:\.

**To create a configuration for an Automation Folder**

1. In the Ghost Solution Suite console, click the **Boot Disk Creator**.
2. In the **Boot Disk Creator** dialog, navigate to **File > New configuration…**
3. In the **Create Configuration** wizard, enter the following:

   - **Enter the name for this configuration**
     
     Enter the name of the configuration.

   - **Enter a detailed description for this configuration (optional)**
     
     Enter a description for the automation folder configuration.

   - **Pre-boot Operating System for this Configuration**
     
     Select the Windows pre-boot operating system from the list.
     
     **Note:** To install automation folder on Windows XP client, use WinPE 3.1 version.

4. Click **Next**.

5. Select the **Hardware Device** drivers that you want to bundle with the automation folder package and click **Next**.
6 Enter the TCP/IP Protocol Settings to govern the communication with the Server and click **Next**.

7 In the Ghost Solution Suite Server Communication, enter the Server IP address and the Port number for communication.

8 Select the location of the Automation Agent Location. Specify if the automation agent is located remotely on the server share or in the local pre-boot environment. Click **Next**.

9 Enter the **Network Connection** details for the client computer to connect to the file server.

10 In the **Network Drive Mappings**, browse to the drive that you want to map. Click **Next**.

11 In the **Optional Component** dialog, select if you want to add any additional components. Click **Next**.

12 In the **Boot Disk Media Type** dialog, select the media type for the Boot disk and click **Next**.

13 (Optional) When you are prompted to confirm if you want to store the automation boot package installer with the configuration name that you specified in the first step, click **Yes**.

**To install an Automation Folder**

1 In the Ghost Solution Suite console, select the computer or a group of computers on which you want to install an automation folder.

2 Right click and select **Advanced**.

3 From the menu, select **Install Automation Folder**....

4 Select a configuration for which you want to create and install an automation folder on the selected computer.

5 Check the status of the task from the console.

**To uninstall an Automation Folder**

1 In the Ghost Solution Suite console, select the computer or a group of computers from which you want to uninstall an automation folder.

2 Right click and select **Advanced**.

3 From the menu, select **Uninstall Automation Folder**.

4 Check the status of the task from the console.
Change agent settings

This feature lets you modify most of the agent settings for a selected computer or computer group. You can set properties for the Production Agent (Ghost Solution Suite Agent), or for an Automation Agent.

To change agent settings

1. From the Computers pane, right-click a computer and select Change Agent Settings.
2. Select either Production Agent or Automation Agent.
3. Edit the properties settings.
4. Click OK.

Deploying and managing servers

Ghost Solution Suite provides additional features to remotely install, deploy and manage servers. From the Ghost Solution Suite Server Console, you can configure new server hardware, install operating systems and applications, and manage servers throughout their life cycle. And because servers are mission-critical, you can set up a system to quickly deploy new servers or automatically re-deploy servers that have failed. Features like rules-based deployment, support for remote management cards, and quick server restoration from a deployment history give you new tools to manage all servers throughout your organization.

Servers are identified in the Computer pane with distinctive server icons. Like all managed computer icons, the icons change to identify the status and state of the computer, such as user logged on or Server Waiting.

Note: Servers are recognized by their operating system (such as Windows 2000 Advanced Server, Windows Server 2003, 2008, or any Linux operating system), multiple processors, and specific vendor server models.

Table 4-19 Deploying and managing servers

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Servers from the Console.</td>
<td>The Ghost Solution Suite Server Console includes features specifically designed for deploying and managing servers, such as enhanced task logging and history tracking features to let you recall administrative actions and quickly redeploy mission-critical servers.</td>
</tr>
</tbody>
</table>
Servers are essential to any organization and require special planning and management strategies. Ghost Solution Suite Server provides server-specific features to automatically deploy new servers and maintain existing servers.

See “Server deployment options” on page 140.

<table>
<thead>
<tr>
<th>Server management features</th>
</tr>
</thead>
</table>

Ghost Solution Suite Server provides various features for deploying and managing servers. These features are supported for client computers as well, but are essential in deploying servers.

Server icons. The Ghost Solution Suite Console displays icons that identify servers across the network. Like other computer icons in the console, server icons can be selected to view server properties or assign specific jobs and management tasks.

The following states are displayed:

- The server is active and a user is logged on.
- The server is disconnected from the console.
- The server is in a waiting state.

<table>
<thead>
<tr>
<th>Table 4-20</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Scripted Installs.</td>
<td>Execute scripted, unattended installs across the network for both Microsoft Windows and Linux servers. Follow steps to create answer files and set up operating system install files using a wizard.</td>
</tr>
</tbody>
</table>

See “Scripted OS install” on page 173.
Support for multiple network adapter cards.

Because servers may require more than one network interface card, Ghost Solution Suite Server provides property pages to access and configure multiple network adapters remotely from the console.

See “TCP/IP configuration settings” on page 109.

Synchronized server date and time.

Ghost Solution Suite Server automatically sets the server's date and time after installing or imaging (as part of the configuration process). Ghost Solution Suite Agents include an option to disable this feature (it is off by default).

Enhanced scripting capabilities.

Ghost Solution Suite Server also lets you view and debug each step in the deployment script, and track each job to provide a history of tasks for redeploying a server.

Server deployment options

Ghost Solution Suite Server includes features to automatically reconfigure and redeploy new servers. If you are using Initial Deployment to automatically re-image new servers or run installation scripts, you can (1) safeguard against mistaken disk overwrites, or (2) run automatically for every server not identified as a managed computer in the database. These contrasting settings are based on polices you define for managing servers in your organization.

Example: If you rely on PXE to boot the new server and you want to deploy new servers automatically without halting the process, you must change the default settings in the PXE Configuration Utility. In contrast, if you want to ensure that the server waits before being deployed (or waits a set time before proceeding) to avoid erroneous re-deployment, you must set the options in the Advanced section of Initial Deployment.

When a server boots from a PXE server or from Automation (if the option is set), Ghost Solution Suite Server recognizes it as a new computer and attempts to configure the computer with sample jobs. See Sample jobs. Initial Deployment includes a feature to prohibit servers from being deployed automatically.
To halt the initial deployment of servers

1. Click Initial Deployment and select Properties.
2. Click the Advanced tab.
3. Select the Servers check box and click OK.

Initial Deployment does not run for any computer identified in the console as a server.

If installing a server using a PXE Server, the server attempts to install, but does not run automatically using default settings. It waits until a boot option is selected from the client computer. You can change the default setting in the PXE Configuration Utility to allow Initial Deployment to run automatically and not wait for user intervention.

To change PXE options for initial deployment

1. Click on Start > All Programs > Altiris > PXE Configuration Utility.
2. Click the GSS tab.
3. Select a pre-boot operating system from the Initial Deploy boot option drop-down list.
4. Click Execute Immediately.
   
   Initial Deployment runs automatically for every identified server.
5. Click Save.
6. Click OK.

When you run a deployment job on a computer where the Ghost Solution Suite Agent is remotely installed, a message appears stating that PXE stamp is found. The message remains open until the user clicks OK on the message dialog, which delays executing the scheduled job as part of an automated redeployment process. To fix this delay:

Following these steps, ensures that the BootWorks message does not appear and a job runs smoothly when scheduled.

Managing server blades

Ghost Solution Suite lets you manage high-density server blades with Rack/Enclosure/Bay (R/E/B) hardware and properties. From the Ghost Solution Suite Console, you can deploy and manage these space-efficient server blades using the physical view to assign jobs to the Rack, Enclosure, or Bay level of the server cluster, or you can manage each server blade directly from the logical view.

See Bay for properties and rules to deploy Rack/Enclosure/Bay servers.
Using Ghost Solution Suite, you can employ rip and replace technology that lets you insert a new server blade and automatically configure and deploy it exactly like the previously installed server blade, letting you replace any server that is down and get it back online quickly. By default, the replay option is checked when you create a new job. This option replays the job during any rip and replace actions. Symantec provides fail-safe features to ensure that no server is mistakenly overwritten and that all disk images, software, data, and patches are applied to the new server from the history of jobs assigned to the previous server blade.

**Hewlett-Packard server blades**

Hewlett-Packard high-density blade servers can be deployed and managed from the Ghost Solution Suite Console. The following HP server blades are supported:

- **HP Proliant™ BL e-Class**
  - Proliant™ BL 10e
  - Proliant™ BL 10e G2

- **HP Proliant™ BL p-class**
  - Proliant™ BL 20p
  - Proliant™ BL 20p G2
  - Proliant™ BL 40p

HP blade servers let you employ all features provided in the Ghost Solution Suite Console when you install the HP Proliant Essentials Rapid Deployment Pack (see www.hp.com/servers/rdp), including the Virtual Blade Server feature. The name of each Rack for an HP Server appears along with the assigned name for the Enclosure and Bay. These names are collected from the SMBIOS of the server blade and appear in both the physical and server views within the Computers pane of the Ghost Solution Suite Console.

For HP blade servers in the physical view, the Rack name can be a custom name in the console, with all subordinate Enclosures and Bays also identified. Example:

```
<rackName>
<enclosureName>
<bayNumber>
```

See “Server management features” on page 139.

See “Server deployment options” on page 140.

**Dell server blades**

Dell high-density blade servers can be deployed and managed from the Ghost Solution Suite Console. All Dell Rack Servers are supported by Ghost Solution
Suite, but the server blades can also be managed from the physical view in the Rack/Enclosure/Bay view. The following servers are supported:

**Dell Rack Servers**
- All PowerEdge™ rack servers

**Dell Server Blades**
- PowerEdge™ 1655MC

For Dell blade servers in the physical view, the Rack name is always Dell. All subordinate Enclosures and Bays are identified with custom names under the Dell rack name. Example:

Dell

<enclosureName>

<bayName>

See “Server management features” on page 139.

See “Server deployment options” on page 140.

Finding a computer in the database

This search filter lets you type a string and query specified database fields for specific computer properties. You can search for user or computer names, licensing or location information, or primary lookup keys: MAC address, serial number, asset number, or UUID. This search filter queries property values appear in the Computer Properties pages.

See “Computer properties” on page 125.

Click `<CTRL> F` or click Find Computer on the console toolbar to search the Ghost Solution Suite Database for computers by property settings. The search begins at the top of the computer list and highlights the computer name in the Computers pane when a match is found. Press F3 to find the next computer that matches the search criteria until there are no more results, or the end of the computer list is reached.

**To find a computer in the database**

1. In the **Search For** field, type all or part of the computer's property values you would like to search for. This alpha-numeric string is compared with specified database fields.

2. From the **In Field** drop-down list, select the field you want to search in the Ghost Solution Suite Database.

   Example: To find a computer by searching for its IP address, type the address in the **Search For** field and select the **IP Address** from the **In Field** drop-down list.
### BIOS name of the computer.

### Ghost Solution Suite name of the computer.

### Example: 0080C6E983E8.

### Example: 192.168.1.1.

### Example: The computer ID. 5000001.

### Serial number installed in BIOS. A primary lookup key.

### Asset number in BIOS. A primary lookup key.

### A primary lookup key.

### Name entered when the operating system was installed.

### Product Key for the operating system.

### Name of the user currently at the computer.

### The actual bay number. Example: 7x.

The computer you are looking for appears highlighted in the Computers window in the console.

**Note:** This search is not case-sensitive and allows wildcard searches using *.

See "Computer filters and job conditions" on page 80.

### Using lab builder

Use the Lab Builder to set up jobs under the **Lab** folder in the **Jobs** pane to set up a classroom or lab environment.

Click **Lab Builder** on the console toolbar or click **File > New > Lab Builder** to set up jobs specifically created for managing multiple computers in a lab environment.

You can set up jobs to:

- Create Disk Image
- Deploy Lab
- Restore Lab
- Update Configuration
Upload Registries

Each of these jobs contains a default list of tasks. Lab Builder places these five new jobs under a folder (which you name) located under the Lab folder. All tasks in the jobs have been assigned default paths and file names that let them use the same images and configuration information, registry data, and so on. Symantec recommends that you do not change the file names and paths. If you change the default settings (example: changing the image name), you must change them in all jobs where the image is used.

To use Lab Builder

1. Click the Lab Builder icon on the toolbar, or choose File > New > Lab Builder.
2. Enter the name of the Lab Setup.

Note: The lab name must be unique as the program creates a default image file name based on the lab name, and the image file name must be unique. The default image name is synchronized in all lab jobs, so if you change the name later you must change it in all the jobs that use the image.

3. (Optional) Enter a lab description to help you differentiate the lab from others and click OK.
4. Identify an image in the Create Disk Image job.
5. Set computer names and addresses in the Update Configuration job.

The following information describes the default jobs. To run one of these jobs, simply drag it to the computer or computer group you want it applied to.

Create Disk Image

This job uploads an image of a computer to the server and an image name is created automatically based on the lab name. However, there is no actual image in the job until you drag the image source computer to this job.
Deploy Lab

This job has three default tasks: Distribute Disk Image, Modify Configuration, and Back up Registry. The image that is uploaded using the Create Disk Image job is distributed when you use this job. The configuration settings you specify in the Modify Configuration job are applied to the computers, and the computer registry files are uploaded to the Ghost Solution Suite Server.

Restore Lab

This job restores the image and registry files to a computer where a lab was previously deployed. You can quickly get a computer running again by restoring the lab on that computer.

Update Configuration

This job lets you set unique configuration information (such as computer names and network addresses) for client computers. When a lab is deployed, each computer has an identical image, but not the same configuration settings. This means you don’t have to visit each computer to reset the IP addresses and other settings when you deploy an image.

Upload Registries.

This job backs up computer registry files to the Ghost Solution Suite Server.

New Dynamic Machine Groups

The New Dynamic machine group lets you create groups of computers based on a filter. Following are the fields and the description of the New Dynamic machine group dialog:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Machine Group Name</td>
<td>Enter a name for the group</td>
</tr>
<tr>
<td>Group</td>
<td>Select an existing group or select all computers, New computers or New Group</td>
</tr>
<tr>
<td>Filter</td>
<td>Select a filter based on which the computer or groups of computers are filtered.</td>
</tr>
</tbody>
</table>
If you want to edit or modify filters use Setup>>.

See “Filter Setup” on page 148.

Creating and modifying filters

Ghost Solution Suite lets you create filters for computers. A filter lets you specify a set of conditions based on which the computers that are present on the network are filtered.

For example: If you want to find out all the computers whose RAM is equal to 4MB, then you can set the filter where Field is RAM(total), operation is set as at most and value as 4.

Note: To delete a condition of a filter, select the filter condition from the Filter Setup dialog and click Delete.

To create filters
1. In the Ghost Solution Suite console, navigate to the Computers section and right-click to view the options.
2. From the options, select New Group.
3. In the Filter Setup dialog, enter the name of the filter that you want to create.
4. Click Add....
5. In the Filter definition dialog, select the field from the drop-down list.
6. Select the operation parameter.
7. Enter the Value of the parameter.
8. Click OK.
9. In the Filter Setup dialog, click OK.

To modify a filter
1. In the Ghost Solution Suite console, navigate to the Computers section.
2. From the Computers section, select the filter that you want to modify.
3. Click Setup>>.
4. In the Filter Setup dialog, select the condition that you want to modify.
5. Click Modify...
6. In the Filter definition dialog, modify the filter condition.
7 Click OK.
8 In the Filter Set up dialog, click OK.

Filter Setup

The Filter Set up dialog lets you create, modify, and delete the filters that are applied to the computers in the network. A filter is a set of multiple conditions based on which the computers that are present on the network are filtered. After you add the conditions to the filter, the table displays all the conditions that are set for the filter.

Following are the field and description of the Filter Set up dialog:

Table 4-22  Filter Setup

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Add the name for the filter.</td>
</tr>
<tr>
<td>Add...</td>
<td>Click on this option to add conditions to a filter.</td>
</tr>
<tr>
<td>Modify...</td>
<td>To enable the Modify option, select the condition from a filter that you want to modify.</td>
</tr>
<tr>
<td>Delete</td>
<td>To enable the Delete option, select the condition from the filter that you want to delete.</td>
</tr>
</tbody>
</table>

Following are the field and description of the Filter Definition dialog:

Table 4-23  Filter Definition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Select the name of the condition to be added from the drop-down list</td>
</tr>
</tbody>
</table>
| Operation | Select from the following operators:  
- contain  
- does not contain  
- ends with  
- is exactly  
- starts with  |
| Value | Enter the value for the condition that you want to use. |
See “Creating and modifying filters” on page 147.
Building and scheduling jobs

This chapter includes the following topics:

- Building and scheduling jobs
- Viewing job details
- New Job wizard
- Building new jobs
- Job scheduling wizard
- Setting conditions for task sets
- Deployment tasks
- Creating a disk image
- Distributing a disk image
- Scripted OS install
- Scripted install for Windows XP, Windows Server 2003 and earlier
- Scripted install for Windows Vista, Windows Server 2008, and later
- Scripted install for Linux
- Distributing software
- Capturing personality settings
- Distributing personality settings
Building and scheduling jobs

A job represents a collection of predefined or custom deployment tasks that are scheduled and executed remotely on selected client computers. You can build jobs with tasks to automatically create and deploy hard disk images, back up and distribute software or personality settings, add printers, configure computer settings, and perform all aspects of IT administration. Jobs can be run immediately for a specific computer, or stored and scheduled for daily or long-term administrative duties on multiple computer groups.

Job icons appear in the Jobs pane of the Ghost Solution Suite Console. To assign and schedule a job in the Ghost Solution Suite Console, drag the job icon to selected computer icons. Job status icons also appear in the Details pane of the Ghost Solution Suite Console to indicate various deployment states.

See “Viewing job details” on page 152.
The New Job Wizard guides you through common deployment and management jobs. It is an easy way to set up new users or migrate users to new computers, create and distribute images of computers on the network, distribute software packages, restore computers, and more.

See “New Job wizard” on page 154.

Jobs include one or more Deployment tasks. You build jobs by adding tasks to a job and customizing the task for your specific needs. You can add tasks to capture and distribute images, software packages, and personality settings. You can also write and run a script task, or run scripted installs, configure settings, copy files and back up registry settings. You can also modify existing jobs by adding, modifying, copy and pasting, or deleting tasks to suit your requirements.

See “Building new jobs” on page 158.

Set conditions on jobs to run only on computers with properties that match the criteria you specify. You can build one job to run on different computer types for different needs, and avoid mistakes by ensuring that the correct job runs on the correct managed computer. Add links.

See “Setting conditions for task sets” on page 160.

Initial Deployment lets you run predefined jobs and configuration tasks on new computers when they start up. You can automatically deploy new computers by imaging and configuring TCP/IP, SIDs, and other network settings and installing basic software packages. Sample jobs

Sample jobs are installed with Ghost Solution Suite and appear in the Samples folder of the Jobs pane. You can run many sample jobs as they are, or you can set environmental variables. Sample jobs

**Viewing job details**

As jobs are assigned, scheduled and executed, it is helpful to know specific details about their status and assignments. The Ghost Solution Suite Console provides job icons to show the state and status of the job in the Details pane:

- Job status icons that update the state of the job in running deployment tasks. These icons are graphical symbols in the Ghost Solution Suite Console used to identify the status of an assigned job.

A job is scheduled to run on a computer or computer group.
A job is in progress.

A job has executed successfully.

A job is associated with a computer or group of computers but is not scheduled.

Indicates error conditions when individual tasks run.

- A description of the job, if available. You can also use Add or Modify in the main window to edit the description.
- If a job defines error conditions when individual tasks run, the Status field displays any errors incurred and the tasks that completed successfully.
- Job Schedule details. This is the job's run time, beginning when the job started and ending when it completed successfully.
- The currently applied conditions appear in a list box with a Setup option to add conditions to different task sets for different computer properties within a job. Conditions specify characteristics that a computer must have before the job runs. See Setting conditions for task sets.
- A list of tasks assigned to the job and task descriptions also appears. Change the order of the task execution with the up and down arrows. Tasks are executed in the order they are listed. See Deployment tasks.
- Features to add, modify, and delete tasks for each job.
- A list of assigned computers and its deployment history.

To sort jobs or computer details, just point and click on the category in the Details pane. Example: Click the Status column heading to organize and display the progress status of the job.

See “Viewing computer details” on page 98.
New Job wizard

The New Job Wizard provides integrated features to build, assign, and schedule common deployment jobs. It helps you build the most common jobs, and guides you through additional steps to assign and schedule the jobs to selected computers. It lets you quickly build image files and deploy new computers, distribute software packages, migrate users, and more.

Note: When a software package or deployment job is scheduled to run on client computers, the Symantec Client Service Message dialog appears, warning them that a job is about to execute. If a user clicks Abort when the message appears, an event is logged to the client's history so that Ghost Solution Suite administrators know when users abort a scheduled event.

Create a new job by clicking New Job Wizard on the Ghost Solution Suite Console, clicking File > New > Job Wizard, or right-clicking in the Jobs pane of the Ghost Solution Suite Console and selecting New Job Wizard. The New Job Wizard appears to guide you through basic deployment jobs.

To create a New job

1 Select a job option:
   - Create an image. This wizard guides you through the steps required to create an image of a computer's hard disk and schedule the job.
   - Deploy and configure computers. This wizard guides you through the steps required to deploy a previously created new disk image on a selected computer and install software and personality settings.
   - Deploy software packages. This wizard guides you through steps required to install software packages. You can set conditions, select packages, assign to computers, and schedule the job. See “Distributing software” on page 183.
   - Restore a computer. This wizard guides you through the steps required to restore a computer to a known working state by re-imaging the hard drive and reinstalling software packages, personality settings, and defining configuration values. This option reschedules jobs saved in each managed computer's history record, which contains all deployment tasks previously processed. Restoring a computer from its deployment history
   - Migrate computers. This wizard guides you through the steps required to migrate the hard disk image, applications, and personality settings from a
source computer to a destination computer. You can perform one or more migration operations using the provided options.

2 Give the job a unique name. You can type a name up to 64 characters.

3 Follow the steps in each wizard to create a job (some New Job wizards build multiple jobs).

4 (Optional) Unselect the Replay during rip and replace option.

This option is selected by default. This option replays the job during any rip and replace actions.

After creating a job, the job appears in the Jobs pane of the Ghost Solution Suite Console with the deployment tasks listed in the Tasks list.

Note: You cannot define return codes when using the New Job Wizard. See “Building new jobs” on page 158.

See “Modifying tasks in a deployment job” on page 199.

Migrating computers

From the New Job Wizard, you can select Migrate computers to quickly distribute hard disk images, software, and settings from a user's current computer to a new computer. You can image a new computer's hard disk with a new operating system and install software and personality settings. Or perform different levels of migration to distribute only software or to simply capture and distribute personality settings to the new computer.

Migrate one computer to another separate computer

Click this option to migrate a user from a source computer (old computer) to another destination computer (new computer). Capture personality settings, distribute a new hard disk image, distribute software and redistribute the saved personality settings from the source computer to the new destination computer.

Click the option to migrate only personality settings to one or more computers. Also select Prepare destination computer with a disk image to distribute a disk image to the new computer and select Install software packages prior to applying the personality on the destination computer to install software packages on the new computer.

Note: This option creates two jobs that appear in the Jobs pane: Job (Capture) and Job (Distribute).
Job (Capture) includes a Capture Personality Settings task (See “Capturing personality settings” on page 186.) to capture the personality of the source computer and a Modify Configuration task to rename the source computer to avoid naming conflicts (see Modifying configuration). The source computer is named computerName (Old).

Job (Distribute) includes a Deploy Image task (see Distributing a disk image) if selected, a Modify Configuration task to update settings to the destination computer, and one or more Install Package tasks to update software (if selected) and migrate personality settings. See Distributing software.

Migrate the same computer to another operating system
Click this option to upgrade the operating system on a computer and reinstall personality settings and software packages on the same computer. It creates jobs and tasks to capture the personality settings, distribute a new disk image, distribute software packages, and migrate the personality settings.

Click the option to deploy a disk image and migrate the personality settings to the computer. (Optional) Select Install software packages prior to applying the personality on the destination computer to install software packages on the computer.

Note: This option creates two jobs that appear in the Jobs pane: Job (Capture) and Job (Distribute).

Job (Capture) includes a Capture Personality Settings task (See “Capturing personality settings” on page 186.) to capture the personality of the source computer.

Job (Distribute) includes a Deploy Image task () and one or more Install Package tasks to update software, if selected.

See “Distributing software” on page 183.

Simply capture the personality of the computers
Click this option to capture and save, but not distribute, the personality settings of the selected computer(s). You can select a personality template and save Personality Packages to the eXpress Share, letting you distribute these personality settings later to new computers.

Note: This option creates a single job with a Capture Personality Settings task.

See “Capturing personality settings” on page 186.

See “New Job wizard” on page 154.
Selecting computers in the new job wizard

The New Job Wizard provides steps to select and assign computers to the jobs created in the wizard, rather than requiring you to create a job and assign it to computers when building new jobs. The jobs created in the New Job Wizard appear in the Jobs pane, and can be saved and assigned to other computers at a later time. You can also schedule jobs for the specified computers in the wizard.

See “Building and scheduling jobs” on page 151.

Applying computers to a job

When deploying software in the New Job Wizard, you can select computers to assign the Distribute Software task created in the wizard. (See Distributing software.) You can also select an option to simply store the job and use it at another time without scheduling the job. Regardless of the scheduling option selected, the job appears in the Jobs pane to use at another time.

New Computers. Open an Adding New Computers dialog to create new user accounts to assign the job.

Associating destination computers

Use this dialog to associate source computers with destination computers when migrating personality settings. Depending on the computers selected in the previous Select Computers dialog, you can migrate personality settings captured from the source computers to new destination computers.

Right-click a computer in the Source column to replace it with another source computer. Right-click a computer in the Destination column to replace it with another destination computer and assign it to a new source computer. To automatically assign multiple computers, click Automatic to assign source computers with destination computers using an alpha-numeric order. The associated computers share personality settings after running the jobs.

See “Migrating computers” on page 155.

Setting up conditions in the new job wizard

The New Job Wizard also provides steps to set up conditions, a step usually performed independently for each job during its build phase. Setting conditions lets you run selected tasks only on computers matching defined criteria. See Setting conditions for task sets.

Click Setup conditions for this set of tasks to open the Define Conditions dialog from the New Job Wizard.
Installing software packages

The New Job Wizard provides steps to install software packages to the selected computers. You can install any type of software to the managed client computer, including .MSIs, and personality packages. If the selected package is not an personality package, a message appears asking if you want to continue. See Distributing software for additional information.

Option summary

After selecting the options in the New Job Wizard, you can view a summary of the job names, assigned computers, conditions, and other selected choices. To change any options, click Back to return to the previous dialog. Click Finish to complete the steps in the wizard.

See “New Job wizard” on page 154.

Building new jobs

A job can be a single task to distribute software or change computer property settings, or a series of tasks sequenced to migrate hard disk images, set post-installation TCP/IP and SID values, and install software packages and personality settings.

To create a new job, in the Ghost Solution Suite Console, navigate to File > New > Job, or right-click in the Jobs pane of the Ghost Solution Suite Console and select New Job. You can modify jobs by double-clicking the job or right-clicking, and selecting Properties. Add tasks to each job by clicking Add.

To build new jobs

1 Create a new job. Enter a unique name and description for the job. You can type a name up to 64 characters.

   A new job is added to the Jobs pane in the Ghost Solution Suite Console. You can group and organize jobs, and access and apply them to computers or computer groups from an index of prebuilt jobs.

2 (Optional) Set conditions to apply the job to specified computers meeting defined criteria. Order multiple conditions to run jobs on computers that match the first applicable condition. See Setting conditions for task sets.

3 Click Add to open a list of deployment tasks to add to each job.

4 Set task options using the provided wizards.
5 (Optional) Unselect the Replay during rip and replace option.

This option is selected by default. This option replays the job during any rip and replace actions.

After you complete the steps to create a task, it is added to the Task list. Click Add to add another task. Use the up and down arrows to change the order of execution of the tasks in the Task list.

Tasks are executed in the order that they appear in the task list. Therefore, ensure you do not run a task that overrides the previous tasks. Example: List Distribute Disk Image above Distribute Software or Distribute Personality, letting the hard disk be imaged before installing applications and settings.

6 (Optional) Set Return Codes. The last action in each task wizard lets you set return codes for each deployment task. See “Setting up return codes” on page 204.

7 After adding tasks, click OK.

8 To schedule the job, drag it to a computer or computer group. The Schedule Jobs dialog appears.

See “Importing and exporting jobs” on page 203.

Job scheduling wizard

The Job Scheduling Wizard provides features to assign jobs to selected computers and computer groups, and to schedule the jobs to run without using a mouse. This new feature meets Section 508 requirements to improve disability access and enables integration of voice activation software and other user interface features.

Select a job

Select the jobs or groups of jobs to assign to computers or computer groups. Use the SHIFT and CTRL keys to select multiple jobs or job folders. Click Next.

Select a computer or computer groups

Select the computers or groups of computers to assign the jobs selected in the previous dialog. Use the SHIFT and CTRL keys to select multiple computers or groups. Click Next.

New Computers. Click when adding new computers.

See “Adding new computers” on page 100.
Setting conditions for task sets

Setting conditions on a job lets you run selected tasks only on computers that match defined criteria. As a result, you can create a single job with tasks defined for computers with varying properties, including operating system types, network adapters, processors, free drive space, and other computer properties. You can create task sets for each job that apply only to the computers matching those conditions.

Note: The default condition (named default) has no parameters or values associated with it. If this is the only condition a job contains, the tasks associated with the default condition will always work on all computers to which the job is assigned. A default condition is like having no conditions.

In addition, if a task is associated with the default condition, the task always runs when a computer does not meet any other conditions associated with this job.

To set conditions for task sets

2. Click Setup next to the Condition field. A menu appears with options to create a new condition, or to modify, delete, or reorder a condition.
3. To reorder conditions, click Order and reorder them using up or down.
4. To create a new condition, click New in the menu. The Condition Settings dialog appears. Enter a name up to 64 characters.
5. Click Add to open the Condition dialog. Specify the following conditions and click OK:
   - From the Field drop-down list, select a data field heading. You can define conditions based on common client features such as operating system, software and hardware version, hard drive space, operating system language, RAM, and other characteristics.
     To set up custom conditions based on custom tokens, select User Defined Tokens from the Field drop-down list.
   - From the Operation drop-down list, select a compare statement.
   - In the Value box, type a string to search for in the selected database field. You can set conditions based on computer properties stored in fields in the Ghost Solution Suite Database. Example: You can set a condition to match a particular asset tag, Ghost Solution Suite agent version, or IP address. You can use wildcard characters and AND/OR operators.
To set up custom conditions based on custom tokens, select User Defined Tokens from the Field list.

The task set you create appears in the Task list for each condition. When you select a new condition, the tasks for that condition appear.

---

**Note:** When using User Defined Tokens to set conditions for some client property values, you may be required to use the decimal value instead of the hex value. Example: When setting conditions based on the NICS table on the nic_device_id and nic_vendor_id columns, you must use decimal values.

---

See "Deployment tasks" on page 161.

**Deployment tasks**

A task is an action of a job. Jobs are built with tasks. Each task runs according to its order in the task list contained in a job. You can resize the task pane by dragging the bottom pane (horizontal bar) that separates the task list and the scheduled computer list of the Ghost Solution Suite Console. This lets you view a greater number of tasks in a deployment job without using the scroll bar to navigate up and down.

**Task names in a mixed-language environment**

Ghost Solution Suite Server does not handle the code pages in a mixed-language environment well. If a Windows 32-bit Ghost Solution Suite Server Console is installed on a native single-byte OS (for example, English, Italian, and French) and viewed on a double-byte language, the task names show as a series of question marks.

When you view the task names on a native double-byte OS, they display correctly.

**Common Tasks**

The Add menu of the Ghost Solution Suite Console includes the following tasks:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Disk Image</td>
<td>Create a disk image from a reference computer and save the image file (GHO files) for later distribution. See “Creating a disk image” on page 165.</td>
</tr>
<tr>
<td>Distribute Disk Image</td>
<td>Distribute previously created disk images or create a disk image from a reference computer on the network and simultaneously distribute it (.IMG or .GHO) to other managed computers on the network. See “Distributing a disk image” on page 171.</td>
</tr>
<tr>
<td>Scripted OS Install</td>
<td>Run scripted (unattended) installs using answer files to install computers remotely over the network. See “Scripted OS install” on page 173.</td>
</tr>
<tr>
<td>Distribute Software</td>
<td>Distribute .MSI files, scripts, personality settings, and other package files to computers or groups. See “Distributing software” on page 183.</td>
</tr>
<tr>
<td>Capture Personality</td>
<td>Capture the personality settings of a selected computer on the network using the PC Transplant software. PC Transplant ships as a part of Ghost Solution Suite Server. See “Capturing personality settings” on page 186.</td>
</tr>
<tr>
<td>Distribute Personality</td>
<td>Send a Personality Package to computer or groups. This task identifies valid Ghost Solution Suite packages and assign passwords and command-line options to Personality Packages. See “Distributing personality settings” on page 187.</td>
</tr>
</tbody>
</table>
Table 5-1  Common tasks (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Configuration</td>
<td>Modify the IP address, computer and user name, domains and Active Directory organizational units, and other network information and computer properties. See “Modifying configuration” on page 190.</td>
</tr>
<tr>
<td>Back up Registry</td>
<td>Copy the registry files of selected computers and save the registry file settings to a selected directory.</td>
</tr>
<tr>
<td>Restore Registry</td>
<td>Copy the registry file settings to a managed computer.</td>
</tr>
<tr>
<td>Get Inventory</td>
<td>This lets you gather inventory information from client computers to ensure that the Ghost Solution Suite Database is updated with the latest computer properties.</td>
</tr>
<tr>
<td>Run Script</td>
<td>Create custom commands using scripts to perform jobs outside the bounds of the preconfigured tasks. Use the Run Script dialog to select or define a script file to run on specified computers or groups.</td>
</tr>
<tr>
<td>Copy File to</td>
<td>Copy a file from the eXpress Share or another source computer to a destination computer.</td>
</tr>
<tr>
<td>Power Control</td>
<td>Perform power control options to restart, shutdown, power off, and log off.</td>
</tr>
<tr>
<td>Wait</td>
<td>Use the Wait dialog to retain a computer in automation mode after a task is performed.</td>
</tr>
</tbody>
</table>

Supported Live Task Types

The following is the list of the live tasks supported for the x64, IA64, and SPARC platforms.

<table>
<thead>
<tr>
<th>Task</th>
<th>x64</th>
<th>IA64</th>
<th>SPARC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Computer</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Task</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----</td>
<td>----</td>
<td>-----</td>
</tr>
<tr>
<td>History</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Configure</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Quick Disk Image</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Wake Up</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Restart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Shutdown</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Log off</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Remote Control (Only 3rd Party)</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Execute</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Copy File</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Clear Computer Status</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Reset Connection</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Get Inventory</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Reject Connection</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Uninstall Windows Agent</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Install BIS Certificate</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Remove BIS Certificate</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Creating a disk image

This task creates an image of a computer's hard disk and partition. You can save the disk image as a .GHO file.

Create an image file by using the New Job Wizard or adding the task when building new jobs. You can distribute the disk image file using the Distribute a Disk Image task.

To create an image of a computer, you must boot to Linux, or WinPE. This requires that you set up a PXE Server or install an automation folder.

To create a disk image

1. In the Jobs pane of the Ghost Solution Suite Console, select a job.
2. In the Details pane, click Add and select Create Disk Image.
3. In the Create Disk Image dialog, select an imaging tool from the drop-down list. You can select from the following tools:
   - Symantec Ghost

The Symantec Ghost is the default imaging tool and creates a .GHO file. For information on creating a Ghost Image, See “Creating a Ghost image ” on page 167.
4 (optional) **Additional Parameters** are displayed when you select the Ghost tool for imaging. You can modify the **Additional Parameters** if required.

---

**Note:** Ensure to enter the additional parameters correctly, else the imaging task fails.

---

5 If you select the RapiDeploy tool for imaging, the **Advanced** option is displayed. See “Create disk image advanced” on page 168.

---

6 In the **Source Computer options (Ghost Only)**, select the **Drive number** and the **Partition number** of the source computer.

To create a disk image, select only the drive number. To create an image of a partition of a drive, select the drive number and the partition number.

---

**Note:** To know the correct partition number, use the Gdisk tool in the automation environment.

---

7 In the **Location to store image (path and filename)**, click **Select options** and enter the following:

- **Use Ghost Solution Suite Server share**
  - If you select this option, the image is stored at the Ghost Solution Suite Server share.

- **Use any Drive letter accessible in Automation pre-boot**
  - Specify the drive letter where you want to store the image.
  - **Note:** Ensure that the drive is accessible in automation pre-boot environment from the client computer.

- **Use Drive and Partition Number in Automation pre-boot (Ghost Only)**
  - Specify the drive Number and the Partition number. You can use this option only when Ghost imaging tool is used.

- **Specify the Image path**
  - Enter or browse the path where you want to store the image.
8 Check **Prepare using Sysprep –Configure**.

To configure the Sysprep settings, See “**Advanced Sysprep settings for creating a disk image**” on page 168.

---

**Note:** Windows 10 onwards, you must run the Sysprep with Administrator credentials. For more information refer to the Microsoft article.

---

9 Select the Automation pre-boot environment (Windows PE/Linux).

10 Set the Return codes and RIP and replace options. See Setting up return codes.

### Creating a Ghost image

Symantec Ghost Solution Suite provides operating system migration, software distribution, computer personality migration, hardware and software inventory, and secure system retirement.

You can create a Ghost Image using the **Create Disk Image** task.

**To create a Ghost image**

1 In the **Create Disk Image** dialog, select **Ghost Image (.gho)** from the **Imaging Tool** drop-down list.

2 Add additional parameters in the **Additional Parameters** field.

3 Enter the path and file name to store the disk image.

4 (Optional) To disable the validation of the image path, select the **Disable image path validation** check box. This is useful if the image is stored locally, or if you are retrieving the image from a remote server.

5 To use Microsoft Sysprep, select the **Prepare using Sysprep** check box and specify the operating system and product key.

6 From the **Automation pre-boot environment (WinPE/Linux)** drop-down list, select the required pre-boot environment to create the disk in the selected pre-boot environment.

   By default, the **Default Automation (Auto-select)** type is selected.

7 Click **Next**.

   The **Return Codes** dialog appears.
8 (Optional) Set Return Codes. See Setting up return codes.

9 Click Finish.

The task appears in the Task list for the job. The Ghost image is created when you run this task.

Advanced Sysprep settings for creating a disk image for Windows Vista and later versions

You can use the Sysprep advanced settings dialog to specify the settings for any Windows Vista or later Windows operating system version.

If you select the Operating System as Windows Vista or later, in the Sysprep settings on the Create Disk Image dialog. The Advanced Settings... option is enabled.

Click the Advanced Settings... option. The Sysprep advanced settings dialog appears. This dialog lets you select Plug-n-Play (PnP) drivers options, as well as Sysprep options, such as command-line options.

Advanced Sysprep settings for creating a disk image

You can use the Sysprep Advanced Settings dialog to specify Sysprep mass storage device support. By default, the Enable mass storage device support using built-in drivers (For Windows XP and 2003 only) option is selected.

**Disable mass storage device support.** When this option is selected, the Sysprep.inf file contains the section [Sysprep] with the key value pair as

BuildMassStorageSection = No

**Enable mass storage device support using built-in drivers.** When this option is selected, the Sysprep.inf file contains the section [Sysprep] with the key value pair as

BuildMassStorageSection = Yes

**Enable mass storage device support using following:** When this option is selected, the Sysprep.inf file contains the section [SysprepMassStorage] and is appended by contents of the file mentioned in the Mass storage section file field. You can also copy the drivers directory mentioned in the Mass storage drivers field.

**Command-line switches.** You can add command-line options.

Create disk image advanced

**Media Spanning**

The Maximum file size is set to 2GB.
Additional Options

Table 5-2  Additional Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Compressing an image is a trade-off between size and speed. Uncompressed images are faster to create, but use more disk space. Following options are available:</td>
</tr>
</tbody>
</table>
|               | ■ **Optimize for Speed**  
|               | Select this option to create a larger compressed image file with a faster imaging time. This is the default option. |
|               | ■ **Optimize for Size**  
|               | Select this option to compress the image to the smallest file size. |
|               | ■ **Balanced for Size and Speed**  
|               | ■ **None**  

**Note:** Configuration restoration after imaging a compressed drive is not supported for this release.

(Optional) Enter an image description to help identify the image and click **OK**.

For more information, refer to the following article:

TECH106775.html

Ghost Solution Suite Hot Imaging

The Ghost Solution Suite Hot Imaging lets you automatically refresh images from a live reference computer before deploying the image. This feature ensures that the deployed image is latest and reduces the risk of stale, out-of-date images.

Hot imaging does not require to boot a computer into the preboot environment before creating an image. Hot imaging uses the Snapshot technology for Windows desktop operating systems and is used to capture an image while Windows is running.

**Note:** Hot imaging does not support Windows Server class operating systems.

Tips for Hot imaging:
The Volume Shadow Copy service should not be in "disabled" state. If you are using any database software on the computer you want to take a hot image of, that database software must be stopped to prevent damage to the database file. If the database application is VSS Aware, the Volume Shadow Copy service shuts down the database for you. If the database application is not VSS aware, you must stop the database service before capturing an image.

Firewalls can block necessary communications.
See “System requirements for installing Ghost Solution Suite” on page 39.

To use Hot imaging
1 In the Ghost Solution Suite console, navigate to Jobs > Hot Imaging.
2 Use the appropriate sample jobs for creating an image:
   ■ Create X64 Image
   ■ Create X86 Image

Troubleshooting error 1959
While using Hot imaging, you may receive an error as follows:
■ Volume could not be locked
■ Cloning via Volume Snapshot has failed

Following is the workaround for the same:
If you are using ghost32.exe on the client computer:
1 Go to Start > Run.
2 Type cmd and click OK.
3 Navigate to C:\Program Files (x86)\Altiris\eXpress\Deployment Server.
4 Type ghost32.exe -forcevolumesnapshot and click Enter.
5 Configure Ghost Solution Suite to meet your needs.

If you are executing a Create Image task:
1 Find the failed task in your task list.
2 Right-click on the task and go to Properties.
3 Click Advanced.
4 Type –forcevolumesnapshot in the Additional option for the Ghost command line and click OK.
5 Click Save > Execute.
Distributing a disk image

Distribute a Ghost, RD_deploy, ImageX image file to managed computers to deploy a previously created disk image. Ghost Solution Suite supports hardware independent imaging through DeployAnywhere.

DeployAnywhere creates a hardware abstraction layer (HAL) and updates network drivers and storage drivers. It performs post-imaging functionality while you are still in automation mode.

You can use the following switches with DeployAnywhere:

- /logPath that specifies the fully qualified path where the DA log files are written.
- /logID that specifies the ID to prepend to the log file name.

Distribute a hard disk image using the **New Job Wizard** or adding the **Distribute Disk Image** task when building new jobs. You can create the disk image file using the **Create a Disk Image** task.

See “**New Job wizard**” on page 154.

See “**Building new jobs**” on page 158.

---

**Note:** If you deploy a Windows image over a Linux computer or a Linux image over a Windows computer, you must change the path of the Ghost Solution Suite Agent for the Windows log file.

---

**To distribute a disk image**

1. In the **Jobs** pane in the Ghost Solution Suite Console, select a job.
2. In the **Details** pane, click **Add** and select **Distribute Disk Image**.
3. In the task window, select the location of the image to be deployed. Click on the **Select options**.
4. (optional) **Additional Parameters** are displayed when you select the Ghost tool for imaging. You can modify the **Additional Parameters** if required.

**Note:** Ensure to enter the additional parameters correctly, else the imaging task fails.

5. If you select an image that is captured with RapiDeploy tool, the **Advanced** option is displayed. You can set **Resizing** and other settings such as the **Automation Folder** and **OEM Partition**.
6 If you select a Ghost image, the **Enable Partition Imaging (Ghost Only)** option is enabled. You can specify the partition number of the source image that you want to deploy on the target computer. Select the **Drive number** and the **Partition number** of the target computer.

7 Select **Prepared using Sysprep** if the image was captured using Sysprep. Click **Sysprep Settings** to open the **Sysprep Advanced Settings** dialog.

8 In the Data transfer mode, select if the image should be distributed using either of the following:
   - **GhostCast Server**
     Enter the **Session Name** that should be used.
   - **Multicast using Ghost**

9 Select **Automatically perform configuration task after completing this imaging task** to restart the computer and push the configuration settings to the imaged computer.

   **Note:** If you clear this option, a warning appears, confirming that you want to remove the configuration step after the image is deployed. As a result, the imaged computer may not reconnect to the network.

10 (Optional) Select the **DeployAnywhere** option if you want to do hardware independent imaging.

   (Optional) Click **Advanced** and browse to the **Windows Directory** and set additional parameters.

11 (Optional) Select the **Boot to production** to complete configuration task.

12 From the **Automation pre-boot environment (WinPE/ Linux)** drop-down list, select the required pre-boot environment to perform the **Distribute Disk Image** task. By default, the Default Automation (Auto-select) type is selected.

13 Click **Next**.

14 (Optional) Set Return Codes. See “**Setting up return codes**” on page 204.

15 Click **Finish**. The task appears in the **Task list** for the job. The disk image is distributed when you run this task.

See “**Deployment tasks**” on page 161.
Scripted OS install

The **Scripted OS Install** task performs remote, automated, and unattended operating system installations over the network using answer files to input configuration and installation-specific values. Scripted installs let you deploy server and client computers across the network from installation files and perform post-installation configuration tasks. You can run scripted installs for Windows or Linux computers.

---

**Note:** Scripted Install requires either an automation boot disk or a PXE Server. Using embedded automation causes the selected image (Linux, WinPE) to load and halt. It does not let the scripted install run.

When running a **Scripted OS Install** task, you can identify the type of operating system to install for supported languages, run the scripted install, and update with service pack installations. This task provides easy-to-use features to create an answer file for each scripted installation.

Scripted installs are flexible in performing post-configuring tasks, but much slower and bandwidth-intensive. Complete server installation and configuration tasks benefit most from scripted installs.

**Windows**

Use complete unattended install features to copy Windows operating system source files quickly to the eXpress Share and easily create an answer file. Configured operating system install sets can be reused to build and run scripted install jobs as needed.


**Linux**

Run scripted install jobs to remotely install different versions of Linux. You can customize sample scripted install jobs installed with the Ghost Solution Suite Server system and create a kickstart answer file to remotely run a scripted install.

See “Scripted install for Linux” on page 182.
Scripted install for Windows XP, Windows Server 2003 and earlier

To install Windows

1. After selecting Add > Scripted OS Install, select the Windows option and click Next.

2. Select the type of Windows operating system to install and the preferred language. See Select OS version and language. Select the required pre-boot environment from the Automation - PXE or BootWorks environments (WinPE/Linux) Automation pre-boot environment (WinPE/Linux) drop-down list to perform the Distribute Disk Image task in the selected pre-boot environment. The option reported by the PXE Manager is the default pre-boot environment option. By default, the Default Automation (Auto-select) type is selected. Click Next.
3 From the **Select or add new OS source files** drop-down list, select the operating system source files already copied to your eXpress Share.

See “Installation source files” on page 177.

Click **Add New** from the list to set up the new operating system installation files.

See “Operating system-source files” on page 177.

Click **OK** after entering a unique name and the path to the operating system installation source files. The source files will be copied to the Deploy folder in the eXpress Share directory. The first source files added are given a generic name of WinOS001, with additional operating system source folders named as WinOS002, WinOS003 and so on. Service Pack source files are also stored as WinSP00x.img files.

This process could take a few minutes. Because the installation source files are copied over to the eXpress Share, when running subsequent scripted installs you do not need to add new source files for this version of Windows. They can be selected from the list of installation source files.

See "Installation source files" on page 177.

---

**Note:** When importing Scripted Install jobs, you must edit the job files to point to the installation source files on the new Ghost Solution Suite Server system. This requires you to run the Scripted Install for Windows wizard and modify the path and name of the folder for the Installation Source Files for the exported jobs. This is required for both the main installation and the service pack installation file.

---

Scripted install for Windows XP, Windows Server 2003 and earlier

See “Installation source files” on page 177.

See “Importing and exporting jobs” on page 203.

4 After the source files are copied, select the newly created operating system source name from the **Installation Source Files** list. Click **Next**.

5 In the **Partition and Format Disk** page, click **Advanced** to set partition size, delete hidden partitions or set RapiDeploy command-line parameters. Click **Next**.

See “Operating system-source files” on page 177.

6 Import an answer file to the Ghost Solution Suite Database. Click **Next**.

See “Import an answer file” on page 178.
7 Create the Answer file. Click **Next**.
   See “Answer file setup ” on page 178.
8 Set command-line options for cmdlines.txt files and for the WINNT installation program. Click **Next**.
   See “Command-line switches for scripted install ” on page 180.
9 View and modify the Ghost Solution Suite for Windows configuration file from the dialog. Click **Next**.
   See “Ghost Solution Suite agent settings for scripted install ” on page 181.
10 View the summary of the selected options. Click **Next**.
   See “Scripted install summary” on page 181.
11 Set up return codes for the Scripted Install task. Click **Finish**. The task appears in the Task list for the job.
   See “Setting up return codes ” on page 204.

See “Scripted OS install” on page 173.

**Select OS version and language**

Identify the operating system version to run in a scripted install. The selected version and language must correspond to your Windows installation files.

We support multiple languages for the following Ghost Solution Suite utilities:

- Boot Disk Creator
- Image Explorer
- PXE Configuration Utility
- Remote Client Installer
- Control Panel Applet
- DS Info
- PW Util (Password utility)
- Switch Management

**Select the operating system version**

Select the Windows operating system you want to install from the list. Click Template if you want to install another version or language of a Windows operating system not provided in the list.
Select the operating system language

Select the language version of the operating system to install. The language must correspond to the operating system source files. If you selected the Template option, only the Multilingual language option can be selected (this is a generic language option).

Automation (Pre-boot Environment)

Select the required pre-boot environment from the Automation (Pre-boot Environment) drop-down list. The option reported by the PXE Manager is the default pre-boot environment option.

Installation source files

If you copied installation files to the eXpress Share for previous scripted installs, the name of this install source configuration appears in the list box for each operating system type and language. To create new source configuration sets for additional operating system installs, select Add new from the drop-down list.

Select or add new operating system source files

Select the assigned name for each operating system source configuration in the list, or select Add new from the list to create a new install task. Previous scripted install jobs will create a WinOS00x.img file in the Deploy directory of the eXpress Share.

Operating System-Source Files

The Operating System-Source Files dialog lets you identify the version of Windows install files and enter the path to the files (on the CD or other medium).

Select or add new service pack source files

Run service pack updates immediately after installing the operating system during the scripted install process. Previous scripted install jobs will create a WinSP00x.img file.

Operating system-source files

Name the operating system source configuration, specify the path, and automatically copy Windows installation files to the eXpress Share.
Enter a unique name for the operating system source files

Enter a name for the operating system source configuration files to assign an alias to associate with the install files for a specific operating system version and language.

The Windows operating system identified previously in the Installation Source Files dialog must match the source files selected here. If the name and language of the operating system does not match the installation files, you receive an error.

Click OK and the files will copy from the source CD (or other volume) to the Ghost Solution Suite Server\Deploy directory in the eXpress Share. This process will take a few minutes.


Import an answer file

Reference a previously created answer file for a Windows scripted install. You can also view a summary of the operating system source configuration.

Import existing unattend.txt

Select to import a previously created answer file to the Ghost Solution Suite Database. The values for the answer file are imported from the delimited text file and appear in the Answer File Setup dialog.

Path of the unattend.txt

Enter a path and select an answer file with any name. The answer file is imported to the database, edited in the console (if required), and distributed as an unattend.txt file to the client computer.

See Scripted install for Windows XP, Windows Server 2003 and earlier

Answer file setup

Use the tabs in this dialog to enter values to create an answer file for a scripted install. These values are stored in the Ghost Solution Suite Database. An answer file is generated from the database (unattend.txt) and distributed to each managed computer when the job runs.

In the Answer File Setup dialog, select a value (a row) in the table. A list appears in the Values column to change values for each entry. You can add new variables to each section by selecting the bottom row named Add new Variable. To add a new section to the answer file, click the right arrow until the Add new Section tab appears (the last tab on the right).
The required answer file values are selected automatically in the dialog with a gray check mark (you cannot clear these variables). Optional but selected values have a green check mark. Other optional values are cleared. Select these optional values if you want to add them to the answer file when it is generated.

The various tabs in the Answer File Setup dialog correspond to the general answer file sections. See the Microsoft Windows Unattended Setup Guide for specific values for an unattended setup file.


Add a new section

Use this dialog to add new variable sections to the answer file.

- **Use this dialog to add new variable sections to the answer file**: If you add a section, this name appears in the new tab in the Answer File setup dialog. Enter a description. Enter comments to describe the new section.

  - **Enter a description**: Enter comments to describe the new section.

See the Microsoft Windows Unattended Setup Guide for your specific operating system values for an unattended setup file.


Delete a section

To delete a new section that you added, right-click the section and select **Delete selected Section**.

Add a new variable

Use the **New Variable for Section "Unattended"** dialog to add new variables to the answer file. This variable appears as a row in the Answer File Setup dialog.

**Table 5-3 Add a new variable**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the variable</td>
<td>Select a variable name</td>
</tr>
<tr>
<td>Type of the new variable</td>
<td>Select a variable data type. The <strong>Default value of the variable</strong> and <strong>Displayed value of the variable</strong> fields are enabled depending on the variable type selected.</td>
</tr>
</tbody>
</table>
Table 5-3  Add a new variable (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value of the variable</td>
<td>Enter values for a list, text, password, IP address, or variable only types.</td>
</tr>
<tr>
<td>Displayed value of the variable</td>
<td>Enter an alias for list item types to appear instead of the real variable value.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter comments to describe the new variable. It appears in the Description column of the Answer File Setup dialog.</td>
</tr>
</tbody>
</table>


Command-line switches for scripted install

Use the **Scripted OS install commands** dialog to enter Windows commands that are executed from the cmdlines.txt file. You can also add scripted install command-line options.

Table 5-4  Command-line switches for scripted install

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switches</td>
<td>Add or edit switch commands to this line for the install program for the scripted install.</td>
</tr>
<tr>
<td><strong>Additional commands in the cmdlines.txt file</strong></td>
<td>Enter additional Windows scripted install commands in this dialog. The commands execute in the order they are listed. The provided command installs the Ghost Solution Suite for Windows during the Install Component phase of the installation. You can view and edit Ghost Solution Suite settings in the next dialog. Enter additional Windows scripted install commands in this dialog. The commands execute in the order they are listed. The provided command installs the Ghost Solution Suite for Windows during the Install Component phase of the installation. You can view and edit Ghost Solution Suite settings in the next dialog.</td>
</tr>
</tbody>
</table>

Ghost Solution Suite agent settings for scripted install

View or edit Ghost Solution Suite for Windows settings in this dialog. You can change agent settings using this text-edit dialog.

For a list of the Ghost Solution Suite agent properties, See “Ghost Solution Suite Agent settings” on page 117.


Scripted install summary

View a summary of the selected options for the scripted install. Click Back to change any of these settings or click Finish to complete the Scripted Install task. Click Next to set up return codes.

See “Setting up return codes” on page 204.


Scripted install for Windows Vista, Windows Server 2008, and later

The Scripted OS install for Windows Vista, Windows Server 2008 Server or later provides a wizard to help set up Vista, Windows Server 2008 and later installation files and run sample jobs. Follow the steps in the wizard to identify the type of scripted install as Vista, Windows 2008 Server or later. You can gather all the files for Vista or Windows 2008 Server for the job, but the server does not build any answer file. Instead, you are asked for the location of the answer file. Also, a sample answer file is provided.

To perform a scripted install for Windows Vista and 2008 server

1. On the Scripted Operating System Installation page of the Scripted OS Install dialog, select the following options:
   - The operating system
   - Operating system language
   - Automation pre-boot environment

   Note: Ghost Solution Suite supports only WinPE environments.

2. Click Next.
3 From the **Select or add new OS source files** drop-down list on the **Installation Source Files** page of the **Scripted OS Install** dialog, select the operating system.

Browse to the root directory of the ISO files of the OS that you are installing.

4 (Optional) You can select the required option from the **Select or add new service pack source files** drop-down list. Click **Next**.

5 Select the **Select a Diskpart tool** option on the **Partition and Format Disk** page of the **Scripted OS Install** dialog to partition and format the disk. Click **Next**.

---

**Note:** You can select the **Continue without selecting Diskpart Tool** option to partition and format the hard disk using your own scripts and setup utilities.

6 On the **Scripted Operating System Installation** page of the **Scripted OS Install** dialog, browse to select the path of the unattended .XML file.

7 On the **Scripted OS Install Commands** page of the **Scripted OS Install** dialog, set the command-line options for the cmdlines.txt files and enter the Additional commands in the cmdlines.txt file. (See Command-line switches for scripted install.) Click **Finish**.

---

**Note:** If you want to use the sample answer files (Vista_unattend.xml and Longhorn_unattend.xml) provided by default in the Deploy folder of the eXpress Share, you must enter the product key (for the version you want to install) before you schedule the job. If you do not select the product key, the job fails.

See “OS product key dialog” on page 84.

---

### Scripted install for Linux

The Scripted OS install for Linux provides a wizard to help set up Linux installation files and run Sample jobs. Follow steps in the wizard to identify the type of scripted install and locate the answer files. You can also modify and run Sample deployment jobs to remotely run a scripted install on Linux servers and workstations.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory</td>
<td>Browse to or enter the path and name of the Linux answer file (Kickstart file).</td>
</tr>
</tbody>
</table>
Table 5-5 (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command-line</td>
<td>Enter the command-line options.</td>
</tr>
<tr>
<td>Automation pre-boot environment (WinPE/Linux)</td>
<td>Select the required pre-boot environment from the drop-down list to perform the Backup and Restore task in the selected pre-boot environment. By default, the Default Automation (Auto-select) type is selected.</td>
</tr>
</tbody>
</table>

Scripted install summary

View a summary of the selected options for the scripted install. Click Back to change any of these settings or click Finish to complete the Scripted Install task.

Distributing software

Send .MSI Packages, .CAB, .EXE, and other package files to selected computers or computer groups, including EBS, and .RPM files for Linux computers. This task identifies valid Ghost Solution Suite packages and assigns passwords and command-line options.

Distribute software packages to managed computers using the New Job Wizard or adding the Distribute Software task when building new jobs.

See “New Job wizard” on page 154.

See “Building new jobs” on page 158.

To distribute software

1. Enter the name and location of the package to distribute in the Name field.

   **Note:** Information about the package appears in the Description field for valid packages. If no description appears, the file is not a Personality Package.

2. Select Run in quiet mode to install the package without requiring user interaction.
If distributing an install package or other types of packages with associated support files, you can select **Copy all directory files** to install all peer files in the directory. Select **Copy subdirectories** to distribute peer files in the directory and all files in associated subdirectories.

**Note:** Some clients may have software installed on the client computer that, for protection against harmful software, only lets software programs on a list of "well-known" executables to run. Therefore, whenever the system administrator wanted to install a patch on client computers, he or she would have to update the well-known-executables list on all the client computers, which could be a lot of work.

To save the work of updating that list, or of manually renaming distribution packages, the RenameDistPkg feature was added. Now, the system administrator may update the well-known-executable list once with a filename of their choice. The well-known filename may be entered into the Windows registry of the Ghost Solution Suite Server computer (the computer running axengine.exe) as the Value data of a string value named RenameDistPkg under the HKEY_LOCAL_MACHINE\SOFTWARE\Altiris\Altiris xPress\Options key. If the RenameDistPkg registry entry is set, Ghost Solution Suite Server renames the installation files that are copied to the client computers.

This feature only affects files that are temporarily copied to the client computer as part of a Distribute Software task. The file that is to be executed only during the installation, sometimes referred to as the package, is the file that is renamed, not the files that are actually installed to various locations on the target computer.

If the **Copy all directory files** option is enabled, only the main (installable) file is renamed.

4 Click **Advanced** to specify how files are distributed to the managed computer. You can copy through the Ghost Solution Suite Server, or copy directly from the file source and then run, or run directly from the file source. See Distribute software advanced. Click **Next**.

5 Provide additional command-line options for distributing software.

6 (Optional) Set Return Codes.

   See “**Setting up return codes**” on page 204.

7 Click **Finish**. The task appears in the Task list for the job. The software is distributed when you run this task.

If the Personality Package is configured to run only if a particular user is logged in and only if the user has an account on the managed computer, the package runs
the next time that user logs in. If the user does not have an account, the package aborts and sends an error back to the console through the Ghost Solution Suite. If the package is not run through the Ghost Solution Suite Server, a message appears on the managed computer and the user is prompted to abort or continue.

See “Modifying tasks in a deployment job” on page 199.

Distribute software advanced

Following are the fields and the description of the Distribute software > Advanced:

<table>
<thead>
<tr>
<th>Table 5-6</th>
<th>Distribute software advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Copy files using Ghost Solution Suite Server then execute</td>
<td>Select this option to distribute packages through the Ghost Solution Suite Server to the managed computer, requiring two file copy transactions if the eXpress Share is on another file server. This option is run for Simple installs and is the default option.</td>
</tr>
<tr>
<td>Copy directly from file source then execute.</td>
<td>Select this option to copy packages directly from the eXpress Share if this data store is located on another server (a Custom install). It copies the file and runs it, avoiding running through the Ghost Solution Suite Server and reducing processor output.</td>
</tr>
<tr>
<td>Run directly from file source</td>
<td>Select this option to run files remotely from the eXpress Share or another selected file server.</td>
</tr>
<tr>
<td>Specify user</td>
<td>Enter the user name and password for the client computer and the eXpress Share. Both must have the same user name and password (this is not an issue if both are on the same domain).</td>
</tr>
<tr>
<td>Run script in console user session</td>
<td>For Windows 2008, Vista, and Windows 7, you can see the output of jobs on a local desktop and use that output for debugging purposes. The script runs in a logged-in user's UI session. If no users are logged in, the job fails. DAgent can also run scripts in a console user session.</td>
</tr>
</tbody>
</table>
Capturing personality settings

The Capture Personality task lets you save personal display and user interface settings defined in the operating system for each user. You can create a Personality Package that you can save and distribute when migrating users. This task runs Symantec PC Transplant from the console to capture and distribute settings.

Capture personality settings using the New Job Wizard or adding the Capturing Personality task when building new jobs.

See “New Job wizard” on page 154.

See “Building new jobs” on page 158.

To capture a personality

1. After creating a job, click Add > Capture Personality.

2. Enter the name of a personality template file, or browse and select a template. A default personality template is included in the PCT folder of the eXpress Share (DEFAULT.PBT). Enter the name of the folder where you want to store the package.

   The personality template lets you define the settings, files, and options to be captured during run time. Click Template Builder to open a wizard to build a custom template.

3. In User account and folder login, enter the login credentials for the managed computer from which the personality settings are captured, and the file server where the Personality Package is stored.

4. In Package login, enter a password for the Personality Package. This is a run-time password that is required when the Personality Package runs on the destination computer.

5. Click Advanced to specify additional features.

6. Set the Advanced options and click OK. Click Next. See “Capture personality advanced options” on page 187.
7 (Optional) Set Return Codes.
See “Setting up return codes” on page 204.

8 Click Finish. You have now created a Capture Personality task, which appears in the Task list. You must schedule this task to capture a personality setting and save it as a PCT file in the selected location (most often in the PCT folder on the Ghost Solution Suite Server shared directory on the eXpress Share).
See “Distributing personality settings” on page 187.

Note: Set the conditions on the job for either Windows 98 or Windows 2000, XP, 2003, 2008 and Vista computers to ensure that the appropriate Capture Personality task runs on the appropriate computers.

Capture personality advanced options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain users</td>
<td>Select this option to capture personality settings for all domain users on the computer.</td>
</tr>
<tr>
<td>Local Users</td>
<td>Select this option to capture personality settings for all local users on the computer.</td>
</tr>
<tr>
<td>Custom</td>
<td>Specify users or groups to capture personality settings. Select the Custom check box and enter the Users or Groups you want to capture personality settings. Also, instead of specifying names, you can also select users who have been either created or accessed in the specified number of days.</td>
</tr>
<tr>
<td>Additional command-line switches</td>
<td>You can add command-line options specifically for the PC Transplant program that migrates personality settings. See the Symantec PC Transplant Reference Guide in the docs folder of the eXpress Share.</td>
</tr>
</tbody>
</table>

Distributing personality settings

The Distribute Personality task lets you save personal display and user interface settings defined in the operating system for each user. You can distribute Personality
Packages to migrate personality settings. This task runs Symantec PC Transplant from the console to capture and distribute settings.

Distribute personality settings using the New Job Wizard or adding the **Distribute Personality** task when building new jobs. For more information about capturing personality settings to create a Personality Package, refer to the following section:

See “Capturing personality settings ” on page ?.

See “New Job wizard” on page 154.

See “Building new jobs ” on page 158.

**To distribute personality settings**

1 In the **Name** field, enter the file name and location of the PCT file.

---

**Note:** The information about the Personality Package appears in the **Description** field for valid Personality Packages (PCT files). If no description appears, the file is not a valid package.

If you use a token, such as %COMPNAME%, in this field, and you proceed with the job, when you apply the job to a Windows XP computer, the user must enter input before the job completes. Symantec recommends you enter a valid Personality Package name and use the **Additional command-line switches** fields for token values. See the Symantec PC Transplant Reference Guide for a complete list of valid command-line options.

2 In the **Password** field, type the password set for the PCT file when created.

3 Select **Run in quiet mode** to install the package without displaying the PC Transplant screens.

4 Specify the users to associate with the Personality Package.

   - Select **Apply to all users** to run the package for all users with accounts on the specified computer.

   - If you want to send the package to a managed computer with multiple users and to install it for certain users with a unique password, clear the **Apply to all users box**.

   Example: To install a Personality Package for specific user accounts on a computer, add values to the **Additional command-line switches** field.

   Example:

   `-user: J Doe; TMaya; BLee`
Note: The command-line options are specifically for Personality Packages. For a complete list of command-line options, see the Symantec PC Transplant Reference Guide.

5 (Optional) Click Advanced to specify how to copy Personality Packages to the managed computer. You can copy through Ghost Solution Suite Server and then run, or copy directly from the file source and then run, or run directly from the file source. See Distribute personality advanced. Click OK.

6 Click Next.

7 (Optional) Set Return Codes.

See “Setting up return codes” on page 204.

8 Click Finish. The task appears in the Task list for the job. The personality is distributed when you run this task.

For more information about capturing a computer’s personality settings, see the Symantec PC Transplant Help.

See “Modifying tasks in a deployment job” on page 199.

Distribute personality advanced

Table 5-8 Distribute personality advanced

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy files using Ghost Solution Suite Server then execute</strong></td>
<td>Select this option to distribute software packages through the Ghost Solution Suite Server to the managed computer, requiring two file copy transactions if the eXpress Share is on another file server. Use this option for Simple Installs to take advantage of security rights defined by Ghost Solution Suite Server. This is the default option.</td>
</tr>
</tbody>
</table>
Table 5-8  Distribute personality advanced (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy directly from file source then execute</td>
<td>Select this option to copy packages directly from the eXpress Share, sending only one copy across the network. It copies the file and runs it and avoids running through the Ghost Solution Suite Server and diminishing processor output. Because the Ghost Solution Suite doesn't recognize shared rights and is not guaranteed to have a mapped drive to the data source, you must identify a user name and password for the data share computer from the target computer. This option also requires a full UNC path name in the Source Path field in the Copy File dialog.</td>
</tr>
<tr>
<td>Execute directly from file source</td>
<td>Select this option to run files remotely from the eXpress Share or another selected file server.</td>
</tr>
<tr>
<td>File source access and credentials</td>
<td>Enter the user name and password for the client computer and the eXpress Share. Both must have the same user name and password (this is not an issue if both exist in the same domain).</td>
</tr>
</tbody>
</table>

Modifying configuration

You can add a task to configure or modify the configuration of computer property settings using the Modify Configuration dialog. The Ghost Solution Suite updates the property settings and restarts the computer for changes to take effect.

To modify configuration

1. After creating a job, double-click the job, and click Add > Modify Configuration.

2. Select the Reboot after Configuration check box to restart client computer after the configuration changes are complete. By default, the check box for Reboot after Configuration is selected.

3. Enter or edit the property settings in the Configuration dialog. Click the category icons in the left pane to set additional values for each property setting group.

   See “Computer configuration properties” on page 104.

4. Click Next.
5  (Optional) Set Return Codes.

See “Setting up return codes ” on page 204.

6  Click Finish. The task appears in the Task list for the job. The configuration is modified when you run this task.

See “Modifying tasks in a deployment job” on page 199.

Getting inventory

Use this task to gather inventory from an individual computer or a group of client computers. This ensures that the Ghost Solution Suite Database is updated with the latest computer properties information, which includes the following information:

- Applications
- Devices
- Drivers
- Hardware
- Location
- Network
- Services
- TCP-IP
- General

Location is the only area that administrators can manually enter if they want to. The Ghost Solution Suite software gathers the other information from each computer.

You can view the history of the Get Inventory task in the Computers History pane.

See “Viewing computer details” on page 98.

- Click Add and select Get Inventory from the list. The Get Inventory task appears in the list.

Running a script

Select an existing script or write a new script file to run on selected managed client computers.

Run script files on client computers by adding the New Script task when building new jobs. See Script information to identify how the script appears, script security, and an option for server-side execution of the script.
To run a script

1. If you have a script file defined, select Run Script and browse to select the file. To read or edit the script file, click Modify.

   **Note:** To run scripts that call an executable, use the start command.

   Example: Enter start C:\windows\notepad.exe to open the Notepad application on the client computer.

2. To create a new script, click Run Script. Enter the script in the provided field, or click Import and select a script file to import. After you import the script, you can modify it in the provided field.

3. Specify the operating system to run the script. You can choose Windows, Linux, or Mac OS X. Click **Next**.

4. Set Script Information. See Script information. Click **Next**.

   See “Script information” on page 192.

5. (Optional) Set Return Codes.

   See “Setting up return codes” on page 204.

6. Click Finish. The task appears in the Task list for the job. The script runs when you run this task.

**Note:** The Ghost Solution Suite Server assumes a return code of zero (0) as a successful script execution. Some programs return a code of one (1) to denote a successful script execution. If a program returns a one (1), you see an error message at the Ghost Solution Suite Console even though the script ran correctly. To modify the return codes, you can edit the script file to return a code that the console interprets correctly.

See “Modifying tasks in a deployment job” on page 199.

### Script information

**Script Run Location**
### Table 5-9  Script information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On the client computer</strong></td>
<td>This option runs the script on the managed computer to which you assign the job</td>
</tr>
<tr>
<td><strong>Locally on the Ghost Solution Suite Server</strong></td>
<td>This option runs a server-side script on the Ghost Solution Suite Server of the managed computer. In most cases you can create a server-side script task that runs in context with other tasks. Example: You can add a task to image a computer and add a task to execute a server-side script to post the imaging return codes to a log file stored on the Ghost Solution Suite Server computer. Use the -id option for running scripts on Ghost Solution Suite Server when using the WLogEvent and LogEvent utilities. See “Using LogEvent and WLogEvent in scripts” on page 195. <strong>Note:</strong> You cannot use this feature to run scripts that require user intervention. The script runs on the Ghost Solution Suite Server of the managed computer, but is not visible. When running the script on the Ghost Solution Suite Server, it runs specifically for the assigned managed computer. Example: If you create a job with a script to run locally on the Ghost Solution Suite Server and assign the job to 500 computers, the script runs on the Ghost Solution Suite Server 500 times.</td>
</tr>
</tbody>
</table>

### Client run environment

Select the environment for your client computer. You can run the script either in production mode or in automation mode.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Production - Client-installed OS** | (Windows/Linux/Mac OS X)  
Security Context  
- Default  
  (local system account). Use the network security account established to administrate all managed computers.  
- Specific user.  
  If you have selected to run the task on the local Ghost Solution Suite Server, enter an administrator user name and password for that Ghost Solution Suite Server account. In most cases Ghost Solution Suite Server does not have the Ghost Solution Suite installed, which prohibits it from using a network security account.  
- Run script in console user session  
  For Windows 2008 and Vista, you can see the output of jobs on a local desktop and use that output for debugging purposes. The script runs in a logged-in user's UI session. If no users are logged in, the job fails.  
- Scripts run in an elevated mode, which skips the usual consent step through a user access control (UAC). Otherwise, someone must physically go to the remote computer and approve the action to allow the script to run.  
Script Window  
From the drop-down list, select how you want the script window to appear: minimized, normal, maximized, or hidden.  
**Note:** This option is available only for Windows environment. |

---

**Script Options - (Windows/Linux/Mac OS X)**
Table 5-11  Script Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional command-line switches</td>
<td>Additional command-line switches. Enter commands to execute when the script runs in Windows, Linux, or Mac OS X.</td>
</tr>
<tr>
<td>Automation pre-boot environment (WinPE/Linux/Mac OS X).</td>
<td>Select this option to run the script in an automation environment. Select a pre-boot automation environment from the drop-down list.</td>
</tr>
</tbody>
</table>

If you select Linux as the operating system type, the **Locally on the Ghost Solution Suite Server** option is disabled and only the **Additional command-line switches** under the **Production Client installed OS (Windows/Linux/Mac OS X)** is enabled.

**Example script**

The process to convert NT4 from FAT16 to NTFS normally returns a 1 after a successful completion. The following is an example of the file that is modified to return a code of 0 (which is the success code recognized by the Symantec Management Console and utilities). You can make similar changes to your script files as needed.

```plaintext
CONVERT /FS:NTFS
if ERRORLEVEL 1 goto success
goto failure
:success set ERRORLEVEL = 0
goto end
:failure
echo Failed
set ERRORLEVEL = 1
goto end
:end
```

**Using LogEvent and WLogEvent in scripts**

The logging features, LogEvent and WLogEvent, accommodate detailed logging to help debug complex scripts. These utilities include the following features:

- Logging is stored in the database instead of a log file.
The console displays and works with the new status messages.

LogEvent posts status sends messages to the Ghost Solution Suite Console, letting you view the status of the script. It is a light-weight reporting tool that can log both status strings and status codes to the history file and the console.

**LogEvent** - Use the LogEvent utility for Linux scripts.

**WLogEvent** - Use the WLogEvent utility for Windows scripts.

The LogEvent and WLogEvent utilities are command-line driven only - there is no user interface. Use both utilities with the following switches.

`LOGEVENT -c:code -id:%ID% -l:level -ss:"message"`

- **code** is any number for a return code level.
- **id** is used for server-side scripting only. For server-side scripts you must add the `-id:%ID%` switch.

See the **Locally on the Ghost Solution Suite Server** option in Script Information to select a server-side script. See “Script information” on page 192. level is the severity level. The following levels are used:

- **1 = Information message**
- **2 = Warning message**
- **3 = Critical failure message. Only this level can be used to set up a return code.**
  
  See “Setting up return codes” on page 204. The response does not execute for a return code unless a level 3 is specified when using the LogEvent and WLogEvent command in a script.

**message** is the status string. If spaces exist in the message, the string must be contained in quotes. Specifying a severity level of 3 causes the script job to fail.

### Copying a file

Copy all types of files to managed computers. You can send selected files or directories to a computer or computer group.

Send files to client computers by adding the Copy File to task when building new jobs. Use the Copy File to operation (see Remote operations using Ghost Solution Suite ) to copy files quickly from Computers pane in the console.

See “Building new jobs” on page 158.
To copy a file

1. Select either the **Copy File** or **Copy Directory** option. When you select the Copy Directory option, select Copy Subdirectories to copy all subdirectories.

2. Enter the directory path and name of the file or directory. The Source path defaults to the eXpress Share, but you can enter or browse to a file or directory.

   To copy files or directories through the Ghost Solution Suite Server from the eXpress Share, you can enter a relative path in this field. To copy files or directories directly from the eXpress Share to the managed computer, you must enter the full UNC path name.

   See “Copy file to advanced” on page 198.

---

**Note:** When entering the source path for copying files through the Ghost Solution Suite Server, you can only access the shared directories through an established user account. Specifically, you can only use UNC paths when you have sufficient authentication rights established.

3. Select the **Allow to run in automation** check box to run this task in automation mode.

   **Note:** This option is only applicable for Linux and WinPE automation.

4. Type the destination path. The **Destination path** field automatically enters a sample path, but you can enter the directory path you require. If the destination path does not exist on the destination computer, it is created.

5. Click **Advanced** to specify additional features to copy files through the Ghost Solution Suite Server or directly from a file server. Click **Next**.

6. (Optional) Set **Return Codes**.

   See “Setting up return codes” on page 204.

7. Click **Finish**. The task appears in the Task list for the job. The file is sent to the specified location when you run this task.

   See “Modifying tasks in a deployment job” on page 199.

---

**Using location variables**

Location variables are being added to the Ghost Solution Suite Server for the Copy Files feature, letting you enter a token variable instead of requiring a complete location path when copying files to a managed computer (a client computer running the Ghost Solution Suite).
Ghost Solution Suite supports long names in the REM replacetoken command. If your file name includes spaces, enclose the file name in quotes so that it handles correctly.

The current variables include:

**Temp.** Enter Temp in the Destination path to set the Temp directory (identified in the system path) for the managed computer. Example: Instead of entering C:\windows\temp\setup.exe in the Destination path, enter temp:setup.exe.

### Copy file to advanced

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy files using Ghost Solution Suite Server</strong></td>
<td>This option distributes software packages through the Ghost Solution Suite Server to the managed computer, requiring two file copy transactions if the eXpress Share is on another file server. Use this option for Simple installs to take advantage of security rights defined by the Ghost Solution Suite Server. You can use a relative path name entered in the <strong>Source Path</strong> field in the <strong>Copy Files</strong> dialog. This is the default option.</td>
</tr>
<tr>
<td><strong>Copy directly from file source</strong></td>
<td>Click this option to copy packages directly from the eXpress Share, sending only one copy across the network. It copies the file directly to avoid running through the Ghost Solution Suite Server and diminishes processor output. Because the Ghost Solution Suite Agent doesn't recognize shared rights and is not guaranteed to have a mapped drive to the data source, you need to identify a user name and password for the data share computer from the target computer. This option also requires a full UNC path name in the <strong>Source Path</strong> field in the <strong>Copy File</strong> dialog.</td>
</tr>
<tr>
<td><strong>File Source logon</strong></td>
<td>Enter the user name and password for the client computer and the eXpress Share. Both must have the same user name and password (this is not an issue if both exist in the same domain).</td>
</tr>
</tbody>
</table>
Power control

Start the computer using Wake on LAN or run standard power control options to restart the computer, shut down, or log off the current user.

Wake up, shut down, or log off client computers by adding the **Power Control** task when building new jobs. See “Building new jobs” on page 158.

**To manage power control**

1. Create a job.
2. Click **Add > Power Control**.
3. Select an option: **Restart**, **Shut down (if available)**, **Log off**, or **Wake up (send Wake-On-LAN)**.
4. Select **Force application to close without a message**, if required. Click **Next**.
5. (Optional) Set Return Codes.
   - See “Setting up return codes” on page 204.
6. Click **Finish**. The task appears in the Task list for the job.

Waiting

Use the Wait task to boot a computer in the automation mode and wait for user interaction.

**To use the Wait task**

1. Create a job.
2. Click **Add > Wait**.
   - The **Wait** dialog appears.
3. Select the appropriate pre-boot environment from the drop-down list. Click **Next**.
4. (Optional) Set Return Codes.
   - See “Setting up return codes” on page 204.
5. Click **Finish**. The task appears in the Task list for the job.

Modifying tasks in a deployment job

You can build jobs by adding or modifying deployment tasks. You can modify the tasks in a job that is already scheduled on any computer. The job will run the modified tasks according to the previously set schedule.
If the task (image, batch file, executable, and so on) is saved in the product directory, it appears on your Resources list in the Shortcuts pane. Simply drag it to an existing job to add it.

To add a task to a job immediately

1. In the Jobs pane, double-click the job you want to modify.
2. Click Add and select another task from the menu.
3. Follow the basic instructions on each dialog provided for each task. Select the type of task you want to add and follow the directions.
4. After finishing task configuration, a new task appears in the Jobs list.
5. Change the order of the tasks using the up and down arrows. The tasks run in the order listed.

Use the steps below to copy and paste tasks within the same job, or from one job to another.

To copy and paste a task

1. In the Jobs pane, click the job that contains the task you want to copy.
2. In the Details pane, right-click the task, and select Copy. (To copy multiple tasks, press the CTRL key and select the desired tasks. The tasks that are highlighted are copied when you select Copy.)
3. In the Jobs pane, click the destination Job where you want to paste the task.
4. Right-click in the Details pane and select Paste. The tasks appear at the bottom of the task list, and use the condition settings of the current job.
5. Change the order of the task using the up and down arrows. The tasks run in the order listed.

To modify a task in a job

1. In the Jobs pane, double-click the job you want to modify.
2. Select the desired task from the list.
3. Click Modify and follow the directions to make the required changes. Click OK.

To remove a task from a job

1. In the Jobs pane, double-click the job you want to modify.
2. Select the task you want to remove from the task list. Click Delete.
3. Click OK.

Use the steps below to copy and paste tasks within the same job or from one job to another. You can also use CTRL+C and CTRL+V to copy and paste tasks.
To copy and paste tasks

1. In the Jobs pane, click the job that contains the task you want to copy.
2. In the Details pane, right-click the task and select Copy. (To copy multiple tasks, press the CTRL key and select the desired tasks. The tasks that are highlighted are copied when you select Copy.)
3. In the Jobs pane, click the destination Job where you want to paste the task.
4. Right-click in the Details pane and select Paste. The tasks appear at the bottom of the task list and use the current condition settings of the destination job.
5. Change the order of the tasks using the up and down arrows. The tasks execute in the order listed.

To add a new task to an existing task list

1. Select a job from the Jobs pane.
2. Click on one of the tasks within the job and add a new task. The new task is inserted above the task you highlighted, and all other jobs shift down by one position.
3. Use the up and down arrows to change the order of the tasks within the job.

Modifying multiple modify configuration tasks

If you have scheduled multiple Modifying Configuration tasks to a computer group, you can double-click Modify Configuration in the task list of the Details pane to modify each computer's configuration settings independently.

In the Jobs pane, click the job with a Modify Configuration task. Double-click the Modify Configuration task.

A message appears. Click YES to modify configuration settings individually for each scheduled computer. Click NO to modify the Modify Configuration task when the job is scheduled again (the current job sends modified configuration files already created).

If you click YES, a Modify Job Wizard appears with a list of each managed computer scheduled to change configuration settings. Select one or more computers and click Next.
To modify multiple configuration task

1. In the **Computer Configuration Properties** property page, modify the settings. Click **Next**.
   
   See “Computer configuration properties” on page 104.

2. Set Return Codes.
   
   See “Setting up return codes” on page 204.

3. Click **Finish**.

---

### Creating new script files

You can create script files and directly schedule the script file to run scripts on any computer or computer groups.

#### To create new script files

1. Go to View > Shortcuts View.

2. Click **Resources** in the **Shortcuts** view to move the focus to the Resources view.


   **Note:** The **Script File** option is activated only if the focus is on the Resources view.

   A script file is created by default at the root of the resources. The default file name is Batch.bat.

4. Right-click the Batch.bat file, and select **Modify**.

   **Note:** You can rename the batch file by right-clicking the file and selecting **Rename**.

5. Type the script in the open file, and save it.

6. Drag the Batch.bat file to a computer or computer group where you want to schedule the job.

7. Specify the scheduling options, and click **OK**.

   See “Building and scheduling jobs” on page 151.
Copy and paste jobs and job folders

Jobs or job folders (including their subfolders) can be copied to any other job folder in the left pane of the Jobs pane of the Ghost Solution Suite Console. A Job folder can only be copied to a root level folder, which has a limit of 30 subfolders, and cannot be copied to a child level folder.

If you copy a job or folder with the same name as the destination job or folder, the copied job or folder is automatically named Copy of <job or folder name>. This feature can only be performed by administrators or users who have permissions to create jobs or job folders.

To copy jobs and job folders
1. In the Jobs pane, right-click a job or job folder you want to copy, and click Copy.
2. In the Jobs pane, right-click the destination job folder and click Paste.

Importing and exporting jobs

Jobs can be exported to back up the Ghost Solution Suite Server data or to share jobs between Ghost Solution Suite Server installations.

To import jobs
1. Right-click in the Job pane, and select Import
2. or
   Click File > Import/Export > Import Jobs.
3. Browse to or enter the path and name of an existing import file (a .BIN file).
4. Select Import to Job Folder to import the jobs to an existing folder in the Jobs pane. If you have a folder already selected, it appears in the edit field.
5. Select Overwrite existing Jobs and Folders with the same name to replace identical jobs and folders.
6. Select Delete existing Jobs in folder to overwrite and replace all jobs in the selected Jobs folder. Click OK to import the job(s).

To export jobs
1. Right-click the job or Jobs folder you want to export and select Export.
2. or
   Click File > Import/Export > Export Jobs.
3. Select the destination folder and enter a file name.
3 Click Export subfolders to export all folders subordinate to the selected job folder.

4 Click OK.

Setting up return codes

When you create a task in a job, you can define a response to specific return codes generated from that task after it runs. You can determine the response if the task runs successfully or if the task fails. You can also set up custom return codes generated from scripts or batch files that are unique to your environment or deployment system.

**Note:** Return code handling cannot be set up for jobs created in the New Job Wizard.

When creating a task, the Return Codes page appears so you can set a response if the task was successful or to determine a default response if the task failed. Because Ghost Solution Suite Server returns a 0 (zero) if the task runs successfully, any other return code value denotes some type of failure in running the task. As a result, in the Success field you can select an action if the return code is 0 (zero), or select an action in the Default field if the return code is not a 0 (zero).

Return codes are first evaluated to be successful (zero) or failed (non-zero). If the task returns as successful, it runs the action specified in the Success field. If it is not successful, it determines if the return code has been assigned a custom code value. If the return code is defined as a custom code, the selected action for that custom code runs. If no custom code is assigned to the return code, the action set in the default runs.

**Note:** If you are using LogEvent and WlogEvent in Scripts, you can generate return codes only when the level 3 message is specified. Specifying a severity level 3 causes the script job to fail and lets you respond using this return code feature.

**Return code actions**

For both successful tasks (in the Success field) and failed tasks (in the Default field), you can specify the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>This action stops the job after the task runs. Subsequent tasks do not run.</td>
</tr>
<tr>
<td>Continue</td>
<td>This action lets the subsequent tasks in the job continue after the task runs.</td>
</tr>
</tbody>
</table>
Select a job. This action lets you select existing jobs to run after the task completes.

These actions also apply to custom return codes designed specifically for your system.

Custom return codes

In the Other return codes field, you can view custom return codes set specifically for your system. You can add return codes by clicking Add below the Other return codes field, or by clicking Master Return Code.

Type a custom code in the Code field, select a response action from the Response list, select the result from the Result list to specify the interpretation of this return code as Success or Failure, and provide a message in the Status field.

These custom codes can respond to any return codes set up in scripts or batch files in the Run Scripts task, or these custom codes can respond to system return codes thrown from the Ghost Solution Suite Server or external codes generated when distributing applications, personality settings, or disk images. Any task can have custom codes that respond to different return code values.

Master Return Code List. This is a list of all the return codes existing in the Ghost Solution Suite Database. You can add, modify, and delete the codes and their values so that setting codes for other tasks is easier.

Add This lets you add a new custom return code for the task. You can also add the return code to the Master Return Codes list.

Modify This lets you modify the return codes listed in the Other return codes field. The changes you make do not update the Master Return Codes list.

Delete This lets you delete return codes listed in the Other return codes field, but not from the Master Return Codes list.

To set up master return codes

The Master Return Code List dialog lets you:

- Add, modify, and remove return codes in the master list.
- Select return codes for the current job from the drop-down list.
To add master return codes

1. Select a job from the Jobs pane.
2. Click Add in the right pane to add a task. Select the task. The Task dialog appears.

   **Note:** You can add Master Return Codes for all tasks except Get Inventory.

3. Click Next until the Return Codes page appears.
5. Click Add. The Add Return Code dialog appears.
6. Enter the return code in the Code field and click OK. The code is added to the master list.

To modify Master Return Codes

1. Click Modify. The Modify Return Code dialog appears.
2. Enter data in the Response, Result, and Status fields and click OK. The code is modified.

To delete master return codes

1. Select the code you want to delete and click Delete. A warning message appears to confirm the deletion.
2. Click Yes. The selected return code is deleted from the Master list.

   **Note:** The OK and Cancel options in the Master Return Code List dialog apply to the return codes selected. If no return codes are selected, or none exist in the list, OK is disabled. Click OK on the Master Return Code List dialog to add the selected return codes to the current job.

To set up return codes, you need to determine how to respond to the Ghost Solution Suite Server success return code (zero) in the Success field, how to respond to a failure return code (a non-zero) in the Default field, and how to respond to a custom or externally generated return code defined in the Other return codes field.

The following example describes how to set up a simple process to deal with custom and system return codes, and how to interpret the status of user-defined return codes:
To set up return codes

1. In the Success drop-down list on the Return Codes page, keep the default value Continue. This lets the job continue running additional tasks in the job after successfully completing this task.

2. Click Add to add custom return codes. The Add Return Code dialog appears.

3. In the Code field, enter a value of 10 (ten).

4. Click the Response drop-down arrow and select Continue from the list.

5. Click the Result drop-down arrow and select Success from the list. Even if the return code was not zero, which is success by default, the task is considered a success as per the user’s choice.

6. Enter a description for the return code in the Status field. This is the message that appears when the task within a selected job runs.

7. Select the Add to Master return code list check box to add the custom code to the master return code list. The code is listed in both the Other return codes and Master Return Codes lists. This is useful if you want to use the return code again. Click OK.

8. If the code you added already exists, a message dialog displays the return code and asks if you want to replace it. Click Yes to replace the return code, and click No to return to the Add Return Code dialog.

9. Select the Select a job option from the Default drop-down list to select a job to run when a default condition is reached. The Select a Job dialog appears, letting you select an existing job that runs if the task returns a failed system return code (non-zero) or a return code not defined as a custom return code.

---

**Note:** The status of the tasks executed in a job also appears in the history of a computer.

### Sample jobs

Sample jobs are installed with each Ghost Solution Suite Server system, letting you quickly modify or add parameters, or to run the sample jobs as they are. During installation, jobs are automatically imported from the samples.bin file to the Ghost Solution Suite Server system where they can be viewed in the Samples folder in the Jobs area of the Ghost Solution Suite Console. Click each job and identify its features in the Description field of the Details pane.

Jobs in each folder marked with an asterisk (*) require input parameters or other minor modifications added before running on your system. These modifications let...
you add parameters to the job, such as user name and password or other required
data for the job to be functional. Jobs requiring input parameters or customizing do
not function properly if you do not edit the job with the information specific to your
environment.

All files without an asterisk (*) can be used to perform the identified functions without
modification. However, if the job conditions are not met or are not consistent with
the computer type, you may get an error.

---

**Note:** When upgrading versions of Ghost Solution Suite, we recommend that you

copy and rename modified sample jobs to avoid overwriting by new sample jobs.

### Initial deployment

Initial Deployment is a default job designed to help in the process of setting up
customers that do not exist in the Ghost Solution Suite Database. Initial Deployment
lets you define how computers are initially set up after being identified by the Ghost
Solution Suite Server.

You can define various computer configuration sets and deployment jobs for the
user during startup, letting the user select the computer settings and hard disk
images, software, and personality settings for their specific needs and environment.
**New computers** appear in the New Computers group in the **Computers** pane of
the Ghost Solution Suite Console.

To access Initial Deployment, double-click **Initial Deployment** from the Jobs pane
or right-click **Initial Deployment** and click **Properties**. The **Properties of Initial
Deployment** dialog appears.

Initial Deployment is ideal for small-scale deployments, from 1 to 10 computers.
We do not recommend this feature for large deployments -- from 10 to 100
computers -- or mass deployments -- from 100 to 5000 computers. We also do not
recommend this feature where you use virtual computers, customized jobs, and
the computer import feature.

Although Initial Deployment is commonly used on computers that support PXE, you
can also configure a boot disk to run Initial Deployment. In this case, the image you
deploy must include automation pre-boot environment so that post imaging tasks
can run successfully.

---

**Note:** To completely deploy and configure a computer using Initial Deployment, you
must define at least one Configuration and one Job.
Initial Deployment consists of a dialog with the following tabs with separate features to deploy new computers:

- Configurations
- Jobs
- Advanced

## Configurations

Click the **Configurations** tab on the Initial Deployment dialog to configure different sets of computer properties. Each configuration set is presented to the user as a menu. The user can select the configuration set designed for their environment. Compare the Configurations tab with the Jobs tab. See Jobs.

---

**Note:** If you do not create any configuration sets, the deployment process automatically sets TCP/IP information to use DHCP and names the computer to match the computer's asset tag, serial number or MAC address -- in that order, depending on what is available.

---

### To create configurations

1. Double-click **Initial Deployment** in the **Jobs** pane drop-down list. The **Properties of Initial Deployment** dialog appears.

2. Click the **Configurations** tab.

3. Click **Add**. A configuration set appears in the **Configurations menu** field. The **Configuration** page of the New Job Wizard appears.

4. Enter values to set computer and network properties for new computers. See Modifying configuration for a list of property categories.

5. Click **Add** again to configure another set of property settings. You can add multiple configuration sets for the user to select from a menu after connecting to Ghost Solution Suite Server. You can modify, rename, or delete a selected configuration set.

6. After setting the properties, click **Apply**.

7. From the **Default Menu choice** drop-down list, select a configuration set as the default.

8. Click the **Timeout after ___ seconds** and proceed check box and specify the time after which you want to run the default job.

9. Click **OK**, or click the **Jobs** tab to define a task.
Advanced Configuration

Click Advanced on the Configurations tab to open the Advanced Configuration dialog. This dialog lets you set advanced configuration settings for client computers and provides different options for processing jobs for client computers.

- Select **Process this job as each client becomes active**. This job is processed only when clients become active.
- Select **Process this job in batch mode**. This job is processed for a batch of clients for the **Minimum clients** specified and after the specified Timeout in minutes.
- Select **Hold all clients until this time**. You can specify the **Start time for this job**, which runs for all clients at the specified time.
- Click **OK**.

Jobs

Click the Jobs tab on the Initial Deployment dialog to add existing jobs or create new jobs to run on the new computer. The jobs you add or build using this dialog are listed in a menu and presented to the user during startup. The user can select the deployment jobs to image the computer and install applications and personality settings. Compare the Jobs tab with the Configurations tab. See “Configurations” on page 209.

To create Initial deployment job

1. Click Initial Deployment in the Jobs pane drop-down list. The Properties of Initial Deployment dialog appears.
2. Click the Jobs tab.
3. Click New to build a new job. The Select a job dialog appears. See “Building new jobs” on page 158. Select a folder in which you want to create the job. Click OK. The Job Properties dialog appears.
4. Click Add Existing to add an existing job.
5. From the Default menu choice drop-down list, select a job as the default.
6. Click the Timeout after ____ seconds and proceed check box and specify the time after which you want to run the default job. The default setting is 60 seconds.
7. Click OK, or click the Advanced tab to stop servers or workstations from running configuration task sets and jobs automatically. See also Sample jobs.
Advanced

Click the **Advanced** tab to set options to stop Initial Deployment from automatically running the default configuration task sets and jobs. This avoids accidental re-imaging or overwriting of data and applications for either workstations, such as desktop and laptop computers, or servers, such as servers identified by Ghost Solution Suite Server.

When a computer not yet identified by the Ghost Solution Suite Database is first detected, it is placed in the New Computers group and an Initial Deployment configuration set and job is run. However, in many cases you do not want servers to be automatically re-imaged without confirmation from IT personnel.

- Select **Servers** to stop servers from automatically running Initial Deployment configuration jobs. Servers are identified as the managed computers running multiple processors or identified as a specific server model from specific manufacturers. Example: Both an HP Proliant computer and a Dell computer with multiple processors are identified as servers. Identifying a computer as a server by the operating system cannot be accomplished for new computers until the server operating system has been installed.

- Select **Workstations/Clients** to force desktop and laptop computers to stop before automatically running Initial Deployment.